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About this guide

This guide provides troubleshooting information for installing, customizing,
starting, and maintaining the 4 main components that make upIBM® Tivoli®

Composite Application Manager for Application Diagnostics (ITCAM for
Application Diagnostics). These components are:
v Agent for WebSphere® applications
v Agent for J2EE
v Agent for HTTP Servers
v Managing Server

The 3 agent components listed above are also components of ITCAM for
Applications Version 6.2.3. However, if you are using ITCAM for Applications, the
Managing Server (deep dive) functionality is not available. In this case, ignore all
references to this functionality in this document.

Intended audience
This guide is for administrators or advanced users wanting to troubleshoot ITCAM
for Application Diagnostics. The guide assumes that readers are familiar with
maintaining operating systems, administering Web servers, maintaining databases,
and general information technology procedures. Specifically, readers of this guide
must have some knowledge of the following topics:
v Web application servers, such as IBM WebSphere
v IBM Tivoli Monitoring software
v Operating systems on which you intend to install product components
v Web servers, such as IBM HTTP Server and Apache HTTP Server
v WebSphere Application Server Community Edition
v Web application servers, such as WebLogic, NetWeaver, JBoss, Oracle, and

Tomcat, and J2SE applications
v Internet protocols such as HTTP, HTTPS, TCP/IP, Secure Sockets Layer (SSL),

and Transport Layer Security (TLS)
v Digital certificates for secure communication

Publications
This section lists publications in the product library and related documents. It also
describes how to access Tivoli publications online and how to order Tivoli
publications.

ITCAM for Application Diagnostics library
The following publications provide additional information about ITCAM for
Application Diagnostics. They are included in the ITCAM for Application
Diagnostics library available at http://publib.boulder.ibm.com/infocenter/
tivihelp/v24r1/topic/com.ibm.itcamfad.doc_7101/ic-homepage.html.
v IBM Tivoli Composite Application Manager for Application Diagnostics: Prerequisites

Provides the hardware and software requirements for installing ITCAM for
Application Diagnostics components.
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v IBM Tivoli Composite Application Manager for Application Diagnostics: User's Guide

Provides the user overview, user scenarios, and Helps for every ITCAM for
Application Diagnostics component.

v IBM Tivoli Composite Application Manager for Application Diagnostics: Planning an
Installation

Provides the user with a first reference point for a new ITCAM for Application
Diagnostics installation or upgrade.

v ITCAM Agent for WebSphere Applications Installation and Configuration
Guides:
– IBM Tivoli Composite Application Manager: Agent for WebSphere Applications

Installation and Configuration Guide

– IBM Tivoli Composite Application Manager: Agent for WebSphere Applications
Installation and Configuration Guide for z/OS

– IBM Tivoli Composite Application Manager: Agent for WebSphere Applications Data
Collector Installation and Configuration Guide for IBM i

Provide installation instructions for setting up and configuring ITCAM Agent for
WebSphere Applications on distributed, z/OS®, and IBM i systems.

v ITCAM Agent for J2EE Applications Installation and Configuration Guides:
– IBM Tivoli Composite Application Manager: Agent for J2EE Data Collector

Installation and Configuration Guide

– IBM Tivoli Composite Application Manager: Agent for J2EE Monitoring Agent
Installation and Configuration Guide

Provide installation instructions for setting up and configuring ITCAM Agent for
J2EE.

v IBM Tivoli Composite Application Manager: Agent for HTTP Servers Installation and
Configuration Guide

Provides installation instructions for setting up and configuring ITCAM Agent
for HTTP Servers.

v IBM Tivoli Composite Application Manager for Application Diagnostics Managing
Server Installation Guide

Provides installation instructions for setting up and configuring ITCAM for
Application Diagnostics Managing Server.

v IBM Tivoli Composite Application Manager for Application Diagnostics:
Troubleshooting Guide

Provides instructions on problem determination and troubleshooting for ITCAM
for Application Diagnostics.

v IBM Tivoli Composite Application Manager for Application Diagnostics: Messaging
Guide

Provides information about system messages received when installing and using
ITCAM for Application Diagnostics.

Related publications
The following documentation also provides useful information:
v WebSphere Application Server:

Information about WebSphere Application Server is provided on the following
Web site:
http://www-306.ibm.com/software/webservers/appserv/was/library

v IBM DB2®:
Information about IBM DB2 is provided on the following Web site:

x ITCAM for Application Diagnostics: Troubleshooting Guide
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http://www-306.ibm.com/software/data/sw-library/
v IBM Tivoli Enterprise Console®:

Information about IBM Tivoli Enterprise Console is provided on the following
Web site:
http://submit.boulder.ibm.com/tividd/td/EnterpriseConsole3.9.html

v IBM Tivoli Data Warehouse:
Information about IBM Tivoli Data Warehouse is provided on the following Web
site:
http://publib.boulder.ibm.com/infocenter/tivihelp/v3r1/index.jsp?toc=/
com.ibm.tivoli.tdwi.doc/toc.xml

v IBM Tivoli Change and Configuration Management Database:
Information about IBM Tivoli Change and Configuration Management Database
is provided on the following Web site:
http://publib.boulder.ibm.com/infocenter/tivihelp/v10r1/index.jsp?toc=/
com.ibm.ccmdb.doc/ccmdb_ic.xml

v IBM Support Assistant:
Information about IBM Support Assistant is provided on the following Web site:
http://www-306.ibm.com/software/support/isa/index.html?rcss=rtlrre

Accessing terminology online
The Tivoli Software Glossary includes definitions for many of the technical terms
related to Tivoli software. The Tivoli Software Glossary is available at the following
Tivoli software library Web site:

http://publib.boulder.ibm.com/tividd/glossary/tivoliglossarymst.htm

The IBM Terminology Web site consolidates the terminology from IBM product
libraries in one convenient location. You can access the Terminology Web site at the
following Web address:

http://www.ibm.com/software/globalization/terminology

Accessing publications online
The documentation CD contains the publications that are in the ITCAM for
Application Diagnostics library. The format of the publications is PDF, HTML, or
both.

IBM posts publications for this and all other Tivoli products, as they become
available and whenever they are updated, to the Tivoli software information center
Web site. Access the Tivoli documentation center at the following Web address:

https://www.ibm.com/developerworks/wikis/display/tivolidoccentral/Home

Access the Tivoli Information Center for ITCAM for Application Diagnostics at the
following Web address:

http://publib.boulder.ibm.com/infocenter/tivihelp/v24r1/topic/
com.ibm.itcamfad.doc_7101/ic-homepage.html

Note: If you print PDF documents on other than letter-sized paper, set the option
in the File → Print window that allows Adobe® Reader to print letter-sized pages
on your local paper.
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All IBM Tivoli product documentation can be accessed through the Tivoli
Documentation Central Wiki page at http://www.ibm.com/developerworks/
wikis/display/tivolidoccentral/Home.

Ordering publications
You can order many Tivoli publications online at the following Web site:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/
pbi.cgi

You can also order by telephone by calling one of these numbers:
v In the United States: 800-879-2755
v In Canada: 800-426-4968

In other countries, contact your software account representative to order Tivoli
publications. To locate the telephone number of your local representative, perform
the following steps:
1. Go to the following Web site:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/
pbi.cgi

2. Select your country from the list and click Go.
3. Click About this site in the main panel to see an information page that

includes the telephone number of your local representative.

Accessibility
Accessibility features help users with a physical disability, such as restricted
mobility or limited vision, to use software products successfully. With this product,
you can use assistive technologies to hear and navigate the interface. You can also
use the keyboard instead of the mouse to operate all features of the graphical user
interface.

For additional information, see Appendix A, “Accessibility,” on page 119.

Tivoli technical training
For Tivoli technical training information, refer to the following IBM Tivoli
Education Web site:

http://www.ibm.com/software/tivoli/education/

Conventions used in this guide
This guide uses several conventions for special terms and actions, operating
system-dependent commands and paths, and margin graphics.

Typeface conventions
This guide uses the following typeface conventions:

Bold

v Lowercase commands and mixed case commands that are otherwise
difficult to distinguish from surrounding text
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v Interface controls (check boxes, push buttons, radio buttons, spin
buttons, fields, folders, icons, list boxes, items inside list boxes,
multicolumn lists, containers, menu choices, menu names, tabs, property
sheets), labels (such as Tip:, and Operating system considerations:)

v Keywords and parameters in text

Italic

v Citations (examples: titles of publications, diskettes, and CDs
v Words defined in text (example: a nonswitched line is called a

point-to-point line)
v Emphasis of words and letters (words as words example: "Use the word

that to introduce a restrictive clause."; letters as letters example: "The
LUN address must start with the letter L.")

v New terms in text (except in a definition list): a view is a frame in a
workspace that contains data.

v Variables and values you must provide: ... where myname represents....

Monospace

v Examples and code examples
v File names, programming keywords, and other elements that are difficult

to distinguish from surrounding text
v Message text and prompts addressed to the user
v Text that the user must type
v Values for arguments or command options

Variables for directories
This guide refers to the following variables:

ITM_home

The top level directory for installation of IBM Tivoli Monitoring
components.

ITCAM_home

The top level directory for installation of IBM Tivoli Composite Application
Monitoring components.

DC_home and MS_home

The directory where the Data Collector or Managing Server are installed.
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What's new in this publication

ITCAM Agent for WebSphere Applications

This publication contains information that applies to version 7.1.0.1 of IBM Tivoli
Composite Application Manager for Application Diagnostics. You should have the
following maintenance of the product installed:
v ITCAM Agent for WebSphere 7.1.0.1

ITCAM Agent for J2EE

This publication contains information that applies to the 6.2.0.4 version of the
product:
v Data Collector Fix Pack 4
v J2EE Monitoring Agent Fix Pack 4

ITCAM Agent for HTTP Servers
v ITCAM Agent for HTTP Servers 7.1.0.1

You can use the auto-learning thresholds and benchmark performance for a new
application (or changed environment) and to understand where thresholds should
be established. In conjunction with this offering, best practices related to logical
navigation views and correlation of situations for automation of problem
identification can be found in the Open Process Automation Library (OPAL). For
more information, see the following Web site: http://catalog.lotus.com/wps/
portal/tcam

© Copyright IBM Corp. 2007, 2010 xv
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Chapter 1. Log files, tracing, and utilities

Log files contain useful information for analyzing and troubleshooting any issue
that may occur in the system. You can also enable tracing in order to log additional
details. It is suggested that you perform tracing and capture the log files before
contacting IBM support for assistance.

ITCAM for Application Diagnostics includes several tools for generating and
managing log files. It also provides an Environmental Checking Utility (ECU). You
can use this utility to check that prerequisite packages are installed correctly prior
to installation

Log files and tracing for the Tivoli Enterprise Monitoring Agent
The Tivoli Enterprise Monitoring Agent is a component of ITCAM Agent for
WebSphere Applications, ITCAM Agent for J2EE, and ITCAM Agent for HTTP
Servers.

Gather Script
The Gather Script is a script that collects system information such as CPU and
memory data, network status, registry and environment variables. It also collects
specific information on the product, such as configuration settings, log files and
maintenance level. It compresses all the collected information into a single file.
When you contact IBM support for assistance, the support engineer will ask you to
upload the file for further analysis.

ITCAM Agent for WebSphere Applications

For ITCAM Agent for WebSphere Applications, the name of the Tivoli Enterprise
Monitoring Agent gather script is:
v on Windows®, ITM_home\TMAITM6\kyncollect.cmd
v on Linux®, UNIX® systems, and z/OS, ITM_home/ITM_BINARCH/yn/bin/

kyncollect.sh

The script takes no parameters.

The output file will be located in the following directory:
v on Windows, %TEMP%\KYN
v on Linux, UNIX systems, and z/OS, ITM_home/tmp/kyn

ITCAM Agent for J2EE

For ITCAM Agent for J2EE, the name of the Tivoli Enterprise Monitoring Agent
gather script is:
v on Windows, ITM_home\TMAITM6\kyjcollect.cmd
v on Linux, UNIX systems, and z/OS, ITM_home/ITM_BINARCH/yn/bin/

kyjcollect.sh

The script takes no parameters.

The output file will be located in the following directory:
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v on Windows, %TEMP%\KYJ
v on Linux and UNIX systems, ITM_home/tmp/kyj

ITCAM Agent for HTTP Servers

For ITCAM Agent for HTTP Servers, the name of the Tivoli Enterprise Monitoring
Agent gather script is:
v on Windows, ITM_home\TMAITM6\khtcollect.cmd
v on Linux, UNIX systems, and z/OS, ITM_home/ITM_BINARCH/ht/bin/

khtcollect.sh

The script takes no parameters.

The output file will be located in the following directory:
v on Windows, %TEMP%\KHT
v on Linux and UNIX systems, ITM_home/tmp/kht

Tracing within the Tivoli Enterprise Monitoring Agent
For all the agents, tracing within the Tivoli Enterprise Monitoring Agent is
controlled by setting the KBB_RAS1 environment variable, using the format
KBB_RAS1=ERROR (UNIT:<unitname> <trace type>), as per the following examples:
v KBB_RAS1=ERROR (UNIT:kyn ALL) (UNIT:kwj all)

Writes all error messages.
Writes all trace messages for source files beginning with "kyn" or "kwj"

Tip: Use "kyn" for ITCAM Agent for WebSphere Applications, "kyj" for ITCAM
Agent for J2EE, and "kht" for ITCAM Agent for HTTP Servers.

v KBB_RAS1=ERROR (UNIT:kwj INPUT OUTPUT STATE)

Writes all error messages.
Writes INPUT, OUTPUT, and STATE trace messages for source files beginning
with 'kwj'.

v KBB_RAS1=ERROR

Writes trace messages for all errors.

Useful traces
Generally, requests for tracing and interpretation of traces must only be done by
those who have intimate knowledge of the code.
v KBB_RAS1=UNIT:kwjira FLOW STATE

Traces Monitoring Agent activity on the IBM Tivoli Monitoring framework API
boundary.

v KBB_RAS1=ERROR (UNIT:KWJJ FLOW STATE)

Traces the native Monitoring Agent interface flow with the Java™ sub-agent.

Where to specify tracing parameters
Set tracing parameters in the following locations, depending on the agent and the
OS:
v For ITCAM Agent for WebSphere Applications:

– On Windows: ITM_home\TMAITM6\KYNENV file
– On Linux and UNIX systems: /Install_home/config/yn.ini file
– On z/OS: KYNENV member of RKANPAR data set

v For ITCAM Agent for J2EE:
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– On Windows: ITM_home\TMAITM6\KYJENV file
– On Linux and UNIX systems: /ITM_home/config/yj.ini file

v For ITCAM Agent for HTTP Servers:
– On Windows: ITM_home\TMAITM6\KHTENV file
– On Linux and UNIX systems: /ITM_home/config/ht.ini file

You can also set these parameters using the GUI. This GUI is also available in
UNIX systems using the X Window System.

Note:

1. When troubleshooting the monitoring agent, enable tracing for the Data
Collector code that communicates with the monitoring agent. See “Setting the
logging and tracing levels” on page 7

2. When troubleshooting Application Summary workspaces, enable tracing for
the ITCAM for Application Diagnostics support code in the Tivoli Enterprise
Portal, as this code is used to create the green .yellow/red "lights" in the
workspaces. See “Tracing and logging within the Tivoli Enterprise Portal
(Summary Workspaces)” on page 16

Tivoli Enterprise Monitoring Agent log files
ITCAM Agent for WebSphere Applications

Location of the logs in Windows:
v ITM_home\logs\COMPUTER_NAME_yn_*.log [contains Monitoring Agent native code

trace messages]
v ITM_home\logs\kyn-TEMA-trace.log [contains Monitoring Agent java code trace

messages]
v ITM_home\logs\kyn-TEMA-msg.log [contains Monitoring Agent log messages]
v ITM_home\logs\KYN.Primary.*.*JVM.log [contains Monitoring Agent JVM

messages]
v ITM_home\TMAITM6\logs\itcamfwasras1.log [contains Monitoring Agent

configuration messages]

Location of the log files in UNIX/Linux:
v ITM_home/logs/COMPUTER_NAME_yn_*.log

v ITM_home/logs/itm_config.log

v ITM_home/logs/itm_config.trc

v ITM_home/logs/KYN.Primary.*.*JVM.log

Location of the log files in z/OS:
v ITM_home/logs/COMPUTER_NAME_yn_*.log

v ITM_home/logs/kyn-TEMA-trace.log

v ITM_home/logs/kyn-TEMA-msg.log

v ITM_home/logs/KYN.Primary.*.*JVM.log

The location of the native code trace log files can be changed using the Manage
Tivoli Monitoring Services utility (in the right click menu for the agent, select
Advanced > Edit Trace Parms...); it can not be changed on z/OS. To set the
location of other log files, use the following configuration files:
v Windows - ITM_home\TMAITM6\kynjlog.properties
v UNIX/Linux - ITM_home/arch/yn/config/kynjlog.properties
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v z/OS - ITM_home/yn/config/kynjlog.properties

Attention: The configuration files for the logs must not be changed without the
prior consent of IBM Tivoli Support Team.

ITCAM Agent for J2EE

Location of the logs in Windows:
v ITM_home\logs\COMPUTER_NAME_yj_*.log [contains Monitoring Agent native code

trace messages]
v ITM_home\logs\kyj-TEMA-trace.log [contains Monitoring Agent java code trace

messages]
v ITM_home\logs\kyj-TEMA-msg.log [contains Monitoring Agent log messages]
v ITM_home\logs\KYJ.Primary.*.*JVM.log [contains Monitoring Agent JVM

messages]

Location of the log files in UNIX/Linux:
v ITM_home/logs/COMPUTER_NAME_yj_*.log

v ITM_home/arch/logs/kyj-tema-trace.log

v ITM_home/arch/logs/kyj-tema-msg.log

v ITM_home/logs/KYJ.Primary.*.*JVM.log

The location of the native code trace log files can be changed using the Manage
Tivoli Monitoring Services utility (in the right click menu for the agent, select
Advanced > Edit Trace Parms...). To set the location of other log files, use the
following configuration files:
v Windows - ITM_home\TMAITM6\kyjjlog.properties
v UNIX/Linux - ITM_home/arch/yj/config/kyjjlog.properties

Attention: The configuration files for the logs must not be changed without the
prior consent of IBM Tivoli Support Team.

ITCAM Agent for HTTP Servers

Location of the logs in Windows:
v ITM_home\logs\COMPUTER_NAME_ht_*.log [contains native code trace messages]
v ITM_home\logs\kht-TEMA-trace.log [contains java code trace messages]
v ITM_home\logs\kht-TEMA-msg.log [contains Agent log messages]
v ITM_home\logs\KHT.Primary.*.*JVM.log [contains Agent JVM messages]

Location of the log files in UNIX/Linux:
v ITM_home/logs/COMPUTER_NAME_ht_*.log

v ITM_home/arch/logs/kht-tema-trace.log

v ITM_home/arch/logs/kht-tema-msg.log

v ITM_home/logs/itm_config.log

v ITM_home/logs/itm_config.trc

v ITM_home/logs/KHT.Primary.*.*JVM.log

The location of the native code trace log files can be changed using the Manage
Tivoli Monitoring Services utility (in the right click menu for the agent, select
Advanced > Edit Trace Parms...). To set the location of other log files, use the
following configuration files:
v Windows - ITM_home\TMAITM6\khtjlog.properties
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v UNIX/Linux - ITM_home/arch/ht/config/khtjlog.properties

Attention: The configuration files for the logs must not be changed without the
prior consent of IBM Tivoli Support Team.

Plug-in for IBM Support Assistant (ISA)
ITCAM for Application Diagnostics plug-in for IBM Support Assistant (ISA) is a
plug-in available for download in ISA. It is a GUI-based utility for collecting log
files and system information. You can submit a service request through ISA with
the file generated by the plug-in. For instructions on obtaining and installing the
ISA software, please refer to “Downloading ISA” on page 21 and “Installing ISA”
on page 21.

Downloading the plug-in from IBM Support Assistant (ISA)
To download the ITCAM for Application Diagnostics plug-in for ISA, perform the
following steps:
1. Launch IBM Support Assistant
2. Click Updater on the main page
3. You will see a list of installed plug-ins. Click New Plug-ins

Note: If you are using ISA version 3.0.0.1, click New Products and Tools

4. You will see a list of plug-ins available for download. Click to expand Tivoli
tree

5. Check the box next to IBM Tivoli Composite Application Manager for
Application Diagnostics 7.1

6. Click Install button
7. Click I agree button to accept the license agreement
8. The download will start and the installation will also start after the download

is complete. When the installation finishes, you will be asked for restarting the
ISA, click OK button to restart it

Using the plug-in to collect log files and system information
To use the ITCAM for Application Diagnostics plug-in to collect log files and
system information, perform the following steps:
1. Launch IBM Support Assistant
2. Click Service on the main page
3. Click Collect Data on the left panel
4. Expand IBM Tivoli Composite Application Manager for Application

Diagnostics 7.1

5. Select ITCAM Data Collector Problem.
6. Click Collect button
7. You will be asked for the location of the data collector installation directory.

Please input the path in the text box provided and click OK to continue
8. The process will start and will collect the system information and log files. It

will display the location of the output file it generates when it finishes
9. You can submit a service request through ISA with the file is being generated

by the plug-in
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Log files and tracing for the Data Collector
The Data Collector is a component of ITCAM Agent for WebSphere Applications
and ITCAM Agent for J2EE.

Important: ITCAM Agent for HTTP Servers does not include a Data Collector.

First Failure Data Capture
First Failure Data Capture (FFDC) uses an in-memory tracing tool that runs
continuously. When an unexpected error occurs, FFDC dumps the trace
information to a log file for use in analyzing the problem. FFDC collects
information that is intended primarily for use by IBM software support
technicians. It runs automatically, you do not need to perform any action to start or
stop it. If you experience conditions requiring you to contact software support,
your support representative can assist you in reading and analyzing the FFDC log.
FFDC does not affect the performance of the product.

For information about receiving assistance from IBM Software Support, see
“Contacting IBM Software Support” on page 124.

You can retrieve FFDC logs from the following default locations:
v For Managing Server, they are:

Microsoft® Windows:
C:\Program Files\ibm\tivoli\common\CYN\FFDC

UNIX/Linux:
/var/ibm/tivoli/common/CYN/FFDC

OS/400®:
/QIBM/UserData/tivoli/common/CYN/FFDC

v For ITCAM Agent for WebSphere Applications, they are:
Microsoft Windows:
ITM_home\tmaitm6\wasdc\7.1.0.1\logs

UNIX/Linux:
ITM_home/component_name/yn/wasdc/7.1.0.1/logs

IBM i:
/QIBM/UserData/tivoli/common/CYN/FFDC

v For ITCAM Agent for J2EE, they are:
Microsoft Windows:
C:\Program Files\ibm\tivoli\common\CYN\FFDC

UNIX/Linux:
ITM_home/component_name/yn/wasdc/7.1.0.1/logs

Gather Script
The Gather Script is a script that collects system information such as CPU and
memory data, network status, registry and environment variables. It also collects
specific information on the product such as configuration settings, log files and
maintenance level. It compresses all the collected information into a single file.
When contacting IBM support for assistance, you will be asked to upload the file
for further analysis.
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For information about receiving assistance from IBM Software Support, see
“Contacting IBM Software Support” on page 124.

ITCAM Agent for WebSphere Applications

The Data Collector Gather Script for ITCAM Agent for WebSphere Applications is:
v Windows: ITM_home\TMAITM6\bin\cyn_collector.cmd
v Linux and UNIX systems: ITM_home/arch/yn/bin/cyn_collector.sh
v IBM i: DC_home/itcamdc/bin/cyn_os400_collector.sh

The syntax for running the Gather Script is:
cyn_collector_script_name [[-a] | [-s server]]

where:

-a makes the script collect information from all application servers on the host.

-s makes the script collect information from one application server; server is the
name of the application server.

Important: The -s option is not available on IBM i.

You must specify either -a or -s server

The script will display the name of the resulting *.jar file.

ITCAM Agent for J2EE

The Data Collector Gather Script for ITCAM Agent for J2EE is:
v Windows: DC_home\itcamdc\bin\cyn_collector_J2.cmd
v Linux and UNIX systems: DC_home/itcamdc/bin/cyn_collector_J2.sh

Start the Gather Script without parameters. The name of the created file is
v Windows: DC_home\collect.jar
v Linux and UNIX systems: DC_home/collect.tar.gz

Setting the logging and tracing levels
To change the logging and tracing level for the Data Collector, you need to edit
property files and then restart the Data Collector. Different files are used for native
code and Java code. These settings apply to the Data Collector of both ITCAM
Agent for WebSphere Applications and ITCAM Agent for J2EE.

There are four components in the native code of the Data Collector. They are
Network Agent, Event Agent, Command Agent and Common code. To change the
log levels for these components, modify the file DC_home/runtime/ServerInstance/
cyn-cclog.properties. For example:
logger.dc.trace.listenerNames=handler.file.dc.trace
# dc command agent logger properties
logger.dc.ca.trace.level=INFO
# dc network agent logger properties
logger.dc.na.trace.level=DEBUG_MID
# dc event agent logger properties
logger.dc.ea.trace.level=DEBUG_MIN
# dc common code logger properties
logger.dc.cc.trace.level=INFO
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Important: Restart the Data Collector after making changes to
cyn-cclog.properties.
Attention: On IBM i, the file cyn-cclog.properties is in EBCDIC encoding; when
saving changes, ensure the file is saved in this encoding.

You may specify tracing levels for the Java code in the Data Collector in the
DC_home/runtime/instance/cynlogging.properties file. The following code snippet
from that file indicates where to specify the tracing level for the primary data
collector Java code:
#-----------------------------------------------
# Data Collector
#-----------------------------------------------
# MESSAGE LOGGER
CYN.msg.datacollector.level=INFO
CYN.msg.datacollector.logging=true
# TRACE LOGGER
CYN.trc.datacollector.level=INFO

Note: INFO means only errors and informational trace messages will be written.

You may also specify the tracing level for the Data Collector Java code that
communicates with the Tivoli Enterprise Monitoring Agent. Make the following
changes in the same file:
# MESSAGE LOGGER
CYN.msg.temadc.level=INFO
CYN.msg.temadc.logging=true

# TRACE LOGGER
CYN.trc.temadc.level=INFO
CYN.trc.temadc.logging=true

Tracing can be set at more granular levels by setting CYN.trc.partially qualified
class name.level=debug level in the cynlogging.properties properties file. This
property stipulates that for the class beginning with partially qualified class name
tracing will be at the specified level. For example:
v CYN.trc.com.ibm.tivoli.kyn.gccollector=DEBUG_MID

Traces "middle" level of debugging for classes beginning with
"com.ibm.tivoli.kyn.gccollector"

v CYN.trc.com.ibm.tivoli.kyn.requestmanager=DEBUG_MAX

Traces "maximum" level of debugging for classes beginning with
"com.ibm.tivoli.kyn.requestmanager".

Note: The Data Collector must be restarted for changes to take effect.

Data Collector logs
The ITCAM Agent for WebSphere Applications Data Collector logs are, by default,
located in the following directory:

Table 1. ITCAM Agent for WebSphere Applications Data Collector log path

Windows DC_home\logs\hostname.servername\

Linux and UNIX systems DC_home/logs/hostname.servername/

IBM i /QIBM/UserData/tivoli/common/CYN/logs

z/OS config_home/runtime/
appserver_version.node_name.server_name/logs/CYN/logs
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The ITCAM Agent for J2EE Data Collector logs are, by default, located in the
following directory:

Table 2. ITCAM Agent for J2EE Data Collector log path

Windows C:\Program Files\ibm\tivoli\common\CYN\logs

Linux and UNIX systems /var/ibm/tivoli/common/CYN/logs

The log file names are:
v msg-dc-native.log

v msg-dc-ParentLast.log

v trace-dc-bcm.log

v trace-dc-native.log

v trace-dc-ParentLast.log

For both ITCAM Agent for WebSphere Applications and ITCAM Agent for J2EE,
you can modify the log file location by modifying the cynlogging.properties and
cyn-cclog.properties files. Their location is:

Table 3. Path to cynlogging.properties and cyn-cclog.properties

Windows DC_home\runtime\server_instance\

Linux and UNIX systems,
and IBM i

DC_home/runtime/server_instance/

z/OS config_home/runtime/server_instance/

Plug-in for IBM Support Assistant (ISA)
ITCAM for Application Diagnostics plug-in for IBM Support Assistant (ISA) is a
plug-in available for download in ISA. It is a GUI-based utility for collecting log
files and system information. You can submit a service request through ISA with
the file generated by the plug-in. For the detailed information on how to download
and use the plug-in, please refer to “Plug-in for IBM Support Assistant (ISA)” on
page 5.

Log files and tracing for the Managing Server
The Managing Server is used for deep dive diagnostics. It communicates with
ITCAM Agent for WebSphere Applications and ITCAM Agent for J2EE.

First Failure Data Capture
First Failure Data Capture (FFDC) uses an in-memory tracing tool that runs
continuously. When an unexpected error occurs, FFDC dumps the trace
information to a log file for use in analyzing the problem. FFDC collects
information that is intended primarily for use by IBM software support
technicians. It runs automatically, you do not need to perform any action to start or
stop it. If you experience conditions requiring you to contact software support,
your support representative can assist you in reading and analyzing the FFDC log.
FFDC does not affect the performance of the product.

For information about receiving assistance from IBM Software Support, see
“Contacting IBM Software Support” on page 124.

You can retrieve FFDC logs for the Managing Server from the following default
locations:

Chapter 1. Log files, tracing, and utilities 9



Microsoft Windows:
C:\Program Files\ibm\tivoli\common\CYN\FFDC

UNIX/Linux:
/var/ibm/tivoli/common/CYN/FFDC

Gather Script
The Gather Script is a script that collects system information such as CPU and
memory data, network status, registry and environment variables. It also collects
specific information on the product such as configuration settings, log files and
maintenance level. It compresses all the collected information into a single file.
When contacting IBM support for assistance, you will be asked to upload the file
for further analysis.

The Managing Server Gather Script is located in MS_HOME/bin/MS_Gather_Data.sh.
It is invoked using the command:
./MS_Gather_Data.sh pmr-number [appserver_home where VE is installed] [SERVER_NAME]

, for example:
./MS_Gather_Data.sh 70023.900.000

On Windows, use the Microsoft Services for Unix shell to start this script.

The result of running the MS gather script is a zipped file, containing the
following:
v Most contents of MS_HOME (bin, etc, logs and scripts)
v All logs in the /var directory
v Status of all components (text file for each component)
v Text file of OS information
v List of installed libraries
v server.xml for the specified server
v Netstat output

Changing the log level
The Managing Server supports changing the log level dynamically.

To change the log level of the Managing Server, use the following command in
MS_HOME/bin :
./amctl.sh component [debugmin | debugmax | debugmid | traceoff |

messageoff | error | warn | info]

where component is one of the following:
v kl1: First instance of the Kernel
v kl2: Second instance of the Kernel
v ps1: First instance of the Publish Server
v ps2: Second instance of the Publish Server
v aa1: First instance of Archive Agent
v aa2: Second instance of Archive Agent
v md: Message Dispatcher
v sam1: First instance of Structured Application Monitor (SAM) Global Publish

Server
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v pa: Polling Agent

On Windows, use the Microsoft Services for Unix shell to start this script.

Managing Server logs
The Managing Server logs are:
v MS_home/logs/am_stderr.log

v MS_home/logs/am_stdout.log

v MS_home/msg-component.log

v MS_home/trace-component.log

v MS_home/audit-ms.log

LogViewer
ITCAM for WebSphere supports a common XML format in which log messages
and traces are logged. This viewer processes logs in that format so you can view
and query their content.

The viewer can filter messages and traces by time, severity, thread ID, component,
and other data, and convert the logged messages into ASCII or HTML for
presentation. Visual cues are associated with error and warning messages.

In this section, the following terminology is used:
v A log record is a single coherent entry in the log file. The log record contains

several fields (time, server, logText, etc.). A log should describe either user
activities or the visible behavior of the program.

v A trace record is a single coherent entry in the trace file (similar to the log
record). A trace record describes the internal activity of the application. Tracing
is of interest to a programmer; trace records are not generally useful to the end
user.

v A column header: Each log or trace record contains multiple fields, some more
interesting than others. The term column header refers to these items.

v A filter predicate describes an expression that the LogViewer uses to determine
if a particular record will be present in the output. Contrast with column header,
which describes a field within the record.

Starting the LogViewer
You can start the viewer either by the wrapper script (recommended) or direct
JVM invocation.

Using the wrapper script: In Windows, the wrapper script is located at
MS_HOME\logviewer. You can start the LogViewer by running the following
command:
viewer.bat [(-q Query_String) | (-f filename)]

[-s (text | html)]
[-h]
<input1.xml> [<input2.xml> <input3.xml> ...]

where:
v -q specifies a query string, which defines what will be in the output and the

format of that output. See “Specifying the query string” on page 13.
v -f specifies a file that contains the query string.

Only one of -q or -f can be specified.
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v -s specifies either text or html output (default is html). The html output is in
UTF-8 encoding. Text output is in the default encoding of the console where the
command is issued.

v -h displays the usage statement.
v All other arguments are interpreted as log XML input files. When multiple input

files are given, the log and trace records are merged based on the timestamp.

In UNIX, the wrapper script is located at MS_HOME/logviewer. You can start the
LogViewer by running the following command:
viewer.sh [(-q Query_String) | (-f filename)]

[-s (text | html)]
[-h]
<input1.xml> [<input2.xml> <input3.xml> ...]

Direct JVM invocation: To start the LogViewer by direct JVM invocation, please
set the CLASSPATH environment variable such that the following binary files are
included:
v jlog.jar
v viewer.jar
v xmlparserAPIs.jar
v xercesImpl.jar
v regex4j.jar

Run the following command to start the LogViewer:
java -DVIEWER_HOME=

[-DTRACE=DEBUG_MIN]
[-DSHOWTITLE=TRUE]
com.tivoli.log.viewer.Cli
[(-q Query_String) | (-f filename)]
[-s (text | html)]
[-h]
<input1.xml> [<input2.xml> <input3.xml> ...]

where:
v the -DVIEWER_HOME system property defines the location of the stylesheet

(.css) files. These stylesheets will be embedded in the output HTML file.
v the -DTRACE system property defines the level of tracing. The default is

DEBUG_MIN, but DEBUG_MID and DEBUG_MAX are also valid settings.
v the -DSHOWTITLE system property directs the HTML formatter to either

include or omit the title. The default is to include the title. The title consists of a
comma-separated list of input filenames.

v -cp "viewer.jar:jlog.jar:xercesImpl.jar:xmlparserAPIs.jar:regex4j.jar" indicates to
the JVM which .jar files must be available so the viewer can function. If these
.jar files are not in the current directory, provide the full pathname to each .jar
file.

Note: This example uses the UNIX colon separator ':'. In DOS, this would be a
semicolon, ';'.

v -q specifies a query string, which defines what will be in the output and the
format of that output. See “Specifying the query string” on page 13.

v -f specifies a file that contains the query string.
Only one of -q or -f can be specified.
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v -s specifies either text or html output (default is html). The html output is in
UTF-8 encoding. Text output is in the default encoding of the console where the
command is issued.

v -h displays the usage statement.
v All other arguments are interpreted as log XML input files. When multiple input

files are given, the log and trace records are merged based on the timestamp.

Specifying the query string: The query string has the following format:
select column[,column] where Filter_Predicate

Following the reserved word "select" comes one or more column headers. These
are the elements of the log or trace records that will appear n the output. A
timestamp is always displayed in the output for each record.

After the reserved word "where" comes a filter predicate, which determines which
records will be present in the output.

The default query string is:
select default where true

Table 4 lists the column names.

Table 4. Available column names for LogViewer queries

column header datatype content

all select all columns

default default columns are Time, Severity, MessageId,
LogText, Server, ProductId, Component, and
ProductInstance

Element string either Message or Trace

Time string localized time

Millis long int time in milliseconds

Server string server name or IP address

ServerFormat string for example, TCP/IP

Client string client name

ProductId string three letters

Component string

ProductInstance string

LogText string

SourceFile string name of the source file where the event was
generated

SourceMethod string name of the method that generated the event

SourceLine string line number where the event was generated

CorrelationId string

Principal string

Process string

Thread string

Exception string

MessageId string
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Table 4. Available column names for LogViewer queries (continued)

column header datatype content

TraceLevel string

Severity string

LogAttribs string

Note: The column headers are not case sensitive.

Specifying the filter predicate: A filter predicate can be either an expression or
the reserved word "true", which is a complete filter expression that indicates
filtering is disabled and that every log and trace record should be output.

Conditional operators used in the filter predicate:
v = (equal)
v > (greater than)
v < (less than)
v >= (greater than or equal to)
v <= (less than or equal to)
v <> (not equal to)
v MATCH. The MATCH pattern-matching operator is a very powerful operator

that allows you to select log or trace records using regular-expression syntax.
Strings with either special characters or spaces used in the regular expression
must be enclosed in single quotes.

Boolean operators used in the filter predicate are OR and AND. Boolean operators
conjoin two expressions. They must take the form:
(expression) OR (expression)
(expression) AND (expression)

The parentheses are required around each expression.

Error handling: The query string is verified for correctness, and processing halts
if the query string is malformed. The column labels are validated. Each
command-line argument is validated; if an invalid argument value is specified,
processing halts. If one of the input log XML files is malformed, there will be no
further attempt to read from that file; however, other input files will be processed.

Examples: Show the default fields of all message and trace records in html form:
viewer sample.xml > sample.html

Select for display all fields with a correlation ID of 12. The output is sent to stdout:
viewer -q"select all where CorrelationId = 12" -stext sample.xml

Display all fields with a timestamp less than 1007067881373 milliseconds
(Timestamp is the only column name that takes a numeric argument instead of a
string). Output is in text format, written to stdout:
viewer -q"select all where Millis < 1007067881373" -stext sample.xml

Display only the server and the product ID that meet the boolean expression. Since
boolean operators are present, parentheses indicate the order of operator
evaluation. Input is merged from three files: sample1.xml, sample2.xml, and
sample3.xml:
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java -DVIEWER_HOME="./" -DTRACE="DEBUG_MAX" com.tivoli.log.viewer.Cli
-q"select server,ProductId where (messageid MATCH ’FRWEP00[10-45]’)

AND ((server = ’joe’) OR (severity = ’ERROR’))"
sample1.xml sample2.xml sample3.xml

Filter on the log attribute with the name FNG and the value 123:
viewer -q"select default where LogAttribs MATCH ’FNG=123’" sample.xml

Troubleshooting: Boolean operators require parentheses. The following example
demonstrates the strictness of boolean evaluation:
viewer -q"select default where (server = ’joe’) AND (element = ’trace’)

AND (messageID=’FRWEP0001E’)"

This results in the following error:
2002.04.10 14:52:19.755 com.tivoli.log.viewer.QueryTree labels Tivoli IVR 1
log viewer wintest2.dev.tivoli.com IP
IVR0019E unexpected character after query: AND

The solution is to ensure that each boolean expression has the form "(expression)
OR (expression)" or "(expression) AND (expression)". So in this case, we could
change the example to:
viewer -q"select default where ((server = ’joe’) AND (element = ’trace’))

AND (messageID = ’FRWEP0001E’)"

Using quotes in the query string: The following example attempts to make a query
using the MATCH operator, but the query string is not delimited by double quotes:
viewer.sh -qselect default where logText match ^get *.xml

This results in the following error:
2002.03.29 14:21:47.014 com.tivoli.log.viewer.QueryTree labels Tivoli IVR 1
log viewer aix102.dev.tivoli.com IP IVR0017E missing column label

When a query is incomplete, LogViewer issues an error to indicate which
component of the query string was found to be missing. In this example it was
expecting to find a column label, but the string terminated. Without double quotes
around the query string, the shell provides each word of the query in a different
argument, resulting in the string appearing as "select". We can correct the situation
by adding double quotes around the query string like so:
viewer.sh -q"select default where logText match ^get" *.xml

Upon running this corrected query, we get the following error:
2002.03.29 14:18:53.423 (null) main Tivoli IVR 1
log viewer jrowlan2.dev.tivoli.com IP
IVR0021E Invalid character ^ found in query string.

The query syntax allows values to be enclosed in single quotes, which signal to the
viewer that the string inside the single quote need not be parsed:
viewer.sh -q"select default where logText match ’^get’" *.xml

Single quotes are also required if the term contains spaces. Directory names and
file names occasionally contain spaces. Since the viewer accepts space-separated
file names, this creates ambiguity. The following could be interpreted either as two
separate files , "a" and "b/c", or as a single file, "c", in subdirectory "a b":
viewer a b/c

To resolve this, use quotes around any file name that contains spaces. For example:
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viewer "a b/c"

identifies a file named "c" in subdirectory "a b", whereas
viewer a b/c

identifies two files, "a" and "c in subdirectory b".

Tracing and logging within the Tivoli Enterprise Portal (Summary
Workspaces)

On the Tivoli Enterprise Portal server and client, ITCAM for Application
Diagnostics installs custom code for the Summary Workspaces.

In case of unexpected behavior in these workspaces you may perform tracing both
on the server (backend) and on the client (desktop or Web). The tracing results will
be available in log files.

Tracing and logging within the Tivoli Enterprise Portal Server
To turn on tracing on the Tivoli Enterprise Portal Server, edit the following file:
v on Windows, ITM_home\cnps\kfwenv
v on UNIX systems or Linux, ITM_home/config/cq.ini

If there is a line starting with SET KBB_RAS1 = , append the following text to this
line:

(UNIT:ITCAMWREvaluatorImpl INPUT ERROR DETAIL)(UNIT:SituationProcessor
INPUT ERROR DETAIL)(UNIT:TepsQueryHelper INPUT ERROR DETAIL)

If such a line does not exist in the file, add the following line to it:
SET KBB_RAS1 = ERROR (UNIT:ITCAMWREvaluatorImpl INPUT ERROR DETAIL)
(UNIT:SituationProcessor INPUT ERROR DETAIL)
(UNIT:TepsQueryHelper INPUT ERROR DETAIL)

After this, restart the Tivoli Enterprise Portal Server. Re-create the unexpected
behavior, and get the following log file:
v on Windows, ITM_home\CNPSJ\profiles\ITMProfile\logs\ITMServer\

SystemOut.log

v on UNIX systems or Linux, ITM_home/ITM_BINARCH/iw/profiles/ITMProfile/
logs/ITMServer/SystemOut.log

Tracing and logging within the Tivoli Enterprise Portal desktop
client on Windows

To turn on tracing on the Tivoli Enterprise Portal desktop client on Windows, edit
the file ITM_home\cnp\cnp.bat . Change the following line:
set _CMD= %_JAVA_CMD% -Xms64m -Xmx256m -showversion -noverify =-classpath %CPATH%
-Dkjr.trace.mode=LOCAL -Dkjr.trace.file=C:\IBM\ITM\CNP\LOGS\kcjras1.log -Dkjr.
trace.params=ERROR -DORBtcpNoDelay=true -Dibm.stream.nio=true -Dice.net.
maxPersistentConnections=16 -Dice.net.persistentConnectionTimeout=1 -Dcnp.http
.url.host=SVOINEA2 -Dvbroker.agent.enableLocator=false candle.fw.pres.CMWApplet

to:
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set _CMD= %_JAVA_CMD% -Xms64m -Xmx256m -showversion -noverify -classpath %CPATH%
-Dkjr.trace.mode=LOCAL -Dkjr.trace.file=C:\IBM\ITM\CNP\LOGS\kcjras1.log -Dkjr.
trace.params="ERROR (UNIT:WR DETAIL)" -DORBtcpNoDelay=true -Dibm.stream.nio
=true -Dice.net.maxPersistentConnections=16 -Dice.net.persistentConnectionTimeout
=1 -Dcnp.http.url.host=SVOINEA2 -Dvbroker.agent.enableLocator=false candle.fw.pres
.CMWApplet

Then restart the Portal client, re-create the unexpected behavior, and exit the Portal
client.

Get the following log files: ITM_home\cnp\kcjras1*.log

Tracing and logging within the Tivoli Enterprise Portal desktop
client on UNIX systems or Linux

To turn on tracing on the Tivoli Enterprise Portal desktop client on UNIX systems
or Linux, edit the file ITM_home/ITM_BINARCH/cj/bin/cnp.sh . Change the following
line:
${TEP_JAVA_HOME}/bin/java -Xms64m -Xmx256m -showversion -noverify
-classpath ${CPATH} -Dkjr.trace.mode=LOCAL
-Dkjr.trace.file=/opt/IBM/itm621/Home/logs/kcjras1.log
-Dkjr.trace.params=ERROR -Dibm.stream.nio=true
-DORBtcpNoDelay=true -Dcnp.http.url.host=
-Dkjr.browser.default=/usr/bin/mozilla -Dvbroker.agent.enableLocator=false
-Dhttp.proxyHost= -Dhttp.proxyPort= candle.fw.pres.CMWApplet
$1 $2 $3 $4 $5 $6 $7 $8 $9 $10 2>&1 1>> ${LOGFILENAME}.log

to:
${TEP_JAVA_HOME}/bin/java -Xms64m -Xmx256m -showversion -noverify
-classpath ${CPATH}
-Dkjr.trace.mode=LOCAL -Dkjr.trace.file=/opt/IBM/itm621/Home/logs/kcjras1.log
-Dkjr.trace.params="ERROR (UNIT:WR DETAIL)" -Dibm.stream.nio=true
-DORBtcpNoDelay=true -Dcnp.http.url.host= -Dkjr.browser.default=/usr/bin/mozilla
-Dvbroker.agent.enableLocator=false -Dhttp.proxyHost= -Dhttp.proxyPort=
candle.fw.pres.CMWApplet $1 $2 $3 $4 $5 $6 $7 $8 $9 $10 2>&1 1>>
${LOGFILENAME}.log

Then restart the Portal client, re-create the unexpected behavior, and exit the Portal
client.

Get the following log files: ITM_home/logs/kcjras1*.log

Tracing and logging within the Tivoli Enterprise Portal Web
client

To turn on tracing on the Tivoli Enterprise Portal Web client, edit the following file
on the Tivoli Enterprise Server host:
v on Windows, ITM_home\CNB\applet.html
v on UNIX systems or Linux, ITM_home/ITM_BINARCH/cw/applet.html

Change the following line:
<PARAM NAME = "kjr.trace.params" VALUE="ERROR">

to
<PARAM NAME = "kjr.trace.params" VALUE="ERROR(UNIT:WR DETAIL)">

On a Windows system, launch a Web browser, re-create the unexpected behavior of
the Tivoli Enterprise Portal, and exit the browser.
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Then, get the following log files: C:\Documents and Settings\username\
Application Data\IBM\Java\Deployment\log\*.trace

Environment Checking Utility
The Environment Checking Utility (ECU) is a stand-alone tool. You can use this
utility to check the prerequisite packages before launching the ITCAM Agent for
WebSphere Applications installer, ITCAM Agent for WebSphere Applications
configuration, or Managing Server installer. The ECU generates a report to specify
if the prerequisite packages have been installed correctly. The prerequisite packages
are registered in a property file. The property file can be extended if new
prerequisite packages or libraries are required.

To get the Environment Checking Utility, use IBM Passport Advantage
(http://www.ibm.com/software/passportadvantage). Search for the IBM Tivoli
Composite Application Manager for Application Diagnostics V7.1: (ITCAMAD71)
Managing Server Component. The ECU is also shipped as a part of the ITCAM for
Application Diagnostics installation media set.

Complete the following installation steps before launching the Environment
Checking Utility:
1. Install the Runtime Environment for the Java platform version 1.4.2 or higher.
2. Set JAVA_HOME in the system environment variables.
v For Windows, set JAVA_HOME=JRE_PATH
v For Linux and UNIX systems, JAVA_HOME=JRE_PATH; export JAVA_HOME

3. Use one of the following commands to launch the ECU:
v For Windows, envcheck.bat
v For Linux and UNIX systems, envcheck.sh
On UNIX systems, to ensure the ECU can gather all the necessary operating
system information, log on as the root user.

4. Use the following command line to launch the ECU on Windows:
envcheck.bat -reportPath Report_save_path [-check Configuration_file_name]
[-logPath Log_path] [-tmpPath Tmp_path] [-showSteps] [-noWizard] [-help]

On Linux and UNIX systems, use the following command line to launch the
ECU:
./envcheck.sh -reportPath Report_save_path [-check Configuration_file_name]
[-logPath Log_path] [-tmpPath Tmp_path] [-showSteps] [-noWizard] [-help]

You can use the following parameters:
a. -reportPath Report_save_path

This parameter is required. The ECU generates a report of all the content
checks. Report_save_path indicates the path name to save the report to.

b. -check Configuration_file_name

This parameter is optional. You can use this parameter to specify the
configuration file for this release. There are two configuration files -check
itcamfwas_dc and -check itcamfwas_ms in the ECU command line.
v itcamfwas_dc: defines the environment check steps and parameters for

the Data Collector
v itcamfwas_ms: defines the environment check steps and parameters for

the Managing Server
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If you do not specify the -check parameter option in the command line at
the beginning of ECU execution, the ECU will prompt you to select one of
the configuration files.

c. -logPath Log_path

This parameter is optional. It indicates the log path name for the ECU. The
default log directory is ECU_PATH/logs.

d. -tmpPath Tmp_path

This parameter is optional. It indicates the temporary directory for ECU.
The default temporary directory is ECU_PATH/tmp.

e. -showSteps

This parameter is optional. If you have this parameter in the command line,
the ECU will prompt you with steps generated by a navigation wizard.

f. -noWizard

This parameter is optional. If you have this parameter in the command line,
the ECU will not prompt you for any wizard navigation inputs but the
following options are available: Back, Next or Cancel.

g. -help

This parameter is optional. Display information on available options.
5. The ECU performs the following checks. You are prompted to enter any

additional information if required.
a. OS Information check.

Checks operating system version, release, architecture, bit mode, and user
information.

b. Prerequisite OS packages and libraries check.
On a UNIX platform, the ECU checks the prerequisite packages of ITCAM
Agent for WebSphere Applications Data Collector and ITCAM Agent for
J2EE Data Collector.

c. Processor and memory information check.
Checks the information processors and memory.

d. Database information check.
Checks installed DB2 information.

e. Ports check.
Checks the default ports of the Data Collector.

f. Select WebSphere Home.
Selects the WebSphere Application Server home directory to check.

g. WebSphere Information check.
Checks the selected WebSphere Application Server information.

h. Global Security Status check.
Checks the Global Security Status of selected WebSphere Application Server
information.

i. Select Application Server Instance.
Selects the application server instances to check.

j. JVM parameters check.
Checks the JVM parameters of selected application server instances.

k. WebSphere Connection wsadmin check.
Checks the wsadmin connection of selected application server instances.

l. Generate Java Core.

Chapter 1. Log files, tracing, and utilities 19



Generates Java core of selected application server instances.
m. Open source J2EE frameworks check.

Checks if open source J2EE frameworks are installed on the selected
application server instances.

n. Third-party tools check.
Checks if third-party tools are installed on the selected application server
instances.

o. Other Tivoli products check.
Checks if other Tivoli products are installed on the selected application
server instances.
The ECU generates a report of the content checks and saves it to the
location specified by the -reportPath parameters.

Installing Memory Dump Diagnostic for Java with IBM Support
Assistant

Memory Dump Diagnostic for Java (MDD for Java) either analyzes a single heap
dump or analyzes and compares two heap dumps and searches for evidence of a
memory leak. In order to download MDD for Java, you will need to first install
IBM Support Assistant (ISA). ISA provides extra help with diagnosing problems
and provides extra tools and components for troubleshooting as well as providing
a place to write problems (PMRs).

You can either manually take a heap dump or schedule a heap dump using MDD
for Java's Heap Dump Management feature.

The Heap Dump Management feature allows you to schedule or immediately
initiate the collection of an IBM Heap Dump for a particular application server.
Then this dump must be downloaded and post-processed outside ITCAM's user
interface (Application Monitor) using MDD for Java. The other Memory Diagnosis
tools provided by ITCAM, such as Memory Analysis, Heap Analysis and Memory
Leak Diagnosis, provide analysis via the Application Monitor.

MDD for Java only analyzes heap dumps from IBM JDKs. For non-IBM JDKs use
the ITCAM Memory Leak Diagnosis feature.

If you are using an OS/400 system, MDD for Java is only supported on PASE JDK.

Searching capabilities are not supported for ITCAM for Application Diagnostics in
ISA.

Where to install ISA and MDD for Java
The following are two common configurations:
v Install ISA & MDD for Java on a standalone server that is not running an

application server. After the IBM heap dump has been collected on the
application server, it must be transfered to the MDD for Java computer for
post-processing.
This configuration is recommended for production environments where you do
not want the post-processing of the dump to impact the performance of the
application server.

v Install ISA and MDD for Java on each application server host machine, so that
you can analyze the heap dump locally without having to transfer it.
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This configuration may be suitable for a development or test environment where
the overhead of analyzing the heap dump is not a concern.

The decision on where to install may also be influenced by the platforms
supported by ISA.

Downloading ISA
To download ISA, perform the following procedure:
1. Go to the following URL:https://www14.software.ibm.com/webapp/iwm/

web/preLogin.do?source=isa
2. If you do not have a universal IBM user ID, you will need to click register now

and fill in the required information. Upon completion, you can return to this
page and sign in to download ISA.

3. After signing in, select the radio button to download IBM Support Assistant
Version 3.0.0.1.

4. Click Continue.
5. Select View license. After reading the license, click the I agree check box and

then click I confirm to continue with the download.
6. Click Download now next to the correct platform. It is suggested you

download to the server on which the Data Collector is installed.
7. Click Save to download ISA to your hard drive.

Installing ISA
Perform the following procedure to install ISA:
1. Go to the directory on your hard drive where you saved the ISA zip file.
2. Extract the files.
3. Double-click the setupwin32.exe file.
4. Follow the installation instructions to install ISA.
5. Open the ISA program.

Installing MDD for Java
Perform the following procedure to install MDD for Java:
1. Double-click Updater to open it.
2. Select the New Products and Tools tab.
3. Open the WebSphere directory by clicking the + sign.
4. Click the check box to select WebSphere Application Server. (The version you

select does not matter.)
5. Click Install.
6. Select the feature under Features to Install and review the license.
7. Click Yes to accept the license.
8. Click OK to accept the following message that displays:

New product plug-ins or tool plug-ins were installed successfully.
Please make sure to restart IBM Support Assistant for these changes
to take effect.

9. Click Install.
10. Click OK to accept the following message that displays:
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Reminder–You are installing a common component tool.
After installation, you may not see the common component tool in the
Tools component.
Common component tools only display in the Tools component
if a product is added that uses them.

This is why you need to install a version of WebSphere.
11. Select Memory Dump Diagnostic for Java under the Features to Install and

review the license.
12. Click Yes to accept the license.
13. Click OK at the restart IBM Support Assistant message.
14. Close and restart ISA.
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Chapter 2. Troubleshooting: ITCAM Agent for WebSphere
Applications

The following troubleshooting tips and techniques apply to problems that occur
during ITCAM Agent for WebSphere Applications installation, configuration and
running.

Installation and configuration
The following troubleshooting tips and techniques apply to problems that occur
during installation and configuration.

All platforms
This section describes the problems and troubleshooting that can apply to all
platforms, which are probably not related to any unique platform.

Classpath for the portal client is missing
The problem: When installing and configuring Tivoli Enterprise Monitoring Agent
for ITCAM for WebSphere, a jar file is missing in the classpath for the portal client,
which is used to display the resources of an application server.

The solution: Assuming you have installed IBM Tivoli Monitoring in /opt/IBM/ITM,
cd to /opt/IBM/ITM/li6243/cj/bin. Edit the file cnp.sh. Look for the classpath
entry, and add the following to the end:
${KCJ_LIB}/kyn_resources.jar

This jar file is what substitutes the resource names in the Linux client.

Note: This problem only occurs on the portal client on Linux. When you install
browser support or application support on a portal client running on Windows,
this problem does not exist.

Data Collector cannot work with several deployment managers in
WebSphere Application Server XD environment
The question: Can the Data Collector configurator work with 2 deployment
managers?

The answer: Data Collector configurator doesn't work with 2 deployment
managers. Such an installation is not supported - this is a restriction in an XD
environment.

Data Collector configuration tips
The following content provide some tips on Data Collector configuration.

Configure the Data Collector when using hyphenated Managing Server
host name or a lengthy FQDN

The problem: How to configure the Data Collector when using hyphenated
Managing Server host name or a lengthy fully qualified domain name (FQDN).

The reason: If you are using a hyphenated Managing Server host name or a
lengthy FQDN, the Data Collector Config may fail during configuration.
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The solution: To resolve this problem, continue the configuration even if the
configuration says it cannot reach the Managing Server. After the configuration is
complete, simply edit the
app_server_name.node_name.server_name.datacollector.properties file in the
DC_home/runtime/node_name directory using the following method:

Change the hyphenated host name or FQDN in the kernel.codebase and
kernel.rfs.address fields in this file to the IP address of the Managing Server and
then restart the server. Also, if needed, make changes to wherever referred to the
lengthy Managing Server FQDN in this file.

Non-root Data Collector configuration cannot lock system preferences

The problem: When using a non-root user to install and configure the Data
Collector, system preferences cannot be locked. The following error is displayed in
the console:
java.lang.SecurityException: Could not lock System prefs. Lock file access denied.
at java.util.prefs.FileSystemPreferences.
checkLockFile0ErrorCode(FileSystemPreferences.java:937)
at java.util.prefs.FileSystemPreferences.lockFile(FileSystemPreferences.java:926)
at java.util.prefs.FileSystemPreferences.sync(FileSystemPreferences.java:732)
at java.util.prefs.FileSystemPreferences.flush(FileSystemPreferences.java:825)
at java.util.prefs.FileSystemPreferences.syncWorld(FileSystemPreferences.java:476)
at java.util.prefs.FileSystemPreferences.access$1200(FileSystemPreferences.java:51)
at java.util.prefs.FileSystemPreferences$4.run(FileSystemPreferences.java:437)
at java.util.TimerThread.mainLoop(Timer.java:447)
at java.util.TimerThread.run(Timer.java:397)

The reason: This problem is a limitation of JRE, please reference
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4438983 for more
information.

Verifying the Data Collector Configuration

The question: How can I verify if the Data Collector was configured properly?

The answer: The best way to tell if the ITCAM for WebSphere Data Collector is
configured properly is to check the following items.
v When using an ITCAM console (which is part of the Managing Server):

– If the Data Collector shows up in the ITCAM console, it means that:
1. the WebSphere definitions are added properly;
2. the files in the DC_home/runtime directory were created with no permission

problems;
3. the network connectivity is good between the Managing Server and the

Data Collector.
– The Managing Server must be at an equal or greater fix pack level than the

Data Collector. You can verify the fix pack level by comparing the following
two files:
- MS_home/etc/am-version.properties

- DC_home/itcamdc/etc/version.properties

v When using a Tivoli Enterprise Portal Interface:
– You can verify that the Data Collector is connected to the Tivoli Enterprise

Monitoring Agent by verifying that the WebSphere Application Server icon
and the tree that is displayed under it in the navigator are present and
available.
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– The Tivoli Enterprise Monitoring Agent and the Data Collector must be at the
same level. You can verify it by comparing the Data Collector level in
DC_home/itcamdc/etc/version.properties to the Tivoli Enterprise Monitoring
Agent level which can be determined by running the following commands on
the Tivoli Enterprise Monitoring Agent machine:
- For UNIX: ITM_home/bin/cinfo -i

- For Windows: ITM_home/InstallITM/kincinfo -i

– If Tivoli Enterprise Portal screens have bad labels in the navigation tree or if
workspaces are not formatted properly for tables/graphs, you may have a
problem with the wrong level of Application Support Files being installed on
the Tivoli Enterprise Monitoring Server /Tivoli Enterprise Portal Server
/Tivoli Enterprise Portal Desktop as compared to the Tivoli Enterprise
Monitoring Agent. Use the preceding commands on the Tivoli Enterprise
Monitoring Agent, Tivoli Enterprise Monitoring Server, Tivoli Enterprise
Portal Server, and Tivoli Enterprise Portal Desktop to confirm that all are in
consistence. For ITCAM Agent for WebSphere, the two byte code is yn; for
ITCAM Agent for HTTP Servers, the two byte code is ht.

Data Collector installation fails
The following content provide some solutions when Data Collector installation
fails.

Data Collector installation/configuration fails

The problem: The directory DC_home/runtime is not created and the start-up script
or other files on application server side are not modified for Data Collector
support.

The solution: For a GUI installation, a message panel will pop up to show detailed
error information. Check this message to find if the prerequisite conditions are not
met.

For a silent installation, please check installation log files and find messages with
log level ERROR or WARN.

Data Collector remote upgrade fails with BWMCR9502 error

The problem: When upgrading ITCAM for WebSphere 6.1 Data Collector to 7.1,
remote upgrade fails with the following message returned:
BWMCR9502 error: Failed to unconfigure the server instance.

However, the local upgrade and unconfiguration finished successfully. This issue is
prevalent in VM environments. It occurs when carrying out the following steps:
1. Remote upgrade WebSphere agent.
2. Start WebSphere agent.
3. Click Configure link on the Tivoli Enterprise Portal.
4. Configuration completes.
5. Error occurs.

The reason: The wsadmin command return code is 1 when unconfiguring the
ITCAM for WebSphere 6.1 Data Collector, which causes the upgrade to fail.

The solution: First try to restart remote upgrade. If the problem persists after you
try a restart, manually unconfigure the WebSphere Application Server in the Data
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Collector configuration tool, and configure this WebSphere Application Server
instance using the 7.1 configuration tool again.

The installation fails if you install the Data Collector from a directory
whose name contains space

The problem: The installation fails if you install the Data Collector from a directory
whose name contains space.

The solution: Unpack the installation files of the Data Collector in a directory
whose name does not contain any space before the installation.

The installation of the Data Collector fails if you mount the installation
CD as a non-root user

The problem: The installation of the Data Collector fails if you mount the
installation CD as a non-root user.

The solution: Mount the installation CD of the Data Collector as a root user.

Unable to install ITCAM for Application Diagnostics on a server that
has ITCAM for RTT registered to use the JVMPI interface

The problem: If you select a server that has ITCAM for Response Time Tracking
(RTT) registered to use the JVMPI interface, the installation on that server is
skipped.

The solution: You must temporarily disable the RTT probes with the
RTT_home/MA/app/instrument/60/bin/enableprobes.sh command before installing
ITCAM for Application Diagnostics, then use the enableprobes.sh command to
re-enable the RTT probes. For usage and parameters for this command, see the
IBM Tivoli Composite Application Manager for Response Time Tracking Command
Reference.

Error message is displayed during Data Collector configuration
The following content provides information about the error messages you might
receive during Data Collector configuration.

Database error message during Data Collector configuration

The problem: Sometimes during the Data Collector configuration the console may
display the following error message:
There are 1 database connections that are in use that should have been closed:
Driver = org.hsqldb.jdbcDriver: URL= jdbc:hsqldb:/tmp/ismp001/1495215/idsb;
user = sa
java.lang.NullPointerException

The reason: This is a limitation of the InstallShield program and will not affect the
Data Collector configuration process.

Failure configuring application server

The problem: In the Configuration Summary panel, you may encounter the
following message:
Failure configuring application server
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The reason: One of the reasons you see this message is that the application server
has been configured already and another Data Collector instance is already
monitoring the application server.

The solution: Contact IBM Support.

MissingResourceException occurs after Data Collector is connected to
Managing Server in FFDC

The question: Why does the following error occur in the application server logs
after the Data Collector is connected to the Managing Server in FFDC?
MissingResourceException: Can’t find bundle for base name
com.ibm.ws.wswebcontainer.stats.webAppModuleStatsResourceBundle

The answer: The system is operating as designed. This problem is a WebSphere
Application Server limitation. You can ignore this message.

Error message "JACL failed" displays when running
UpdateInstaller
The problem: After deleting the WebSphere profile, the error message "JACL failed"
displays when running the UpdateInstaller.

The cause: After deleting the WebSphere profile, its Data Collector installation log
and runtime data is still in the system. As a result, UpdateInstaller still has the
reference to the deleted WebSphere profile and encounters errors during JACL
operation.

The solution: Before deleting the WebSphere profile, perform the following steps to
remove the installation log, runtime data of the Data Collector, and its parameters
from the WebSphere profile:
1. Run config_dc.sh (in UNIX) or config_dc.bat (in Windows) file in

ITCAM_home/bin to unconfigure Data Collector.
2. Remove the WebSphere profile.
3. Run UpdateInstaller.

If you did not run the config_dc.sh file before deleting the WebSphere profile,
perform the following steps:
1. Delete all of the configuration information relating to the deleted WebSphere

profile under ITCAM_home/runtime and ITCAM_home/_uninstall.
2. Run UpdateInstaller.

Error messages occur in the log files after installing the JVMTI
interim fix on Sun JDK 1.5.0
The problem: If you have Sun JDK 1.5.0 and have installed the JVMTI interim fix
for the Data Collector, log error messages like the following one will occur when
you restart the application server:
java.lang.StackOverflowError
at
sun.reflect.generics.reflectiveObjects.TypeVariableImpl.getBounds
(TypeVariableImpl.java:114)

This indicates an unsuccessful configuration of the Data Collector.

The solution: Upgrade the JDK version to Sun JDK 1.5.0_6 or later.
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Failure to access the Oracle Application Server Enterprise
Manager after configuring the Data Collector
The problem: Fail to access the Oracle Application Server Enterprise Manager after
configuring the Data Collector

The reason: The Data Collector checks and weaves each class that is loaded by the
Oracle Application Server Enterprise Manager when you access to the Oracle
Application Server Enterprise Manager after the configuration of the Data
Collector.

The solution: Access the Oracle Application Server Enterprise Manager when the
Data Collector finishes checking and weaving each class that is loaded by the
Oracle Application Server Enterprise Manager.

Incomplete list of servers shown during the installation
The problem: Incomplete list of servers shown during the installation after selecting
a node.

The solution: Click the Back button to go back to the previous panel, then click the
Next button again without making any changes.

Manually changing the Tivoli Enterprise Monitoring Agent host
name in ITCAM Agent for WebSphere Applications Data Collector
The problem: You want to manually change the host name or IP address for the
Tivoli Enterprise Monitoring Agent connection in the Data Collector.

The symptom: Host name or IP address for Tivoli Enterprise Monitoring Agent for
ITCAM Agent for WebSphere Applications changes and now the Data Collector is
not communicating with the monitoring agent. No data is shown in Tivoli
Enterprise Portal.

The solution: Perform the following steps:
1. Find the /usr/lpp/itcam/WebSphere/runtime/server/server/kwjdc.properties

file
2. Edit the value of the following property to your new name:

com.ibm.tivoli.kwj.agenthostname=

3. Save and restart the agent.

Only one log file can be found after multiple CICS DCs were
installed on the same computer
The problem: Only one log file can be found after multiple CICS® DCs were
installed on the same computer.

The solution: If you follow the documentation and are installing multiple CICS
DCs on the same host system, the log files override each other. The problem is the
logs are now placed in /var/ibm/tivoli/common/CYN/logs/msg-cicsprobe-
native.log. Edit the following two files in the CICS Data Collector runtime
directory:
v In ITCAM_runtime/cics/CICS_APP_ID/etc/cyn-cclog.properties, change the

following line:
handler.file.dc.msg.fileName=msg-cicsprobe-native.log

to
handler.file.dc.msg.fileName=msg-cicsprobe-<app_id>-native.log
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v In ITCAM_runtime/cics/CICS_APP_ID/etc/cynlogging.properties, change the
following line:
CYN.handler.file.msg.fileName=msg-cicsprobe.log

to
CYN.handler.file.msg.fileName=msg-cics-<app_id>-probe.log

Required permissions for Data Collector configuration for
WebSphere Application Server
The question: How can I create a non-administrator WebSphere Application Server
user ID?

The answer: WebSphere Application Server has four administration roles: Monitor,
Configurator, Operator and Administrator (with the privileges from least to most).
The best way is to configure a user id as a WebSphere Application Server operator,
because in this way a new V6.1 feature (dynamic PMI change) works fine. The
Monitor role may be the second place, for the new feature (dynamic PMI change)
does not work with Monitor and Configurator roles, even that Data Collector's
data collection in PMI and JMX areas are fine.

The user ID is configured in DC_home/runtime/platform.node.server/
platform.node.server.datacollector.properties, and can belong to one of the
four roles - Monitor, Configurator, Operator, Administrator. The following is the
comparison on the four roles.

Table 5. Comparison on administration roles of WebSphere Application Server

MS VE Page
Data
Reported Monitor Configurator Operator Administrator

Availability-
Servers

Sessions/
minute,
Deployed
.ear

OK OK OK OK

Availability-
Recent
Activity
Display

Live Sessions OK OK OK OK

Availability-
System
Resource

-----
Overview

Most PMI
Data

OK OK OK OK

----- JMX data JMX and PMI
Data

OK OK OK OK

PD-Runtime
Environment
Check

HTTP
Transport
Configuration

OK OK OK OK

Dynamic PMI
Level Change

Change PMI
Level per
MOD Level

No No OK OK

Special requirements for CICS installation
The problem: Running the CICS installation script has some special requirements.
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The solution: The CICS installation script must locate in an directory structure like
.xxx.cics.CICS1/bin. The following is an example:
CS000:/u/train01/itcam/cics/CICS1/bin #>./setupcics.sh
Enter ITCAM install directory name:[/u/train01/itcam]

Enter ITCAM runtime directory name:[/u/itcam]
/u/train01/itcam
Enter the CICS region name (APPLID) to monitor:[cics]
CICS23T2
Do you want to enable ITCAM for WebSphere support:[y or n]
y
Enter the IP address of the ITCAM Managing Server:[127.0.0.1]
9.48.138.202
Enter ITCAM Managing Server install directory:[/opt/itcam]
/opt/IBM/itcam/WebSphere/MS
Do you want to enable RTT Support:[y or n]
y
What is the RTT port number:[32323]
32323
Enter the name of the TMTP MA install directory:
/u/ssood/tmtp61/V6R1M0/MA
CICS23T2 configuration created in /u/train01/itcam/cics/CICS23T2

This will in turn create the /u/train01/itcam/cics/CICS23T2. with a correctly
populated datacollector.properties and other files for the region.

The monitoring agent fails to start
The problem: Tivoli Enterprise Monitoring Agent fails to start with error message
"ERROR: required environment variable KWJ_PROD is not set" in the native
monitoring agent log file after it is upgraded to a newer release or fix pack.

The solution: To workaround the problem, perform the following steps:
1. From the management console, select Manage Tivoli Services → Advanced →

Unconfigure.
2. And then select Manage Tivoli Services → Advanced → Configure using

defaults.

Uninstalling the Data Collector
The following content provides information about uninstalling the Data Collector.

Generic JVM argument for Data Collector still exists after
uninstallation

The problem: After Data Collector uninstallation, a Generic JVM arguments of the
Data Collector, such as -Djlog.qualDir=tivc06Node01.server7 still exists in the
WebSphere Application Server administrative console.

The solution: The Data Collector can be successfully reinstalled later. Manually
remove the arguments for a complete cleanup if desired.

Manually uninstalling the Data Collector

The problem: One of the following problems occurred:
v Problems occurred during the installation of the Data Collector and no

configuration took place.
v Data Collector configuration started but failed.

Now you have to uninstall the Data Collector manually.
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The solution: If problems occurred during the installation of the Data Collector and
no configuration took place, remove the DC_home directory and all files and
subdirectories under DC_home.

If Data Collector configuration started but failed, perform the following
procedures:
1. Log onto the WebSphere Application Server administrative console.
2. Select Server → Application Servers and select the Server_Name.
3. Navigate to the JVM system properties page.

For application server version 6: in the Configuration table, navigate to Server
Infrastructure → Javaand Process Management → Process Definition →
Additional Properties: Java Virtual Machine.
For application server version 5: navigate to Additional Properties: Process
Definition → Additional Properties: Java Virtual Machine.

4. In the Generic JVM arguments field, remove the values that were added as a
result of the Data Collector configuration. Make sure you do not remove the
values that are not related to the Data Collector configuration.

5. For JVM custom properties, select and remove the values that were added as
a result of the Data Collector configuration. Make sure you do not remove the
values that are not related to the Data Collector configuration.

6. Navigate to the custom properties page.
For application server version 6: in the Configuration table, navigate to
Process Definition → Custom Properties.
For application server version 5: navigate to Additional Properties: Process
Definition → Custom Properties.

7. For custom properties, select and remove the values that were added as a
result of the Data Collector configuration. Make sure you do not remove the
values that are not related to the Data Collector configuration.

8. Navigate to the page for environment variables at the server level. For
example, in the Navigation Pane, select Environment → WebSphere Variables,
and navigate to the server level variables.

9. Select and remove the ITCAM61_home and MS_AM_home variables.
10. Save your changes. For ND deployment, you need to synchronize the changes

with the node agent so that the changes at dmgr can be applied to individual
server instances.

11. Remove the DC_home directory and all files and subdirectories under
DC_home.

WebSphere Application Server 7.0 cannot start and returns an
"Unable to create Java Virtual Machine" error
The problem: After eCAM 7.0 or ITCAM for WebSphere 6.1 is installed on
WebSphere Application Server 7.0 IBM J9 PASE 64bit, WebSphere Application
Server cannot start and returns an "Unable to create Java Virtual Machine" error in
the logs.

The symptom: "Unable to create Java Virtual Machine" error.

The cause: Installing and upgrading of eCAM 7.0 and ITCAM for WebSphere 6.1 is
not supported on WebSphere Application Server 7.0 IBM J9 PASE 64bit.

The solution: You must install ITCAM for Application Diagnostics 7.1 directly on
WebSphere Application Server 7.0 IBM J9 PASE 64bit.
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Distributed platforms
This section describes the problems and troubleshooting that only apply to
distributed platforms, including Windows, Linux and UNIX systems.

Cannot start WebSphere administrative console after installing
Data Collector on Windows
The problem: After installing the Data Collector and then starting the WebSphere
administrative console, it cannot load its console page.

The reason: Your WebSphere server's default templates have changed.

The solution: Ensure the WebSphere instance is correct and not corrupted.

Data Collector installation fails on Linux platforms because of
inadequate permissions
The problem: The configuration fails if you used a non-root user that did not have
permissions to write to the temporary directory. You must perform the following
procedure to correct this issue and perform a subsequent successful configuration
of the Data Collector.

The solution:

1. Undo your initial (failed) configuration of the Data Collector by using the
Configuration Tool (config_dc.sh script) to unconfigure it. See the installation
and customization guide for details.

2. Take one of the following actions:
v Give the non-root user ID read and write access to the /tmp and /var/tmp

(HP-UX and Solaris only) directories:
a. Log on as root and give the non-root user ID read and write access to

/tmp.
b. If your operating system is HP-UX or Solaris, give the non-root user ID

read and write access to /var/tmp.
c. Remove all files and directories under /tmp and /var/tmp.

v If you have concerns about removing all files under /tmp and /var/tmp,
specify a different temporary directory:
a. Modify the DC_home/config_dc/config_dc.sh file. Add the following

parameters to the file:
-Dtemp.dir=tmp_dir
-Djava.io.tmpdir=tmp_dir

where tmp_dir is the directory you want the Configuration Tool to write
to. The user for the installation must have read, write, and execute
privileges to this directory.

3. Run the Configuration Tool (config_dc.sh script) to configure the Data
Collector. See the installation and customization guide for details.

ECU check fails to return the correct value
The question: After running the ECU tool, the tool returns a value of Windows
Server 2003, even though the operating system in question is Windows Server 2003
R2.

The answer: This is because ECU pulls the os.version and os.name properties from
JVM system properties and depends on these properties for accuracy.
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Error messages are displayed on the console when installing or
configuring the agent for WebSphere Applications or J2EE as a
non-root user on the AIX system
The problem: Error messages are displayed on the console when you run ITCAM
agent for WebSphere Applications or J2EE installation or configuration as a
non-root user on the AIX® system.

The reason: The problem was caused by lacking of the required access to create the
System Preference control files.

The solution: You can use either of the following way to solve this problem:
v Run ITCAM WebSphere Application Server/J2EE Installation or Configuration as

a root user.
v Navigate to the /usr/java14/.private142/jre/.java/.systemPrefs directory and

assign the write permission to the non-root user, create this directory if it does
not exist.

Failure to open external links in ITCAM launchpad on the UNIX
System
The problem: Failure to open external links in ITCAM launchpad and the following
error message is displayed in the console of the launchpad on the UNIX system:
"/usr/dt/bin/dtksh" not found

The solution: You must use Mozilla browser at least once before clicking the
external links in ITCAM launchpad. Type command mozilla in the console and
accept the license agreement which is displayed, then run the launchpad again.

Insufficient temporary disk space when installing on HP-UX
The problem: You may get the following error message when starting the Data
Collector installation on HP-UX:
Error writing file = There may not be enough temporary disk space.
Try using -is:tempdir to use a temporary directory on a partition with
more disk space.

There has been an error writing to file DC_installation.log, because there may
not be enough temporary disk space in temporary directory: /var/tmp. (The
minimum required is 50 MB. )

The solution: Before starting the server, make sure that there is no .pid file under
the /tmp directory that was created by other users during previous operations. As
another option, permission to execute these scripts can be restricted to one user by
changing the ownership and mode of these files with chown and chmod
commands. To use a temporary directory with more disk space, try the following
command:
setup_DC_hp11.bin -is:tempdir temp_dir

where temp_dir is a directory with at least 50 MB free space.

OS agent does not start after Tivoli Enterprise Monitoring Agent
local installation or upgrade
The problem: Previously installed OS agent does not start after Tivoli Enterprise
Monitoring Agent local installation or upgrade.

The solution: To workaround the problem, take either of the following actions:
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1. Start OS agent manually after installation or upgrade finish. You can do this
with Tivoli Service Manager that appears after installation or upgrade.

2. Use remote deploy for installing or upgrading Tivoli Enterprise Monitoring
Agent on destination host.

Customized situations are not available after a version update
The problem: After an update of the Tivoli Monitoring application support version,
situations customized by the user are lost.

The cause: This is expected Tivoli Monitoring behaviour when, during the
application support version update, ALL is selected.

IBM i systems
This section describes the problems and troubleshooting that only apply to IBM i
systems.

Error occurs when installing the Data Collector on iSeries
systems
The problem: When you install the ITCAM for Application Diagnostics Data
Collector for WebSphere Applications on the iSeries® systems, the following error
message is displayed in the installation console:
Exception on getTopology : java.lang.Exception: getTopology
error[getTopology error]

The solution: Run wsadmin.sh script in the AppServer_home/profiles/
profile_name/bin directory manually in the Qshell on the iSeries systems, respond
“yes” to the prompt that is displayed and then install the Data Collector again. If
this solution still cannot solve this problem, please contact the IBM Support
Assistant.

Fail to get WebSphere version information during the silent
installation of the Data Collector on the i5/OS system
The problem: Fail to get WebSphere version information during the silent
installation of the Data Collector on the i5/OS® (OS/400) system.

The solution: For WebSphere 6.0 or later version you must check the dcInputs.txt
file which is used in the silent installation and make sure that you specify the
WAS_BASEDIR variable in this file correctly. For example,
v For WebSphere 6.0 base: /QIBM/ProdData/WebSphere/AppServer/V6/Base
v For WebSphere 6.0 ND: /QIBM/ProdData/WebSphere/AppServer/V6/ND
v For WebSphere 6.1 base: /QIBM/ProdData/WebSphere/AppServer/V61/Base
v For WebSphere 6.1 ND: /QIBM/ProdData/WebSphere/AppServer/V61/ND
v For WebSphere 7.0 ND: /QIBM/ProdData/WebSphere/AppServer/V7/ND

Uninstall eCAM 7.0 on i5/OS silently
The question: How does one uninstall eCAM 7.0 on i5/OS (now known as IBM i)
silently?

The answer: Perform the following procedure to uninstall eCAM 7.0 on i5/OS:

Remove the files and service program:
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CAUTION:
Because all the instances of ITCAM for Application Diagnostics for WebSphere
on IBM i5/OS share the same service program, do not remove the service
program unless the ITCAM for Application Diagnostics for WebSphere being
removed is the last and only one on this system.

1. On the IBM i5/OS server, remove the ITCAM for Application Diagnostics for
WebSphere installation path in the IFS. Open QSH session and run:

rm -rf DC_home
rm -rf /QIBM/UserData/tivoli/common

2. On the IBM i5/OS server, remove the service program. Run the following
commands:

DLTLIB QTIVCCGTS
DLTLIB QTIVTMTP
DLTSRVPGM am_sun_16
DLTSRVPGM SJITI

z/OS systems
This section describes the problems and troubleshooting that only apply to z/OS
systems.

ConnectorNotAvailableException found in Data Collector logs on
z/OS system
The problem: After installing and configuring the Data Collector successfully on
z/OS, the following messages were found in the trace_dc_ParentLast.log file:
<Exception><![CDATA[com.ibm.websphere.management.exception.AdminException:
com.ibm.websphere.management.exception.ConnectorNotAvailableException
at com.ibm.ws.management.AdminServiceImpl.getDeploymentManagerAdminClient
(AdminServiceImpl.java:1536)
at com.cyanea.ws6.JMXDelegate$12.act(JMXDelegate.java:1649)
at com.cyanea.was.JMXDelegateBase$CynPrivilegedException.run
(JMXDelegateBase.java:559)
at com.ibm.ws.security.auth.ContextManagerImpl.runAs
(ContextManagerImpl.java:4097)
at com.ibm.ws.security.auth.ContextManagerImpl.runAsSystem
(ContextManagerImpl.java:4194)
at com.ibm.ws.security.core.SecurityContext.runAsSystem
(SecurityContext.java:245)
at com.cyanea.was.JMXDelegateBase$CynAction.perform
(JMXDelegateBase.java:400)
at com.cyanea.ws6.JMXDelegate.initializeAdminClient
(JMXDelegate.java:1624)
at com.cyanea.ws6.JMXDelegate.connectToDmgr
(JMXDelegate.java:3151)
at com.cyanea.ws6.JMXDelegate.checkAdminClient
(JMXDelegate.java:3120)
at com.cyanea.ws6.monitoring.MonitoringAdapter.getPerfSummary
(MonitoringAdapter.java:900)

The cause: This situation occurs when the Server, Node, or Deploy Manager has
problems in connecting or running.

The solution: Restart the Server, Node, and Deploy Manager.

Running ITCAM Agent for WebSphere Applications
The following are troubleshooting tips and techniques for problems that occur
when running ITCAM Agent for WebSphere Applications.
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All platforms
This section describes the problems and troubleshooting that can apply to all
platforms, which are probably not related to any unique platform.

Cannot call the IBM Tivoli Monitoring Client after reconfiguring
Data Collector
The problem: After reconfiguring Data Collector, the information relating to the
IBM Tivoli Monitoring Client is no longer the same as that in DC_home/runtime/
server_instance.

The reason: When you reconfigure the Data Collector it records the information
relating to IBM Tivoli Monitoring Client that was set when you configured the
Data Collector for the first time. If the information relating to the monitoring agent
and TTAS in DC_home/runtime/server_instance is modified manually after the first
configuration then the information displayed when you reconfigure the Data
Collector will be different from that in the DC_home/runtime/server_instance.

The solution: Manually change the information relating to IBM Tivoli Monitoring
Client in DC_home/runtime/server_instance to match your installation.

Changing server alias fails
The problem: You have used the monitoring agent configuration utility (or use IBM
Configuration Assistance Tool on z/OS) to change a server alias, but the old alias
is still shown in the Tivoli Enterprise Portal..

The solution: Perform the following steps:
1. Stop the Data Collector that monitors the application server.
2. In the Tivoli Enterprise Portal, issue the Remove_Subnode Take Action

command for the affected node (old alias). The node will be grayed out in the
Tivoli Enterprise Portal. You can use the Clear Offline Entries... action in the
portal to remove it.

3. Change the server alias in the Tivoli Enterprise Monitoring Agent monitoring
this application server. On z/OS, use IBM Configuration Assistance Tool. On
the other operating systems, use the configuration utility. For the detailed
information, see ITCAM Agent for WebSphere Applications Installation and
Configuration Guides.

4. Restart the Monitoring Agent.
5. Start the Data Collector.

Disable and enable the Data Collector without losing the
configuration settings
The problem: You may want to temporarily disable the Data Collectors without
losing the configuration settings.

The solution: You can use the following scripts to do this. The scripts enabledc.py
and disabledc.py programmatically enable and disable selected ITCAM Data
Collectors for a given node of the WebSphere Application Server Base or Network
Deployment environment. The Scripts are invoked as follows:
v For BASE environment :
1. Stop the server.
2. Disable Data Collector:

WAS_home/bin/wsadmin.sh -conntype NONE -lang jython -f DC_home/config_dc/disabledc.py
[-ms] <node> [server1] [server2] ... [server n]
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3. Enable Data Collector:
WAS_home/bin/wsadmin.sh -conntype NONE -lang jython -f DC_home/config_dc/enabledc.py
[-tema] <node> [server1] [server2] ... [server n]

v For Network Deployment environment :
1. Start the Deployment Manager.
2. Disable Data Collector:

WAS_home/bin/wsadmin.sh -conntype SOAP -host <dmgr_host_name> -port
<dmgr_port_number> -lang jython -f DC_home/config_dc/disabledc.py
[-ms] [-restart] <node> [server1] [server2] ... [server n]

3. Enable Data Collector:
WAS_home/bin/wsadmin.sh -conntype SOAP -host <dmgr_host_name> -port
<dmgr_port_number> -lang jython -f DC_home/config_dc/enabledc.py
[-tema] [-restart] <node> [server1] [server2] ... [server n]

4. Specify optional argument -restart to restart the modified servers, -restart is
only applicable to Network Deployment.

Note: For Windows, use wsadmin.bat instead of wsadmin.sh If the argument -tema
is specified with the enabledc script, it will only enable data collection for the
ITCAM Tivoli Enterprise Monitoring Agent; data collection for the ITCAM
Managing Server will still be disabled. If the servers list is not specified, the
scripts will search for all servers in the node. The disabledc script will store
backup data inside the server JVM System Properties. The WebSphere Server
instance must be restarted for the data collection changes to take effect.

Enabling Method Profiling
The problem: Customers running at monitoring level 2 (MOD L2) that select the
check box for Method Profiling, might get the following message:
"To make sure your system is instrumented to capture all level 3 data, update the
toolkit_custom.properties file within the data collector’s custom
folder for the monitored application server. Be sure to recycle the application
server to ensure proper results. For CICS and IMS, please ignore this warning."

The cause: Method Profiling, an optional feature at monitoring level 2, is
dependent on monitoring level 3 method entry and exit instrumentation. The
purpose of Method Profiling is to summarize those level 3 method entry and exit
requests, to give you summarized method level data.

The solution: To enable Method Profiling with default settings, you must update
the toolkit_custom.properties file for each application server that will be monitored
using this feature. In particular, you must uncomment the
am.camtoolkit.gpe.customxml.L3 property and set
com.ibm.tivoli.itcam.toolkit.ai.methodentryexittrace=true.

For an introduction to ITCAM for Application Diagnostics technique for
instrumenting application classes, go to the ITCAM for Application Diagnostics
Infocenter.

Errors displayed in the Data Collector logs
The following content provides information about errors displayed in the Data
Collector logs.

Failed to deserialize marshalled object

The problem: When using proxy servers, you see this error in the Data Collector
logs:
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INFO: CYND5109I Failed to deserialize marshalled object

The solution: Append the proxy jarfiles (listed in the IBM Tivoli Composite
Application Manager for WebSphere Applications Installation Guide) to both the class
path and the JVM arguments (property java.rmi.server.codebase).

Cannot determine implemented interfaces

The problem: If JDBC type 2 native connection with RRS is used during WebSphere
startup, an error message will be shown in the log:
error:can’t determine implemented interfaces of missing type
com.ibm.db2.jcc.SQLJConnection

The solution: This is working as designed and the messages can be ignored.

Error getting ITLM Application Tookit
The problem: An error message "Error getting ITLM Application Tookit" is
displayed in the IBM Tivoli Composite Application Manager for WebSphere
trace-dc-ParentLast.log file after running the IBM Tivoli Composite Application
Manager for WebSphere for some time.

The solution: Update the IBM JDK SR8 to IBM JDK SR8a.

Error KCIIN0205E occurs when stopping Tivoli Enterprise
Monitoring Agent
The problem: When stopping the Tivoli Enterprise Monitoring Agent , the
following message is returned:
KCIIN0205E Unable to stop agent or process...

There are also many exceptions in the logs. But if you try to stop the Tivoli
Enterprise Monitoring Agent for the second time, it will stop successfully.

The cause: This is an IBM Tivoli Monitoring limitation. ITCAM for Application
Diagnostics 7.1 on AIX requires IBM Tivoli Monitoring JRE SR10.

The solution: Update IBM Tivoli Monitoring JRE to SR10 by taking the following
steps:
1. Install new IBM JDK to /usr/java5;
2. Remove ITM_home/JRE/aix523;
3. Create a system link from /usr/java5/jre to ITM_home/JRE/aix523.

Errors occur during or after upgrading
The following errors may occur after an upgrade from a previous version of
ITCAM for APplication Diagnostics or ITCAM for WebSphere.

Error KDY0005E occurs when remote upgrading Tivoli Enterprise Monitoring
Agent to ITCAM for Application Diagnostics: The problem: When remote
upgrading Tivoli Enterprise Monitoring Agent to ITCAM for Application
Diagnostics 7.1 on a non-Windows platform, the upgrade failed with the following
message shown:
v For WebSphere Agent:

KDY0005E: The agent bundle YN is missing the prerequisite YN which was not be
installed on host_short_name.An error occurred during an attempt
to install the specified prerequisite.

v For HTTP Servers Agent:
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KDY0005E: The agent bundle HT is missing the prerequisite HT which was not be
installed on host_short_name.An error occurred during an attempt
to install the specified prerequisite.

Diagnosing the problem: Check the host name value of Tivoli Enterprise
Monitoring Agent:
1. Log on to Tivoli Enterprise Portal;
2. Right-click on Enterprise and select Workspace → Managed System Status.
3. Right-click on Managed System Status and select Properties. Enable the Host

Address option in the ensuing dialog box. Then press OK to close the dialog
box.

4. Check the host name in Managed System Status. If the host name you see is
not in short format (for example, tivsun10.cn.ibm.com), it cannot be recognized
by IBM Tivoli Monitoring, which may cause problem when remote upgrading.

The solution: To remote upgrade Tivoli Enterprise Monitoring Agent successfully,
performing the following steps:
1. Add property

CTIRA_SYSTEM_NAME=host_short_name

(for the previous example, the value of host_short_name should be tivsun10) in
the following files under ITM_home/config directory:
v For WebSphere Agent, the files are yn.ini and yn.config;
v For HTTP Servers Agent, the files are ht.ini and ht.config.

2. Restart Tivoli Enterprise Monitoring Agent.
3. Check the host name in Tivoli Enterprise Portal again.
4. If the host name is in correct format, run remote upgrade.

Monitoring overhead rises after upgrade from ITCAM for WebSphere version
6.1 Fix Pack 4 or lower:

The problem: After Tivoli Enterprise Monitoring Agent is upgraded from ITCAM
for WebSphere version 6.1 Fix Pack 4 or lower, the performance overhead rises
significantly.

The solution: This happens because the Tivoli Enterprise Monitoring Agent
automatically starts the baselining process for all applications. In the baselining
process, statistical information on request response times is collected; ITCAM uses
it to automatically determine response time thresholds for Application Health
monitoring.

During the baselining process, Level 2 monitoring is enabled for the application,
irrespective of the configured defaults and any Take Actions. This means that the
monitoring overhead will also rise to values typical for Level 2 monitoring. The
Tivoli Enterprise Portal may show the request monitoring level as Level 1 or
Disabled, but the monitoring is still performed at Level 2.

By default, the baselining process runs for seven days. After this time, monitoring
returns to the level set by the configured defaults and the
Start_Request_Monitoring, Stop_Request_Monitoring and
Set_Application_Monitoring Take Actions. Accordingly, the overhead will also
return to expected levels.
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If the increased overhead is not acceptable, you may use the Tivoli Enterprise
Portal to issue the Stop_Baselining Take Action for any affected application. The
baselining process will be stopped and the overhead will return to a normal level.
However, if you do this, the automatic response time thresholds may not be set
properly, so the Application Health "lights" may not reflect the true state of the
application.

For more details on automatic threshold setting and the baselining process, see the
Online Help available in the Tivoli Enterprise Portal.

Export all the defined Situations into one handy file
The problem: How to export all the defined Situations into one handy file?

The solution: If you need to export all your Situations to send to Support, use this
command:
cd $ITM_home/
./tacmd viewSit --situation <sit-name> --export <sit-name>.sit

where <sit-name> should be replaced with the particular situation name.

This will create a file with a "sit" extension. Simply tar up the "sit" files into one
zip file if you have more than one exported Situation and send this file to the
Support team for analysis.

Failed to update UpdateAutoRun.sh
The problem: You cannot update the ITM_home/logs/UpdateAutoRun.sh script.

The reason: When you perform the installation without "root" permissions you
cannot update the ITM_home/logs/UpdateAutoRun.sh script.

The solution: Make sure that you have "root" permissions before launching the
installation. For more details, see the log file: ITM_home/logs/UpdateAutoRun.log.

Inconsistent JVM heap size value reported in Server Activity
Display and System Resources
The problem: Inconsistent JVM heap size value is reported in the Server Activity
Display and the System Resources pages.

The reason: This works as designed. The value reported in the Server Activity
Display page is PMI data. It is the amount of memory that is in use in JVM which
is calculated by total memory minus free memory in JVM. On the other hand, the
value reported in the System Resources page is JMX data.

ITCAM can not be started or configured when the path name of
IBM Tivoli Monitoring contains special symbols
The problem: ITCAM can not be started or configured when the path name of IBM
Tivoli Monitoring 6.2.2 contains special symbols (for example, % and $).

The cause: This problem is caused by an IBM Tivoli Monitoring limitation. IBM
Tivoli Monitoring 6.2.2 can not be started when the path name contains invalid
symbols.

The solution: The path name of IBM Tivoli Monitoring 6.2.2 should only contains
"0-9", "a-z", "A-Z" and the underscore character ("_").
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Managing Server and Data Collectors require a restart after IP
address change
The problem: The Managing Server and Data Collectors require a restart after a
DHCP IP address change. The kernel stops serving the RMI (remote method
invocation) codebase correctly to the other components; the Data Collectors don't
try to reconnect to the Publishing Server, even after the Publishing Server has been
restarted. Both still reference the old IP address, and they show up as unavailable
in the Application Monitor. Nothing crashes , but the kernel RMI socket stops
serving the classes correctly.

The first exception on the Managing Server is an IOException Socket Closed event,
followed by many socket exceptions.

The solution: Use dynamic DNS, and have the kernel host and RMI codebase
parameters set on the Data Collector using the dynamic DNS name for this
Managing Server rather than the IP address; see the IBM Tivoli Composite
Application Manager for WebSphere Installation and Customization Guide.

Method report does not contain the expected trace although
MOD-L3 and proper filter definition are specified
The problem: Despite using a monitoring level of MOD-L3 and having a proper
filter definition specified in the method_entry_exit.xml file, the method report does
not contain the expected trace.

The cause: If you are missing methods in a trace, and have checked that there are
no dropped records, then the most likely cause is the incorrect use of exclude
overrides.

The solution: Carry out the following steps:
1. Optional step. Create a new configuration with the appropriate exclude list if

you need to trace the WebSphere Application Server system classes. Otherwise
you can use the standard J2EE configuration (default).

2. Switch to MOD-L3.
3. Close WebSphere Application Server (stop Data Collector).
4. Create method_entry_exit_customer-name.xml, copying your filter definition.
5. Point to this file in toolkit_custom.properties in the <DC>/runtime/<server>/custom

directory (with the collect method entry exit parameter set to true)

Note: Do not update toolkit.custom.properties in the <DC>/itcamdc/etc directory.
User modifications must always be made to the <DC>/runtime/<server>/custom
directory.

6. Even if it is not necessary to delete the toolkit and classinfo files from the
<DC>/runtime/<server> directory, you can remove them anyway, as they are
system-generated files:
<nodename>.<was-name>.toolkit.properties.xml

<nodename>.<was-name>.toolkit.xml

<nodename>.<was-name>.classinfo.txt

7. Start WebSphere Application Server (start Data Collector ).
8. Run a customer application.
9. Collect L3 trace.

10. Optional step. Switch to L2 and collect some "Misbehaving Transaction" traps.

Check in PAR Reports or Trap History Reports for the expected data.
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Monitor GC when the GC log path is changed after installed
ITCAM for Application Diagnostics
The question: How can I still monitor the Garbage Collector (GC) when the GC log
path is changed after installing ITCAM for Application Diagnostics?

The cause: When the GC log path has been changed, the Data Collector may not
find the GC log path for collecting information.

The solution: To solve this problem, take the following steps:
1. Navigate to the DC_home/runtime/appserver_version.node_name.server_name

directory.
2. Open the kwjdc.properties file.
3. Find the TEMAGCCollector.gclog.path={GC_Log_Path} property
4. Change the value of GC_Log_Path to the correct GC log path.

No Heap Dump available on Solaris JDK1.5
The problem: No heap dump available on Solaris JDK 1.5.

The solution: perform the following steps:
1. Add "internal.doheapdump=true" in DC_home/runtime/*.*.*/

*.datacollector.properties.
2. Make sure JDK version is above 1.5.0_01

Data Collector uses JVMTI instead of JVMPI to get HEAPDUMP information. From
version 1.5.0_01, SUN JDK 1.5 on Solaris supports HEAPDUMP in JVMTI.

NullPointerExceptions
The following content provides information about NullPointerExceptions.

NullPointerException after running for some time

The problem: The following error message "java.lang.NullPointerException" is
displayed in the WebSphere SystemOut.log file after running the IBM Tivoli
Composite Application Manager for WebSphere for some time:

java.lang.NullPointerException
at java.util.Hashtable$1.contains(Hashtable.java:404)
at java.util.AbstractCollection.containsAll(AbstractCollection.java:300)
at java.util.Collections$SynchronizedCollection.containsAll

(Collections.java:1603)
at com.ibm.tivoli.itcam.tema.mbeanserver.JMX12.propertiesMatch

(JMX12.java:97)
at com.ibm.tivoli.itcam.tema.mbeanserver.JMX12.apply(JMX12.java:42)
at com.ibm.tivoli.itcam.tema.appmon.serverinfo.build.

ObjectNameFilter.isNotificationEnabled(ObjectNameFilter.java:47)

The solution: Update the IBM JDK SR8 to IBM JDK SR8a.

NullPointerExceptions from Oracle on the Data Collector in
trace-dc-bcm.log

The problem: The WebSphere application server using an Oracle database running
with the ITCAM Data Collector for fix pack 4 will experience NullPointerException
from Oracle in the trace-dc-bcm.log. This is the type of exception that displays.
<Exception><![CDATA[java.lang.NullPointerException at oracle.jdbc.driver.
OracleStatementWrapper.equals
(OracleStatementWrapper.java:89)
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The solution: Set com.ibm.tivoli.itcam.toolkit.ai.createRememberedObjectField=true in the
WebSphere application server JVM custom properties to avoid the exception.

Out of Memory errors occur when using L3 and hotspot JVM
The problem: If out of memory errors occur while you are using L3 and hotspot
JVM, do the following instructions.

The cause: The default NewSize and MaxNewSize might be too small for some
Applications if the Application is allocating large numbers of short living objects.

The solution: Some recommended tuning for an application that allocates many
short living objects is as the following content:
-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -Xconcurrentio

Note: NewSize and MaxNewSize must be changed based on the Maximum and
Minimum heap settings of the JVM.

Restoring the previous WebSphere Application Server
configuration after Data Collector installation and configuration
The problem: You want to restore the previous WebSphere Application Server
configuration because the Data Collector configuration has failed with any of the
following reasons:
v After the configuration, the application server fails to restart.
v During a GUI configuration, the summary panel for the Configuration Tool

indicates the configuration has failed.
v During a silent configuration, the command line indicates a message that the

configuration has failed.
v After the configuration, there are messages in the Tivoli common log file that

indicates configuration has failed.

The solution: For instruction on restoring the previous WebSphere Application
Server configuration, refer to Appendix D. What to do if Data Collector configuration
fails in WebSphereDistributed Data Collector Installation and Customization Guide.

Significant CPU consumption and high latency observed if a
thread dump is requested
The problem: Significant CPU consumption by both the Data Collector and the
Managing Server is observed if a thread dump is requested, and high latency is
received in generating traps if thread dumps are requested when the trap is
requested.

The solution: In a production environment, generating a thread dump is not
encouraged as a trap action, due to the latency it will impose on trap actions and
the high CPU time it will consume on the Data Collector and the Managing Server.

Note: Performing a thread dump may also mean that you cannot access the
application when you refresh the thread dump page.

Some features are not working
You might have met the situation that some feature are not working. The following
content provides solutions to this situation.
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ITCAM "Cancel Thread" feature does not work

The problem: Clicked "Cancel Thread" on the thread (Web Container thread in this
case) and found it still shows with all the thread list that is not cancelled.

The cause: "Cancel Thread" feature of ITCAM may not always able to immediately
terminate Java threads running native code. This is a limitation of JVM.

Note: In any event, the cancelling of live threads is a dangerous practice, and
should be used with care and discretion.

The solution: If the "Cancel Thread" feature of ITCAM is used to terminate a Java
thread running native code, that thread will continue to run until either of the
following events occur:
v the native code calls one of the JNI functions that could raise synchronous

exceptions;
v the native code uses ExceptionOccurred() to explicitly check for synchronous

and asynchronous exceptions.

If neither of these events occurs, the thread will continue to run until it returns
from native code back to Java code and only then it will be terminated.

If the thread does not return from native code back to Java code (for example as a
result of a hang or loop in the native code), restarting JVM may be needed to
reclaim the thread.

Service Integration Bus (SIB) monitoring not working

The problem: In WebSphere, Performance Monitoring Infrastructure (PMI) for SIB is
not configured and therefore no SIB data is collected.

The reason: SIB PMI data settings cannot be saved in the WebSphere configuration.

The solution: Adjust SIB PMI settings as runtime parameters by following these
steps:
1. If the DC_home/runtime /<app_server_version>.<node_name>.<server_name>/

custom /datacollector_custom.properties file does not yet exist, create one.
2. In the datacollector_custom.properties file, add the following lines:

am.was6custompmi.settings.1=SIB Service=*
am.was6custompmi.settings.2=SIB Service=*
am.was6custompmi.settings.3=SIB Service=*

These lines set custom PMI settings for L1, L2 and L3 monitoring levels.
3. Restart the application server.

Stack trace cannot be returned for RMI EJB invocations
The problem: If your application remotely invokes an EJB, no stack trace is
returned.

The reason: This lack of information results from a JVM limitation and is thus
unavoidable.

Tivoli Enterprise Monitoring Agent fails to work
You might have met the situation that Tivoli Enterprise Monitoring Agent fails to
work. The following content provides some solutions to this situation.
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Tivoli Enterprise Monitoring Agent stops because of lack of memory

The problem: The Tivoli Enterprise Monitoring Agent reports the following errors:
v java.lang.OutOfMemoryError: JVMCI015:OutOfMemoryError, cannot create

anymore threads due to memory or resource constraints
v java.lang.OutOfMemoryError: JVMST017: Cannot allocate memory in

initializeMarkAndAllocBits(markbits1)

The reason: These error messages indicate that the Tivoli Enterprise Monitoring
Agent is experiencing a high load and lack of available memory.

The workaround: To resolve this problem, take one of the following actions:
v Disable the memory limit by issuing the ulimit -d unlimited command and the

ulimit -m unlimited command before the Tivoli Enterprise Monitoring Agent
starts.

v Increase the Java heap size for the Tivoli Enterprise Monitoring Agent by setting
the -Xmx256m parameter for the Java Options in the Tivoli Enterprise
Monitoring Agent Java properties file.

Note: Refer to http://www.ibm.com/developerworks/java/jdk/diagnosis for
more information about Java troubleshooting tips.

Tivoli Enterprise Monitoring Agent fails to start or recycle the
WebSphere Application server

The problem: The Tivoli Enterprise Monitoring Agent fails to start or recycle the
WebSphere Application server when running a memory-intensive Java application
in a 32-bit Java virtual machine (JVM). The error message JVMST018 shown below
will appear in the native_stderr.log file.
# ./java -version -Xms128M -Xmx2048M
[ **Out of memory, aborting** ]
[ ]
[ *** panic: JVMST018: Cannot allocate memory for
initializeMarkAndAllocBits(allocbits1) ]

The reason: This problem occurs because the maximum Java heap size for the
WebSphere Application server is set to a value that is too large.

The workaround: Lower the maximum heap size.

Tivoli Enterprise Monitoring Agent failed to work after re-configuration

The problem: After re-configuring, Tivoli Enterprise Monitoring Agent failed to
work.

The cause: The configurator tool picked up the Java Runtime Environment (JRE)
1.6 that was set as the default system JRE in the JAVA_HOME environment
variable. Tivoli Enterprise Monitoring Agent requires JRE 1.4.x, by default located
in C:\Program Files\IBM\Java142.

The solution: Set your JAVA_HOME system environment variable to point to the
JRE that was installed by IBM Tivoli Monitoring (on Tivoli Enterprise Portal
Server) or the JRE installed by the base product driver then re-configure the
monitoring agent.
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The Data Collector workload on the PS/AA is not balanced
The question: Why is the Data Collector workload not balanced between the
restarted PS/AA and the new PS/AA that the Data Collector is being connected
to?

The answer: Data collectors are balanced under either of the following conditions:
v The Data Collector connects to the less loaded PS/AA when the old PS/AA that

the Data Collector is connected to reaches its memory limit (HEAP_MAX_SIZE_PS
parameter in the MS_home/bin/setenv.sh file for PS and
HEAP_MAX_SIZE_ARCHIVE_AGENT parameter in the MS_home/bin/setenv.sh file for
AA) and closes the Data Collector socket.

v When a new Data Collector is started, it gets the less loaded PS/AA.

The platform CPU has a negative value
The problem: The platform CPU is a negative value on the Server Activity Display
page when the Data Collector is not started by an administrator user on the
Windows 2003 64-bit system.

The solution: You can either start the Data Collector as an administrator user or
add the non-administrator user to the "Performance Monitor Users" user group
before starting the Data Collector.

The memory requirements increase
The following content provides some solutions to the increase of memory
requirements.

Enabling Lock Analysis increases both application startup time and
memory requirements

The problem: Activating the Lock Analysis feature modestly increases the time
necessary to start ITCAM for Application Diagnostics; it also increases the memory
requirements of both the WebSphere application server and the ITCAM for
Application Diagnostics Data Collector.

The reason: This increased consumption of system resources is caused by the Lock
Analysis feature's requirement to implement bytecode instrumentation in your
application's Java classes.

Switching from L1 to L2 increases the memory consumption

The problem: Switching a Data Collector from monitoring level L1 to L2 online
(without restarting the WebSphere application server) causes the Data Collector's
memory requirements to grow.

The solution: Memory consumption is subject to various Data Collector
configuration parameters and the total number of events generated by J2EE
applications. A Data Collector has a memory monitor that tracks of the native
memory it is using. The memory monitor checks the total allocated memory at
regular intervals (once for every internal.probe.publishing.frequency setting) to
ensure that the Data Collector does not consume more memory than specified in
the internal.memory.limit property.

But since this memory check is done only at certain intervals (rather than each
allocation), it is possible that the Data Collector might consume more than the
specified memory if its load is high (thus causing the Data Collector to allocate lots
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of memory between memory checks). In such scenarios, you must tune the
internal.probe.publishing.frequency and internal.memory.limit parameters
according to your environment. The general recommendation is to reduce the
values of these properties if you notice that Data Collector is consuming excessive
memory.

Turning on or turning off the Data Collector connections
The following content provides information about turning on or turning off the
Data Collector connections.

Data Collector cannot be connected to the Managing Server in a
computer outside the DNS

The problem: The Data Collector fails to connect the Managing Server when the
Data Collector is on a computer outside the DNS.

The cause: The xml parser tries to resolve URLs in the WebSphere variables.xml
and cannot because the xml parser being invoked by the WebSphere config code is
a non-local resolver.

The solution: ITCAM agent for WebSphere does not support installation of the
Data Collector on computers that are not in the DNS.

Enabling communications with Tivoli Enterprise Monitoring Agent if
not done during initial installation

The problem: You chose not to enable communications with Tivoli Enterprise
Monitoring Agent during the initial installation of the Data Collector, but you now
want to enable it.

The solution: Perform the following procedure:
1. In the DC_home/runtime/app_server_version.node_name.server_name/

app_server_version.node_name.server_name.kwjdc.properties file, make the
following modifications:
a. Uncomment the following line and enter the port number to be used by the

Tivoli Enterprise Monitoring Agent:
com.ibm.tivoli.kwj.agentport=

b. Uncomment the following line and enter the IP address of the Tivoli
Enterprise Monitoring Agent:
com.ibm.tivoli.kwj.agenthostname=

2. Restart the Data Collector by restarting the application server associated with it.

Turn off correlation between the CICS Data Collector and the
WebSphere Application Server Data Collector

The question: How to turn off correlation between the CICS Data Collector and the
WebSphere Application Server Data Collector?

The answer: Perform the following steps:
1. Make a backup of the DC_home/etc/bcm.properties file.
2. Update the DC_home/etc/bcm.properties file for the Distributed WebSphere

Application Server Data Collector to remove the reference to the
*_request_ctg.xml files. This will turn off CTG correlation which is turned on
by default in the Distributed WebSphere Application Server code.
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3. Delete the generated bcm.properties file from the DC_home/etc directory (one
for each Application Server).

4. Restart the Distributed WebSphere Application Server Application Server.

Warning CJL0047W during unconfiguration of the Data Collector
The problem: The Data Collector unconfiguration program writes this warning to
the console:
CJL0047W Configuration properties have already been set for the logging object
Relation. in the current log manager. The previous configuration will
remain in effect.

The reason: Ignore this warning as it is a limitation in JLog.

WebSphere Proxy Server crashes
The problem: WebSphere Proxy Server crashed after about 17 hours run with IBM
Tivoli Composite Application Manager for WebSphere and many errors messages
"java.net.SocketException: Too many open files" are displayed in the WebSphere
SystemOut.log file.

The solution: Set the parameter "open files" of operating system to a large number.

Distributed platforms
This section describes the problems and troubleshooting that only apply to
distributed platforms, including Windows, Linux and UNIX systems.

HP uninstallation cannot delete some toolkit files
The problem: Having used the InstallShield wizard to successfully uninstall ITCAM
for Application Diagnostics Data Collector, when you click Finish to exit the
wizard the following warnings are generated:
Could not delete file/opt/IBM/DCFP4/toolkit/lib/hpux10/libam_hp_15.sl
Could not delete file/opt/IBM/DCFP4/toolkit/lib/hpux10/libcclog.sl
Could not delete file/opt/IBM/DCFP4/toolkit/lib/hpux10/libmsg23.sl
Could not delete file/opt/IBM/DCFP4/toolkit/lib/hpux10/libcffdc.sl
Some Files could not be removed during the uninstallation (toolkit_lib_hpix10_lib).
Refer to the uninstall log for additional information.

The reason: This error may occur during an uninstallation of the WebSphere data
collector on a HP operating system if you do not unconfigure the data collector. If
you receive these warning messages, this means that some of the files could not be
removed during the uninstallation process because the server is running. Please
refer to the install shield log records for further information.

Tivoli Enterprise Monitoring Agent on Windows Vista fails to
start without administrator rights
The problem: The Tivoli Enterprise Monitoring Agent on the Windows Vista system
fails to start when you don't run it with administrator rights.

The reason: Inadequate user rights.

The workaround: Grant administrator rights by carrying out the following steps:
1. Right-click the Manage Tivoli Monitoring Services.
2. Click Properties -> Compatibility -> Run this program as an administrator.
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Tivoli Enterprise Monitoring Agent cannot be started on SuSE
Linux Enterprise Server 9
The problem: After installing and configuring the Tivoli Enterprise Monitoring
Agent on SuSE Linux Enterprise Server (SLES) 9, you run the ./itmcmd agent start
yn command. The agent does not start.

The reason: The default gcc version is 3.3 in SLES 9. The Tivoli Enterprise
Monitoring Agent agent requires gcc 3.4 to run.

The workaround: Install gcc3.4 manually. For SLES 9 on AMD64/EM64T, you must
install the compat-libstdc++-lsb-4.0.2_20050901-0.4.x86_64.rpm library. This library
is available in the SLES 9 for AMD64 and Intel® EM64T Service Pack 3.

IBM i systems
This section describes the problems and troubleshooting that only apply to IBM i
systems.

WebSphere Application Server fails to start on IBM i 6.1
The following content provides solutions when WebSphere Application Server fails
to start on IBM i 6.1.

WebSphere Application Server fails to start and error messages are
displayed in log file

The problem: WebSphere Application Server fails to start on IBM i 6.1

The symptom: You may find the following error messages in the Data Collector
installation log file:

INFO Executing:UPDSRVPGM SRVPGM(QGPL/AM) MODULE(*NONE)
INFO ID: CPF5CA6
INFO Text: Program or Service Program not at correct level for update request.
INFO Severity: 40
INFO ID: CPF5CE2
INFO Text: Unexpected error occurred during program or service program update.
INFO Severity: 40

The solution: You can choose either of the following methods to solve this
problem:
v Remove and reinstall the Data Collector after changing the IBM i 6.1 system

value QFRCCVNRST to 2.
v Run the following commands on IBM i 6.1 system:

DLTSRVPGM SRVPGM(QGPL/AM)
RSTOBJ OBJ(AM) SAVLIB(QGPL) DEV(*SAVF) OBJTYPE(*SRVPGM) SAVF(QGPL/AMV5R416)
FRCOBJCVN(*YES) RSTLIB(QGPL)
UPDSRVPGM SRVPGM(QGPL/AM) MODULE(*NONE)
DLTSRVPGM SRVPGM(QGPL/AM_SUN_16)
MOV OBJ(’/QSYS.LIB/QGPL.LIB/AM.SRVPGM’)
TOOBJ(’/QSYS.LIB/QGPL.LIB/AM_SUN_16.SRVPGM’)
STROBJCVN OPTION(*CHECK) LIB(qgpl), it said SJITI.SRVPGM need convertion.
STROBJCVN OPTION(*CONVERT) LIB(QGPL)
STROBJCVN OPTION(*CHECK) LIB(QTIVTMTP), it said JVMPI.SRVPGM need convertion.
STROBJCVN OPTION(*CONVERT) LIB(QTIVTMTP)
STROBJCVN OPTION(*CHECK) LIB(QTIVCCGTS)
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WebSphere Application Server fails to start on IBM i 6.1 when you do
not have the authority to use API from QSYS/QPMLPMGT

The problem: WebSphere Application Server fails to start on iSeries 6.1 when you
do not have the required authority to use API from QSYS/QPMLPMGT.

The reason: Inadequate authority.

The solution: Run the following command:
GRTOBJAUT OBJ(QSYS/QPMLPMGT) OBJTYPE(*SRVPGM) USER(*public) AUT(*use)

z/OS systems
This section describes the problems and troubleshooting that only apply to z/OS
systems.

Installing, configuring, and running ITCAM for WebSphere on
z/OS with Global Security turned on
The problem: Installing, configuring, and running ITCAM for WebSphere on z/OS
with Global Security turned on might require additional steps, depending on your
security configuration.

The solution: If WebSphere Global Security has been turned on, perform the
following steps before running the setupwas.sh script:
1. Make sure the user ID you use to log on to UNIX System Services (z/OS UNIX

System Services) and run the setupwas.sh script has read-write access to the
WebSphere Application Server configuration root files. This user ID must also
have permission to run the WebSphere Scripting Client script (wsadmin.sh).

2. Make sure the user ID you use to run setupwas.sh is a member of the same
UNIX group as the servant user ID. Because this user ID will create the ITCAM
for WebSphere runtime directories for the server, the servant user ID must also
have read-write access to these directories.

3. Make sure the user ID you use to run setupwas.sh fulfills the requirements for
Secure Sockets Layer (SSL) security.

Background Information for Step 3

When Global Security is enabled, SSL security is always used by the administrative
subsystem to secure administrative commands, the WebSphere Application Server
administrative console, and communications between WebSphere Application
Server processes (which includes the wsadmin.sh scripting facility). SSL support
always provides a mechanism by which the server proves its identity.

In addition, SSL support on WebSphere Application Server for z/OS allows the
following ways for a client to prove its identity:
v Basic authentication (also known as SSL Type 1 authentication), in which a client

proves its identity to the server by passing a user identity and password known
by the target server

v Client certificate support, in which both the server and client supply digital
certificates to prove their identities to each other

For the client to authenticate the server, the server (actually, the controller user ID)
must possess a signed certificate created by a certificate authority. The server
passes the signed certificate to prove its identity to the client. The client must
possess the CA certificate from the same certificate authority that issued the
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certificate of the server. The WebSphere Application Server customization dialogs
generate jobs that, among other things, define the user IDs for the various
WebSphere Application Server regions (Deployment Manager, Node Agent, Server
Controller, and Servant tasks). These jobs also specify user IDs that can be used to
log on to the WebSphere Application Server administrative console. The RACF®

customization jobs create key rings for each of these user IDs and connects
certificates to them. You can use one of these user IDs to perform the ITCAM for
WebSphere Data Collector setup if it also has the necessary permissions to access
the WebSphere Application Server configuration files mentioned in Step 1.

Procedure for Step 3

If you do not already have a user ID with the necessary permissions and
certificates, you can define one. Perform the following procedure:
1. Find the following information:
v The user ID and group of the WebSphere Application Server servant started

task.
v The name of the CA certificate that was used to sign the server certificate of

the controller user ID. (If configuring a server in a Network Deployment,
find the name of the CA certificate that was used to sign the Deployment
Manager server certificate).

If you do not know the group ID of the servant ID, issue the TSO RACF
command LISTUSER (LU) for servant task owner. This shows that the group
default group name for the ID is WSCFG1.

2. Define a user ID that you use exclusively for running the ITCAM for
WebSphere setup configuration using the TSO RACF command ADDUSER
(AU). The TSO segment for this user profile is required if you intend to run the
ITCAM for WebSphere setup from TSO OMVS or with a batch job. This same
user ID will be used for the ITCAM for WebSphere JMX client (See Step 7 for
information about how to manually define the user ID and password for the
ITCAM for WebSphere JMX client).

3. Create a keyring for this user ID, and have the cell signing CA certificate
placed on it, as follows:
RACDCERT ID(ITCAMWS) CONNECT -
(RING(WASKeyring) LABEL(’WebSphereCA’) CERTAUTH)

Access to keyrings and certificates is protected by RACF by a set of profiles in
the FACILITY class. Although the keyring is associated with the user ID, the
user must have READ authority to the IRR.DIGTCERT.LISTRING profile in order
to access its keyring. The user must also have ‘READ' access to the
IRR.DIGTCERT.LIST profile to be able to access its certificate.

4. If you selected Use SAF EJBROLE profiles to enforce J2EE roles during security
domain setup in the WebSphere Application Server Customization Dialogs,
make sure the user ID you use to run setupwas.sh has READ access to the
EJBROLE administrator profile. The following administrative roles were defined
by the customization jobs:
RDEFINE EJBROLE (optionalSecurityDomainName.)administrator UACC(NONE)
RDEFINE EJBROLE (optionalSecurityDomainName.)monitor UACC(NONE)
RDEFINE EJBROLE (optionalSecurityDomainName.)configurator UACC(NONE)
RDEFINE EJBROLE (optionalSecurityDomainName.)operator UACC(NONE)

Ideally, your user ID will be a member of the servant ID group, which is
already granted permission to these profiles.

Chapter 2. Troubleshooting: ITCAM Agent for WebSphere Applications 51



5. For any RACF classes whose profiles have been added or modified, refresh the
RACF cache. An authorized RACF administrator must issue the following
command:
SETROPTS RACLIST(classname) GENERIC(classname) REFRESH

6. Use the WebSphere Scripting Client directly to see if the user ID is set up
correctly. From a z/OS UNIX System Services session, change to the bin
directory of WebSphere Application Server and issue the following command:
./wsadmin.sh –user itcamws –password itcamws

You will see the following messages if the user ID is set up correctly. This
example is from a Network Deployment environment:
WASX7209I: Connected to process "dmgr" on node PLEX1Manager using SOAP
connector;
The type of process is: DeploymentManagerWASX7029I:

For help, enter:
"$Help help"
<wsadmin>

Enter quit to terminate the WebSphere Scripting Client.
7. If needed, change the user ID and password used by the ITCAM for

WebSphere JMX client. The setupwas.sh script configures the ITCAM for
WebSphere Data Collector JMX client security using the user ID and password
that you supply in the setupwas.sh script parameters –user and –password. If
you want to change the user ID and password used by the JMX client, perform
the following procedure:
a. Before running the amcrypto.sh script, set the JAVA_home and

DATACOLLECTOR_home environment variables. For example,
JAVA_home=/usr/lpp/java/J1.4
export JAVA_home
DATACOLLECTOR_home=/usr/lpp/itcam/WebSphere/DC
export DATACOLLECTOR_home

The value for DATACOLLECTOR_home is the directory where the Data
Collector is installed.

b. Run the amcrypto.sh script from the ITCAM for WebSphere bin directory
(The default is /usr/lpp/itcam/WebSphere/DC/bin.) to encrypt the password,
as follows:
amcrypto.sh -encrypt itcampw

Your encrypted value is: 127-32-236-237-43-36-114-16
c. Set properties for your user ID and encrypted password in the

DATACOLLECTOR_home/runtime/appserver_version.node_name.server_name
/appserver_version.node_name.server_name.datacollector.properties file,
as follows:
appserver.userid=your_userid
appserver.password=your_encrypted_password

KYNM001E KYNALSRD: SERVICE=IXGCONN(CONNECT) FOR
LOGSTREAM
The problem: The following messages show up at startup in RKLVLOG for Tivoli
Enterprise Monitoring Agent for ITCAM Agent for WebSphere Applications on
z/OS:

52 ITCAM for Application Diagnostics: Troubleshooting Guide



KYNM001E KYNALSRD: SERVICE=IXGBRWSE(END) FOR LOGSTREAM=WAS.ERROR.LOG
FAILED WITH RC=8, REASON=0000082D, DEBUG1=, DEBUG2=
KYNM001E KYNALSRD: SERVICE=IXGCONN(CONNECT) FOR LOGSTREAM=WAS.ERROR.LOG
FAILED WITH RC=4, REASON=00000407, DEBUG1=, DEBUG2=
(0000-C8376623:kynlogscr.cpp,204,"KynWasLogScrapper::getEntries") ERROR:
kynalsrd(G) failed (rc 8, status 84D0000)

The cause: Tivoli Enterprise Monitoring Agent for ITCAM Agent for WebSphere
Applications on z/OS expects the WebSphere log stream to be defined and set
with the name in the WebSphere variables. Check the SYSOUT file for the z/OS
WebSphere task for this setting:
ras_log_logstreamName: Not Set

or
ras_log_logstreamName: WAS610.ERROR.LOG

If the value is "Not Set", the preceding messages is displayed.

The solution: Create the WebSphere log stream and assign the variable.

z/OS: Problem with amupdate.sh script after making changes in
the cynlogging.properties file
The problem: After making changes in the cynlogging.properties file in the runtime
directory,cynlogging.properties file doesn't move back to the runtime directory
when you run the amupdate.sh script.

The solution: Install the UK33975 PTF and rerun the amupdate.sh script.

z/OS: Diagnosing ITCAM Data Collector configuration problems
with global security
The problem: Installing ITCAM for Application Diagnostics on z/OS with Global
Security enabled may result in errors during the configuration of the application
server.

The solution: The ITCAM Data Collector configuration process uses the WebSphere
Application Server administration scripting client, wsadmin.sh to configure the
WebSphere Java Virtual Machine properties and services. The scripting client
connects to an admin server or the Deployment Manager (in Network
Deployment) using a SOAP connection. When Global Security is enabled, the
administration service requires an authenticated user ID and password to be
supplied in order to execute the configuration script. In addition, since SOAP
transport is HTTP, the underlying TCP/IP connection is established using Secure
Sockets Layer (SSL). This protocol uses a private-public key authentication
mechanism, which on z/OS uses RACF to store the SSL certificates.

If configuration problems are encountered using the setupwas.sh script, try using
the wsadmin.sh script directly. The setup script requires a SUPERUSR connected
ID, but also have access to the SSL digital certificates. Refer to the WebSphere
Security Handbook for further information.

To configure zWebSphere in security enabled environment:
1. Go to WAS_INSTALL_ROOT/AppServer/bin
2. Try SOAP connection:

wsadmin.sh -user username -password pass

3. If the connection to the server instance succeeds, go to ITCAM Data Collector
install_root/WebSphere/DC/bin:
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setupwas.sh -user $username -password $pass

4. If the connection to the server instance fails, try wasadmin.sh -user username
-password pass -conntype RMI -port yourRMIport (default 2809).

5. Go to ITCAM DC install_root/WebSphere/DC/bin
setupwas.sh -user $username -password $pass -conntype RMI -port yourRMIport

6. If you do not succeed in step 4, resolve the WebSphere problem before
configuring the data collector.

Note: If you install on WebSphere V6R1, your install ID uid=0 need to be
connected to Admin keyRing. Refer to your WebSphere configure
prefix.DATA(BBOWBRAK).

z/OS: Configuration user can not read FFDC and other log files
The problem: The user who configures the Data Collector on z/OS is unable to
read FFDC (First Failure Data Capture) and other ITCAM related log files.

The solution: The user who configures the Data Collector (for example,
WSADMIN:WSCFG1) is different from the user under which the WebSphere
Application Server servant address space is running (for example, ASSR1:OMVS).
This address space creates log files with read/write access for the user and group,
but no access for other users (u=rw,g=rw,o=X).

To allow the WSADMIN user to read the log files, either add the WSADMIN user
to the OMVS group, or configure RACF (or another z/OS security facility) to run
the WebSphere Application Server servant address space under a user that is a
member of the WSCFG1 group. If other user/group names are used, modify the
actions accordingly.

Do not change the log file permissions to allow all users to read the files, as they
may contain sensitive information.

z/OS Data Collector: Request metrics and method trace data do
not appear
The problem: When class preloading is enabled, request metrics and method trace
data do not appear.

The solution: If class preloading is enabled for WebSphere on z/OS, then you must
delete the .preload file for the WebSphere Application Server process when you
change instrumentation in the bcm.properties or userbcm.xmlfilename files. When
the process next starts up, a new class preload file is generated for your
application classes based on the latest instrumentation.

To check whether class preloading is enabled verify whether
-Dibm.websphere.preload.classes=true for Generic JVM arguments on the Java
Virtual Machine page.

z/OS Data Collector: Protocol Timeout
The problem: You have a transaction that is hung or too slow.

The solution: You need to do this to avoid an abend:
1. Log in to the WebSphere Application Server Administration Console.
2. Navigate as follows:

a. Select the Server → Application Servers option and select the server you
want to configure for use with ITCAM for Application Diagnostics.
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b. Navigate to Process Definition → Control → Additional Properties.
c. Select Environment Entries.
d. Add the following properties, as name/value pairs. Select OK after each

add operation:

Table 6. Add properties to Data Collector Environment Entries

Name Suggested
Minimum Value

protocol_http_timeout_input 3600

protocol_http_timeout_output 3600

protocol_http_timeout_output_recovery SESSION

protocol_http_timeout_persistentSession 3600

3. In the Messages dialog box, select Save.
4. In the Save to Master Configuration dialog box,
v If you are under ND environment, be sure the check box Synchronize

changes with Nodes is selected and then select Save.
v If you are NOT under ND environment, simply select Save.

5. You can verify your configuration data in /WAS_directory/server/was.env.
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Chapter 3. Troubleshooting: ITCAM Agent for J2EE

The following are troubleshooting tips and techniques for problems that occur
during installation, configuration and running of ITCAM Agent for J2EE.

Installation and configuration
The following are troubleshooting tips and techniques for problems that occur
during installation and configuration.

Data Collector
The following are troubleshooting tips and techniques for problems that occur
during installation and configuration of the Data Collector.

Cannot connect to JBoss server when configuring the Data
Collector for JBoss 4.2.0 or higher
The problem: When configuring the Data Collector for JBoss 4.2.0 or higher, the
following error message is displayed after entering the JBoss Server and Java home
details:
Cannot connect to the JBoss server.
Make sure that the JBoss is running or check whether the Server Host/Port specified
are correct. Please be sure of that JNP service is not only bound on localhost
and JNP service should be able to be connect via domain name like
testdomain.com:1099

The reason: Before JBoss version 4.2.0, JBoss always bound to any address, for
example, 0.0.0.0. For security reasons, when using JBoss 4.2.0 or later, you need to
explicitly state the address.

The solution: If you want to use 0.0.0.0 as your JBoss address, start the JBoss server
by passing the following parameters to the startup script:

For UNIX, use:
./run.sh -b 0.0.0.0

For Windows, use:
run.bat -b 0.0.0.0

Note: You are advised to secure your JBoss instance when using the server in
production.

Data Collector configuration fails
The following content provides solutions when the Data Collector configuration
fails.

Net Weaver Data Collector cannot be configured

The problem: Net Weaver Data Collector configuration fails when the Data
Collector is installed in an English locale but configured in a Turkish locale.

The solution: Re-install the Data Collector in a Turkish locale.
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WebLogic 9 Data Collector configurator cannot create
Startup/Shutdown class

The problem: The Data Collector configurator cannot create the Startup/Shutdown
class. The admin server returns an error like:
weblogic.management.provider.EditFailedException: [Management:141201]
Unable to modify the configuration using the compatibility MBean server
as other changes are pending.
Activate the pending changes before modifying the configuration with the
compatibility MBean server.

The solution: The WebLogic 9 configuration is locked by the admin console, try to
release the configuration lock from admin console and try again. Restart the
WebLogic server after you try this.

WebLogic Data Collector cannot be configured with Weblogic 9 and
JRocket

The problem: When configuring WebLogic Data Collector with Weblogic 9 and
JRocket, the configuration process fails.

The cause: This problem is caused by the WebLogic 9 admin console. Data
Collector configurator is unable to add, update, or remove the MBean while the
meta repository is locked by the admin console.

The solution: Unlock the WebLogic 9 application server by clicking Release
Configuration in the Change Center panel of the admin console before configuring
the Data Collector. If there are pending changes, save your changes and then click
Activate Changes in the Change Center panel.

WebLogic Server rejects Data Collector configuration - JNDI
connection

The problem: The WebLogic Server rejects the Data Collector configuration JNDI
connection and reports Certificate chain receieved from <ip> was incomplete on
the console. But from the admin console, the SSL attribute Two Way Client Cert
Behavior has been set to Client Certs Not Requested.

The solution: Change the attribute Two Way Client Cert Behavior to Client Certs
Request But Not Enforced and save it. Then change the attribute value to Client
Certs Not Requested.

Data Collector installation fails
The following content provides solutions when the Data Collector installation fails.

Data Collector installation fails when the system has a wrong mount

The problem: The Data Collector installation fails when the system has a wrong
mount.

The solution: InstallShield uses the UNIX df command to check disk space on the
target computer. User corrects the wrong mount indicated by the df command and
restarts the installation process.
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Data Collector installation or configuration fails

The problem: The directory DC_home/runtime is not created and the start-up script
or other files on application server side are not modified for Data Collector
support.

The solution: For a GUI installation, a message panel will pop up to show detailed
error information. Check this message to find if the prerequisite conditions are not
met.

For a silent installation, please check installation log files and find messages with
log level ERROR or WARN.

Net Weaver Data Collector installation or configuration fails

The problem: The Data Collector for Net Weaver installation fails or fails to start
after installation.

The reason: Verify that you have the correct configuration for Net Weaver, the
following text outlines the names, details, and locations for Net Weaver
configuration files:
v File: jvm_config.xml

– Details: Follow Net Weaver rules to define the JVM settings of Data Collector
for Net Weaver into Database.

– Location: NetWeaver Server Home/j2ee/configtool

v File: default_jvm_config.xml
– Details: Follow Net Weaver rules to reserve the default JVM settings of Net

Weaver Application Server before configuring Data Collector or unconfiguring
Data Collector from Net Weaver Application Server.

– Location: NetWeaver Server Home/j2ee/configtool

v File: BatchConfig.bat/BatchConfig.sh
– Details: Use these scripts to import the JVM settings of Data Collector for Net

Weaver into the database.
– Location: NetWeaver Server Home/j2ee/configtool

v File: sap.com~tivoli.sda
– Details: Tivoli service component to be deployed into Net Weaver server
– Location: NetWeaver Central Instance Home/SDM/program

v File: config.bat/config.sh/unconfig.bat/unconfig.sh
– Details: These scripts call Batchconfig.bat/BatchConfig.sh and deploy the

Tivoli service component into the Net Weaver Application Server. They also
config/unconfig all Data Collector settings for the Net Weaver server

– Location: NetWeaver Central Instance Home/SDM/program

v File: Tivoli Service Directory
– Details: This directory contains jar files packed in the Tivoli service

component.
– Location: NetWeaver Central Instance Home/j2ee/cluster/server[N]/bin/

services/tivoli

v File: config.log
– Details: The logs produced when configuring/unconfiguring the Data

Collector for Net Weaver.
– Location: CYN_LOGS/config.log
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The solution: If the std_server[N] log, reports Xrun library am_xx_xx.dll or
am_xx_xx.so cannot be found:
v On Windows: Check if the dll path (DC_home/toolkit/lib/platform) is added

into the Windows System Path.
v On UNIX/Linux: Check if the OS path of the Data Collector is appended with

DIR_OS_LIBS in Net Weaver START_INSTANCE_NAME_HOST_NAME script.

Oracle Data Collector Installation/configuration fails

The problem: After installing the Data Collector, the Oracle instance cannot startup.

The solution: If the instance log reports that Xrun library am_xx_xx.dll or
am_xx_xx.so cannot be found, make sure that your Oracle instance is recycled
properly.

If the Oracle instance is on Windows 2000 and the instance log file reports
maximum command length exceeded, check your Java options in your opmn.xml
and remove some unnecessary parameters. Another solution to exceeding
maximum command length is to install your Data Collector with a shorter file
system path like /opt/oracleDC or C:\DC\.

Data Collector for WebLogic server instance cannot be
unconfigured
The following content provides solutions when the Data Collector for WebLogic
server instance cannot be unconfigured.

Data Collector for WebLogic server instance cannot be unconfigured
after the listening port of the WebLogic domain administration server
is changed

The problem: WebLogic server instance cannot be unconfigured after the listening
port of the WebLogic domain administration server is changed. During the
unconfiguration process, the following message is reported:
Cannot connect to weblogic server, please make sure the server is running,
and check host/port parameters.
If connecting to weblogic over SSL, please check SSL client CA trust keystore file,
and client certification files/types/password also.

The solution: Perform the following steps to unconfigure the Data Collector
manually:
1. From the administration console of the WebLogic domain administration server,

remove the WebLogic server instance from the target server list of Startup Class
AM Startup. If the server list of Startup Class AM Startup is empty, it can be
removed as well.

2. From the administration console of the WebLogic domain administration server,
remove the WebLogic server instance from the target server list of Shutdown
Class AM Shutdown. If the server list of Shutdown Class AM Shutdown is
empty, it can be removed as well.

3. Stop the WebLogic server instance.
4. Remove ITCAM Data Collector JVM arguments from the WebLogic server

instance startup script.
v If the WebLogic server instance is started by a script file or is run as a

Windows Service:
a. Open the startup script file.
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b. Search and locate the lines with the keywords "DC for Weblogic
support--begin"and "DC for Weblogic support--end" and delete all the
content between the above two lines from the file.

v If the WebLogic server instance is started from the NodeManager:
a. Open WebLogic administration console in a browser. Navigate to the

server instance's Configuration panel.
b. Click the table Remote Start (WebLogic 8) or Server Start (WebLogic 9 or

10)
c. For WebLogic 8, remove the following arguments from Arguments:

-Xbootclasspath/p:DC_home/toolkit/...
-DCCLOG_COMMON_DIR=...
-Xrunam_sun(ibm/bea)_14:...
-Dcom.ibm.tivoli.jiti.injector.IProbeInjectorManager=...
-Dcom.ibm.tivoli.jiti.injector.ProbeInjectorManagerChain.

primaryInjectorFile=...

d. For WebLogic 9 or 10, remove the following arguments from Arguments:
-Xbootclasspath/p:DC_home/toolkit/...
-DCCLOG_COMMON_DIR=...
-agentlib:am_sun(ibm/bea)_15=...

5. If the WebLogic server instance is installed as a Windows Service, it is required
to re-install the Windows service. To do so, run the script
uninstallService.cmd first and then the script installService.cmd in the
WebLogic domain directory

6. Remove the instance directory from the Data Collector home directory. The
path is DC_home/runtime/
wlsServer_Version.Domain_Name.Computer_Name.Instance_Name

7. Remove the configuration properties file for the WebLogic server instance
a. Go to the directory DC_home/installer/_uninst/configured/wls.
b. For each properties file starting with the name config, for example,

config636300264.properties, search for the keyword RUNTIME_DIR=DC_home/
runtime/wlsServer_Version.Domain_Name.Computer_Name.Instance_Name.

c. If the keyword is found, delete the file. Note there should be only one file
to be deleted

8. The unconfiguration process is completed. You can start the WebLogic server
instance now

Data Collector for WebLogic server instance cannot be unconfigured
after the password of the WebLogic domain administrator is changed

The problem: Data Collector for WebLogic server instance cannot be unconfigured
by the Configuration Tool after the password of the WebLogic domain
administrator is changed.

The reason: The Configuration Tool is using the old password to connect to the
WebLogic domain administration server, as the password is stored locally in a
configuration file by the Configuration Tool.

The solution: Use the password updater program to update the stored password.

To launch the password updater program in GUI mode:
1. From DC_home/itcamdc/bin directory, run the script password_updater.sh (or

password_updater.cmd on Windows).
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2. On the panel, select the WebLogic instance in which the user name and
password need to be updated.

3. Enter the new user name and password.
4. Click the Update button to finish the process.

To launch the password updater program in silent mode:
v From DC_home/itcamdc/bin directory, run the script password_updater.sh (or

password_updater.cmd on Windows).
Syntax:
password_updater.sh (or password_updater.cmd on Windows)
-instance=instance_name -username=user_name
-password=password

where:
instance_name is the name of the WebLogic server instance in the format of
wlsserver_version.domain_name.computer_name.instance_name. For example,
wls8.fp3test.tiv119.myserver.
user_name is the new JMX user name
password is the new JMX password

Failed to create the default Data Collector log path
The problem: After running the setup_DC_win32.exe file, the installation program
displays an incorrect Data Collector log path, C\:\Program Files
(x86)\ibm\tivoli\common, in the log path window. The installation program cannot
write to this path.

The reason: The problem is caused by this entry in the C:\Program Files
(x86)\ibm\tivoli\common\cfg\log.properties file:

tivoli_common_dir=C\:\\Program Files (x86)\\ibm\\tivoli\\common

The installation program obtains the default log path from this entry and then tries
write to this path.

The solution: After removing the C:\Program Files (x86)\ibm\tivoli\common\cfg\
log.properties file, the installation program will display the correct default log path
in the log path window and it will create the new log.properties file in the
C:\Program Files (x86)\ibm\tivoli\common\cfg directory with the following entry:

tivoli_common_dir=C:/Program Files (x86)/ibm/tivoli/common

For more information, see Installing the Data Collector by InstallShield Wizard in the
ITCAM for J2EE Data Collector Installation and Configuration guide.

Messages displayed during a silent installation
The following content provides information about the messages displayed during a
silent installation.

No message is displayed where they might be considered necessary

The problem: No error or informational message is displayed in the following
circumstances:
v During a silent installation, if the IBM JDK or JRE is not found or does not have

the correct permission, the installation process fails without any error messages.
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v In silent installation on UNIX or Linux systems, no information is displayed in
the Java console.

v When installing the Data Collector using an invalid option file (that is, the file
does not exist), the installation stops without displaying an error message. No
error message is displayed in the trace_install.log or log.txt file.

The cause: It is part of the design of the InstallShield and the purpose of silent
installation mode that there is no output on the console and no user interaction
during the installation. Specifying an options file that does not exist causes a
failure prior to the installer initialization, so there is no opportunity for the installer
to write the error to a log file.

The solution: You can attach -is:log log file to your command line, where log file is
the directory and the file name for the log file. For example: ./setup_DC_lin.bin
-silent -options ./silent/DC61_netweaver.opt -is:log log.txt

Warning messages are displayed when using silent installation for the
Data Collector on AIX

The problem: When using silent installation for the Data Collector on AIX, the
following messages are displayed:
-cp:p operand is empty
-cp:a operand is empty
Installer JAR archive is not embedded.
Build time Java arguments are not specified.
Run time Java arguments are not specified.

Warning: internal error parsing Java arguments. Launcher command may be
missing Java Arguments. LOADP not set

The solution: This is a result of the routine check by the installation program.
Ignore this warning message. It does not affect the installation and configuration
process.

Non-root user configuration problems
The following content provides information about non-root user configuration
problems.

Error messages are displayed on the console when installing or
configuring ITCAM agent for WebSphere Applications or J2EE as a
non-root user on the AIX system

The problem: Error messages are displayed on the console when you run ITCAM
agent for WebSphere Applications or J2EE installation or configuration as a
non-root user on the AIX system.

The reason: The problem was caused by lacking of the required access to create the
System Preference control files.

The solution: You can use either of the following way to solve this problem:
v Run ITCAM WebSphere Application Server/J2EE Installation or Configuration as

a root user.
v Navigate to the /usr/java14/.private142/jre/.java/.systemPrefs directory and

assign the write permission to the non-root user, create this directory if it does
not exist.
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Non-root Data Collector configuration cannot lock system preferences

The problem: When using a non-root user to install and configure the Data
Collector, system preferences cannot be locked. The following error is displayed in
the console:
java.lang.SecurityException: Could not lock System prefs. Lock file access denied.
at java.util.prefs.FileSystemPreferences.
checkLockFile0ErrorCode(FileSystemPreferences.java:937)
at java.util.prefs.FileSystemPreferences.lockFile(FileSystemPreferences.java:926)
at java.util.prefs.FileSystemPreferences.sync(FileSystemPreferences.java:732)
at java.util.prefs.FileSystemPreferences.flush(FileSystemPreferences.java:825)
at java.util.prefs.FileSystemPreferences.syncWorld(FileSystemPreferences.java:476)
at java.util.prefs.FileSystemPreferences.access$1200(FileSystemPreferences.java:51)
at java.util.prefs.FileSystemPreferences$4.run(FileSystemPreferences.java:437)
at java.util.TimerThread.mainLoop(Timer.java:447)
at java.util.TimerThread.run(Timer.java:397)

The reason: This is a limitation of JRE, please reference http://bugs.sun.com/
bugdatabase/view_bug.do?bug_id=4438983

What to do if you tried to install and configure the Data Collector using
a non-root user that did not have permissions to write to the
temporary directory

The problem: The configuration will fail if you used a non-root user that did not
have permissions to write to the temporary directory. You must perform the
following procedure to correct this issue and perform a subsequent successful
configuration of the Data Collector.

The solution:

1. Undo your initial (failed) configuration of the Data Collector by using the
Configuration Tool (config_dc.sh script) to unconfigure it. See the installation
and customization guide for details.

2. Perform one of the following:
v Give the non-root user ID read and write access to the /tmp and /var/tmp

directories:
a. Log on as root and give the non-root user ID read and write access to

/tmp.
b. If your operating system is HP or Solaris, give the non-root user ID read

and write access to /var/tmp also.
c. Remove all files and directories under /tmp and (HP or Solaris only)

/var/tmp.
v If you have concerns about removing all files under /tmp and (HP or Solaris

only) /var/tmp, specify a different temporary directory:
a. Modify the DC_home/config_dc/config_dc.sh file. Add the following

parameters to the file:
-Dtemp.dir=<tmp_dir>
-Djava.io.tmpdir=<tmp_dir>

where <tmp_dir> is the directory you want the Configuration Tool to
write to. The user for the installation should have read, write, and
execute privileges to this directory.

3. Run the Configuration Tool (config_dc.sh script) to configure the Data Collector.
See the installation and customization guide for details.
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Restarting the application server after installing Data Collector
for WebSphere Application Server Community Edition 1.1.0.2 on
Windows platform generates error messages
The problem: After installing Data Collector for WebSphere Application Server
Community Edition 1.1.0.2 on Windows platform, restarting the application server
generates following error messages and Java core dump files are created in
<WASCE_HOME>/bin directory

Module 21/22 geronimo/collector-tool-agent-tomcat/1.1.1/car[JarFileClassLoader@c 6b83c]
abort trouble in:

public class org.apache.geronimo.collectortool.servlet.CollectorServlet extends
javax.servlet.http.HttpServlet implements javax.servlet.Servlet:

The solution: This problem is due to Sun JVM bug 5097856. Please update Sun JDK
1.5 with update 1 or above. For further information, refer to http://bugs.sun.com/
bugdatabase/view_bug.do?bug_id=5097856

The monitoring agent
The following are troubleshooting tips and techniques for problems that occur
during installation and configuration of the Tivoli Enterprise Monitoring Agent.

Tivoli Enterprise Monitoring Agent fails to start with error
message "ERROR: required environment variable KWJ_PROD is
not set"
The problem: Tivoli Enterprise Monitoring Agent fails to start with error message
ERROR: required environment variable KWJ_PROD is not set in the native Tivoli
Enterprise Monitoring Agent log file after it is upgraded to a newer release or fix
pack.

The solution: To solve the problem, perform these steps:
1. From the management console, select Manage Tivoli Services → Advanced →

Unconfigure.
2. Select Manage Tivoli Services → Advanced → Configure using defaults.

Running ITCAM Agent for J2EE
The following are troubleshooting tips and techniques for problems that occur
when running the ITCAM Agent for J2EE.

Data Collector
The following are troubleshooting tips and techniques for problems that occur
when running the Data Collector.

Error messages occur in the log files after installing the JVMTI
interim fix on Sun JDK 1.5.0
The problem: If you have Sun JDK 1.5.0 and have installed the JVMTI interim fix
for the Data Collector, log error messages like the following one will occur when
you restart the application server:
java.lang.StackOverflowError
at
sun.reflect.generics.reflectiveObjects.TypeVariableImpl.getBounds
(TypeVariableImpl.java:114)

This indicates an unsuccessful configuration of the Data Collector.
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The solution: Upgrade the JDK version to Sun JDK 1.5.0_6 or later.

Attempts to start WebLogic Portal Server 10 using Sun JDK 1.5
or HP JDK 1.5 produce out-of-memory error messages
The problem: When attempting to start WebLogic Portal Server 10 using Sun JDK
1.5 or HP JDK 1.5, it fails and produces error messages similar to the following:
java.lang.OutOfMemoryError: PermGen space

The solution: If your WebLogic Portal Server 10 is using Sun JDK 1.5 or HP JDK
1.5, set the JVM parameter MaxPermSize to -XX:MaxPermSize=512M or above.

CICS Transaction Gateway (CTG) Common Client Interface (CCI)
Transactions not correlated
The problem: When applications on distributed systems (that is all systems except
z/OS and IBM i) use the Common Client Interface (CCI) for CICS Transaction
Gateway (CTG), transactions cannot be correlated between ITCAM Agent for
WebSphere Applications or J2EE Data Collector and ITCAM for Transactions Data
Collector.

The cause: This problem happens because the CCI adapter does not honor the
outboundDataLen setting.

The solution: Do not enable correlation when tracing CCI CICS transactions.
Transactions using CCI can be eliminated from correlation using the ctg.filters file.
See the installation guide for further details.

Custom Mbean does not function when the category name is in
lowercase
The problem: Custom Mbean does not function when the category name is in
lower case.

The solution: For a custom Mbean to function, a category name must be in
uppercase letters, with no blank spaces, numbers or special symbols in the name.

Data Collector fails to start
The following content provides solutions when the Data Collector fails to start.

Data Collector fails to start on WebLogic 8 cluster

The problem: After the Data Collector is successfully installed and configured on
the WebLogic 8 cluster, both WebLogic and the Data Collector cannot be restarted.

The solution: This happens when WebLogic server instance is started by different
JDKs. For example, the first time it might be started with BEA JDK and the second
time SUN JDK. Because the Data Collector configuration is JDK specific,
reconfigure the Data Collector to collect the correct JDK vendor information after
you change the JDK.

Tomcat Data Collector does not start after installation and
configuration

The problem: After the Tomcat Data Collector is installed and configured, the Data
Collector does not start.

The solution: The problem is the result of the limited page size of AIX. Sometimes
after a Data Collector is installed on AIX, the Data Collector issues an Out of
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Memory (OOM) error and stops. In this case, determine whether the AIX page size
is large enough. If it is not, set the AIX system environment with the following
shell command:
export LDR_CNTRL=MAXDATA=0x30000000

Note: The value of 0x30000000 is provided as an example only. You must
determine the correct value to set based on your environment.

Before you install the Tomcat Data Collector, determine whether the IBM 64-bit
JDK 1.4 has data size limitations that might cause an Out of Memory error while a
large application is processed. If it has data size limitations, run the following
command:
ulimit -d unlimited

WebSphere Community Edition Data Collector startup fails

The problem: After installing the Data Collector, WebSphere Community Edition
cannot startup.

The solution: Search in <SERVER_HOME>/var/log/geronimo.out (on Linux) or
console printout (on Windows) and see if there is a Port already in use: <port>
exception. This exception means that another program (for example another
WebSphere Community Edition instance) has occupied that port.

Either shutdown the other program to release the port or modify
<SERVER_HOME>/var/config/config.xml and set another port number.

When the shutdown.sh command finishes executing on Linux, there is a delay
(approximately 15 seconds) before the process is fully shut down. Use the
command ps ef | grep java to make sure the process is fully shut down before
restarting the server.

DB2-related applications cannot be deployed on Oracle 9 after
the Data Collector is configured
The problem: When the Data Collector is installed and configured on an instance,
the DB2-related applications cannot be deployed on Oracle 9.

The solution: This problem is the result of the ClassLoader structure. Put the DB2
JDBC driver in a different location from the JRE's ext directory to avoid this
problem.

J2SE Data Collector has JAVA Null Exception Errors
The problem: The following error displays when you configure the Data Collector.
The command line in Windows displays the following error:

"setLogPath:C:\PROGRA~1 java.lang.NullPointerException at null.null(Unknown
Source)"

The reason: This is a caused by the Install shield GUI not being able to handle
keyboard shortcuts.

The solution: This will not affect the installation or configuration of the product.

J2SE Data Collector custom request fails
The problem: J2SE Data Collector custom request fails to capture any requests on
the Managing Server side.
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The solution: There may be no default edge request type in the J2SE Data
Collector. To enable custom requests, edit the custom_request.xml and
toolkit_custom.properties files, to allow J2SE to capture custom functions and show
them on the VE side by specific request name.

JBoss Data Collector throws java.lang.NoClassDefFoundError
exception during server start
The problem: During server start, JBoss Data Collectors throws the following
exception:
java.lang.NoClassDefFoundError: javax/resource/cci/Connection

The reason: JBoss application server provides JCA service implementation such as
javax/resource/cci/Connection. There is a conflict when both the J2EE application and
JBoss application server includes the same JCA service implementation.

The solution:Since JCA service implementation is already provided by JBoss
application server, the solution is to remove the conflicting class in the J2EE
application.

Net Weaver: Cannot get request data from CTG/IMS/MQI library
The problem: Cannot get requests from CTG/IMS/MQI if CTG/IMS/MQI is a
library.

The solution: Make sure there are bidirectional references between the Tivoli
service component and the CTG/IMS/MQI library component. To do this, check if
there is a reference (which defines the reference from those components to the
Tivoli service) in the CTG/IMS/MQI Library component, and add a reference
(which defines the reference from the Tivoli service to the CTG/IMS/MQI Library)
in the Tivoli service component.

For example, for CTG jars deployed as a CTGLIB library into NetWeaver App
Server, perform the following steps:
1. Start the J2EE Engine Visual Administrator and connect it to the J2EE Engine.
2. Click Server -> Services -> Configuration Adapter Service.

3. Click the Runtime -> Display Configuration tab
4. Choose the Edit mode option.
5. Select cluster_data -> server/dispatcher -> cfg -> ext/interfaces/services ->

<component_name>-provider.xml. In the dialog box that appears, add the
following component reference into the configuration of the relevant
component:
<reference type="service" strength="weak">
tivoli
</reference>

6. Select cluster_data -> server/dispatcher -> cfg -> ext/interfaces/services ->
<component_name>-provider.xml. In the dialog box that appears, add the
following component reference into the configuration of the relevant
component:
<reference type="library" strength="weak">
CTGLIB
</reference>

7. Click OK to save your changes.
8. Restart the corresponding cluster element.
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No Heap Dump available on Solaris JDK1.5
The problem: No heap dump available on Solaris JDK 1.5.

The solution: perform the following steps:
1. Add "internal.doheapdump=true" in DC_home/runtime/*.*.*/

*.datacollector.properties.
2. Make sure JDK version is above 1.5.0_01

Data Collector uses JVMTI instead of JVMPI to get HEAPDUMP information. From
version 1.5.0_01, SUN JDK 1.5 on Solaris supports HEAPDUMP in JVMTI.

Port number of the request URL in the Request/Session Object
Link is incorrect on an Oracle Data Collector
The problem: When invoking some requests on an Oracle AS , the port number of
the Request URL displayed on the Request/Session Object page is sometimes not
consistent with the actual request URL.

The reason: For Oracle Application Servers, the Data Collector displays the
recommended port of Oracle HTTP Server in the Request URL. If you do not have
Oracle installed with WebCache, the port number of the Request URL that is
displayed will be the recommended port of the Oracle HTTP server. Refer to
Oracle HTTP Server Administrator Guide and Oracle Knowledge Base (Note:
256923.1) for more information.

Server fails to start
The following content provides solutions when the server fails to start.

Server fails to start after configuring the Data Collector for Oracle

The problem: On Windows Server 2003 R2 Enterprise x64 Edition Service Pack 2,
after configuring the Data Collector for Oracle, the server instance fails to start
with the following message in the log file:

"Error occurred during initialization of VM Could not reserve enough space for
object heap"

The reason: Windows Server 2003 R2 Enterprise x64 Edition Service Pack 2 fails to
reserve sufficient object heap for 32-bit JVM process when it tries to load a
dynamic-link library before startup.

The solution: Change the maximum JVM heap size to a smaller value. For Oracle
application server, this value is specified in opmn.xml by "-mx" or "-Xms"
parameter.

WebLogic Portal 8 cannot start server from Windows service

The problem: For WebLogic Portal 8, starting the server as a Windows Service in
production mode: cannot start the server from Windows Service after configuring
the Data Collector.

The solution: Find the cache files (on the directory {wldomain}\{wlinstance}\
.wlnotdelete\extract) and remove the following directories:
v {wlinstance}_console_console {wlinstance} _uddi_uddi

v {wlinstance}_uddiexplorer_uddiexplorer

v {wlinstance}_wl_management_internal1_wl_management_internal1
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v {wlinstance}_wl_management_internal2_wl_management_internal2

JBoss fails to start

The problem: JBoss fails to start after running the Start_Application_Server
command.

The reason: The JBoss run.bat script uses pipe (|) Windows shell commands to grep
(findstr) on the Java -version output. This is probably linked to how Windows Shell
(and the pipe command in particular) operates when executed on behalf of
Windows services.

The solution: Comment out pipe commands in run.bat. However, if a Sun JDK is
being used, than commenting out problem commands will cause JBoss to start
without the -server option. So the -server option must be added manually, as per
the following procedure:
1. Remove or comment out the following line in the run.bat file.

%JAVA%" -version 2>&1 | findstr /I hotspot > nul

2. Add the following line to the run.bat file:
set JAVA_OPTS=%JAVA_OPTS% -server

The Data Collector on Sun IAS 6.5 cannot read garbage
collection events when using the custom JVM launcher
The problem: The Data Collector on Sun IAS 6.5 cannot read garbage collection
(GC) events when using the custom JVM launcher. To enable reading of GC, you
must modify the startup script.

The reason: Sun IAS 6.5 uses the custom JVM launcher's .kjs files. The custom
launcher ignores the JVM verbose gc argument (-verbosegc). Thus the Data
Collector cannot read GC log events from the standard output redirect file.

The solution: Manually change the startup script file in the <AppServer_home>/bin/
kjs directory. Remove the # from the line for the standard Java launcher as follows:
$JAVA_HOME/bin/java ${JAVA_ARGS} com.kivasoft.engine.Engine $opts

WebLogic does not function after the Data Collector is installed
The problem: After installing the Data Collector, WebLogic does not function and
displays the error message Too many open files.

The solution: Increase the value of rlim_fd_cur and rlim_fd_max in file /etc/system
based on your specific system configuration. For example, set both of the values to
4096:
# set hard limit on file descriptors
set rlim_fd_max = 4096
# set soft limit on file descriptors
set rlim_fd_cur = 4096

The monitoring agent
This chapter provides information about problems you might encounter when
running the monitoring agent (Tivoli Enterprise Monitoring Agent), along with
either the reasons for the restrictions or suggested procedures for working around
them.
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Tivoli Enterprise Monitoring Agent on Windows Vista fails to
start without administrator rights
The problem: Tivoli Enterprise Monitoring Agent on the Windows Vista system
fails to start when you do not run it with administrator rights.

The cause: Inadequate user rights.

The solution: Grant administrator rights by carrying out the following steps:
1. Right-click the Manage Tivoli Monitoring Services.
2. Click Properties → Compatibility → Run this program as an administrator.

Tivoli Enterprise Monitoring Agent fails to start or recycle the
server
The problem: The Tivoli Enterprise Monitoring Agent fails to start or recycle the
server when running a memory-intensive Java application in a 32-bit Java virtual
machine (JVM). The error message JVMST018 shown below will appear in the
native_stderr.log file.
# ./java -version -Xms128M -Xmx2048M
[ **Out of memory, aborting** ]
[ ]
[ *** panic: JVMST018: Cannot allocate memory for
initializeMarkAndAllocBits(allocbits1) ]

The cause: This problem occurs because the maximum Java heap size for the J2EE
Application server is set to a value that is too large.

The solution: Lower the maximum heap size.

Tivoli Enterprise Monitoring Agent stops because of lack of
memory
The problem: The Tivoli Enterprise Monitoring Agent reports the following errors:
v java.lang.OutOfMemoryError: JVMCI015:OutOfMemoryError, cannot create

anymore threads due to memory or resource constraints
v java.lang.OutOfMemoryError: JVMST017: Cannot allocate memory in

initializeMarkAndAllocBits(markbits1)

The reason: These error messages indicate that the Tivoli Enterprise Monitoring
Agent is experiencing a high load and lack of available memory.

The workaround: To resolve this problem, do one of the following:
v Disable the memory limit by issuing the ulimit -d unlimited command and the

ulimit -m unlimited command before the Tivoli Enterprise Monitoring Agent
starts.

v Increase the Java heap size for the Tivoli Enterprise Monitoring Agent by setting
the -Xmx256m parameter for the Java Options in the Tivoli Enterprise
Monitoring Agent Java properties file.

Note: Refer to http://www.ibm.com/developerworks/java/jdk/diagnosis for
more information about Java troubleshooting tips.
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Chapter 4. Troubleshooting: ITCAM Agent for HTTP Servers

This chapter provides information about problems you might encounter when
running the ITCAM Agent for HTTP Servers, along with either the reasons for the
restrictions or suggested procedures for working around them.

Note:

ITCAM Agent for HTTP Servers is known as ITCAM agent for Web Servers in the
former versions.

Tivoli Enterprise Monitoring Agent fails to start or recycle the server
The problem: The Tivoli Enterprise Monitoring Agent fails to start or recycle the
server when running a memory-intensive Java application in a 32-bit Java virtual
machine (JVM). The error message JVMST018 shown below will appear in the
native_stderr.log file.
# ./java -version -Xms128M -Xmx2048M
[ **Out of memory, aborting** ]
[ ]
[ *** panic: JVMST018: Cannot allocate memory for
initializeMarkAndAllocBits(allocbits1) ]

The cause: This problem occurs because the maximum Java heap size for the J2EE
Application server is set to a value that is too large.

The solution: Lower the maximum heap size.

Tivoli Enterprise Monitoring Agent on Windows Vista fails to start
without administrator rights

The problem: Tivoli Enterprise Monitoring Agent on the Windows Vista system
fails to start when you do not run it with administrator rights.

The cause: Inadequate user rights.

The solution: Grant administrator rights by carrying out the following steps:
1. Right-click the Manage Tivoli Monitoring Services.
2. Click Properties → Compatibility → Run this program as an administrator.

Tivoli Enterprise Monitoring Agent stops because of lack of memory
The problem: The Tivoli Enterprise Monitoring Agent reports the following errors:
v java.lang.OutOfMemoryError: JVMCI015:OutOfMemoryError, cannot create

anymore threads due to memory or resource constraints
v java.lang.OutOfMemoryError: JVMST017: Cannot allocate memory in

initializeMarkAndAllocBits(markbits1)

The reason: These error messages indicate that the Tivoli Enterprise Monitoring
Agent is experiencing a high load and lack of available memory.

The workaround: To resolve this problem, do one of the following:
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v Disable the memory limit by issuing the ulimit -d unlimited command and the
ulimit -m unlimited command before the Tivoli Enterprise Monitoring Agent
starts.

v Increase the Java heap size for the Tivoli Enterprise Monitoring Agent by setting
the -Xmx256m parameter for the Java Options in the Tivoli Enterprise
Monitoring Agent Java properties file.

Note: Refer to http://www.ibm.com/developerworks/java/jdk/diagnosis for
more information about Java troubleshooting tips.

Web Servers Summary view does not display the new server name
The problem: Web Servers Summary view does not display the new server name
after the server name has been changed.

The solution: Restart Tivoli Enterprise Monitoring Agent after changing the server
name. The new name will then be shown in the Web Servers Summary view.
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Chapter 5. Troubleshooting: Tivoli Enterprise Portal

This chapter provides information about possible problems during installing,
running or configuring the user interface (Tivoli Enterprise Portal) for the agents.
Some problems listed are universal and not related to specific agents.

Agent node cannot be found after reconfiguration
The problem: After unconfiguring the ITCAM Agent for WebSphere Applications
with "No TEMS" option-selected, restart WebSphere Application Server and
configure the agent again. However, the WebSphere Agent node cannot be found
in Tivoli Enterprise Portal.

The cause: This problem is caused by wrong protocols. The default protocol of the
agent is IP.PIPE. But if you unconfigure the agent with "No TEMS" option selected
and then reconfigure the agent, the default protocol changes to TCP/IP.

The solution: Set the protocol to IP.PIPE when reconfiguring the agent.

Application Server subnode not available
The problem: Tivoli Enterprise Monitoring Agent to Data Collector connection fails
and the application Server subnode is not available in Tivoli Enterprise Portal.

The solution: Check connection between the Tivoli Enterprise Monitoring Agent
and the Data Collector:
1. Check that the physical socket connection between the Tivoli Enterprise

Monitoring Agent and the Data Collector exists. You can use the net stat utility
to check. For example, using the command bash-2.05b# netstat -a | grep 63335,
the following table shows that the Tivoli Enterprise Monitoring Agent has
established a connection with one application server:

Table 7. Tivoli Enterprise Monitoring Agent Connections

localhost.41576 localhost.63335 49152 0 49152 0 ESTABLISHED

localhost.63335 localhost.41576 49152 0 49152 0 ESTABLISHED

*.63335 *.* 0 0 49152 0 LISTEN

2. If socket connection is not established, check that the Data Collector is
configured correctly. The DC_home/runtime/platform.node.server/
platform.node.server.kwjdc.properties properties file should have two
properties uncommented and set as follows:
com.ibm.tivoli.kwj.agentport=63335
com.ibm.tivoli.kwj.agenthostname=127.0.0.1

3. If the Tivoli Enterprise Monitoring Agent listen port is not bound, check the
Tivoli Enterprise Monitoring Agent configuration in GUI or command-line
mode.
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Automatic threshold and history problems after upgrading
The problem: After an upgrade to ITCAM for Application Diagnostics, the
following problems might happen:
v Enable_Auto_Threshold Take Action fails. It might return code 3.
v Automatic request time threshold values are not set correctly.
v Automatic request time threshold values and application baselining data are lost.
v Automatic baselining for some applications does not start.
v History may not be visible.

The solution: On the Tivoli Enterprise Monitoring Agent host, delete the following
files after an upgrade to ITCAM for Application Diagnostics:
v For ITCAM Agent for WebSphere Applications, when upgrading from ITCAM

for WebSphere or ITCAM for Web Resources:
– On Windows, ITM_home\TMAITM6\hostname_appmon_yn.ctx and

ITM_home\TMAITM6\hostname_yn*_baseline.ctx.
– On Linux and UNIX systems, ITM_home/config/hostname_appmon_yn.ctx and

ITM_home/config/hostname_yn*_baseline.ctx.
v For ITCAM Agent for J2EE, when upgrading from ITCAM for J2EE version

6.1.0.4 (6.1 Fix Pack 4) or earlier or from ITCAM for Web Resources version
6.2.0.4 (6.2 Fix Pack 4) or earlier :
– On Windows, ITM_home\TMAITM6\hostname_appmon_yn.ctx and

ITM_home\TMAITM6\hostname_yj*_baseline.ctx.
– On Linux and UNIX systems, ITM_home/config/hostname_appmon_yn.ctx and

ITM_home/config/hostname_yj*_baseline.ctx.

After you delete the files, a baselining process to collect the data is started
automatically for all applications.

You do not need to delete the files for ITCAM Agent for HTTP Servers.

Cannot see the hover help in summary workspace
The problem: In Tivoli Enterprise Portal, when you multiselect two or more icons
in a summary workspace the hover (flyover) help is not displayed.

The cause: In the WebSphere Agent - Primary node → Workspace → WebSphere
Agent Summary → View → Application Servers Status, if you click an individual
icon in a summary workspace, for example, Applications or Resources, you will
see hover help information relating to the icon. If you click more than one icon
simultaneously and then click one icon, or click the white space around an icon,
the hover help information is not displayed. This problem applies to the following
icon views in summary workspaces:
v Applications
v Resources
v WebSphere Agent Summary Status
v Application Server Summary

The solution: To resolve the problem, click another workspace and then enter the
summary workspace from the WebSphere Agent - Primary node again and click
icons once at a time.
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Dashboard table filter cannot handle informational situations
The problem: There is no way to distinguish nodes where an informational
situation has been fired in the dashboard table view in Tivoli Enterprise Portal.
Although an informational situation has been opened for a node, it is still green
coded and its status is 'Harmless'. As a result, you will not be able to find nodes
with informational situations and separate them from other nodes in the
dashboard.

The reason: It works as designed. Not all statuses can be handled by the
informational filter in the dashboard, although their values are shown and can be
selected in the filter.

Historical view problems
The following content provides information about historical view problems in
Tivoli Enterprise Portal.

Historical views in the Application Server workspace show no
historical data

The problem: The ITCAM for Application Diagnostics agent historical views within
the Application Server workspace are not displayed if the Tivoli Enterprise
Monitoring Agent host and the Tivoli Enterprise Portal server host are out of sync.
There are two possible reasons for this problem:
v Two history collection samples might not yet have been collected for display.
v The date and time on the computers that run the Tivoli Enterprise Monitoring

Agent, the Tivoli Enterprise Monitoring Server, and the Tivoli Enterprise Portal
server were not synchronized.

The solution:

v If the history collection samples have not been collected, wait for at least three
collection intervals for data to be reported by the Tivoli Enterprise Monitoring
Agent. The default collection interval is 30 minutes.

v Make sure that the date and time on the computers that run the Tivoli
Enterprise Monitoring Agent, the Tivoli Enterprise Monitoring Server, and the
Tivoli Enterprise Portal server are synchronized.

Some historical data is not automatically collected

The problem: After Tivoli Enterprise Monitoring Agent has been successfully
installed, some workspaces do not automatically report historical data. Also, alert
icons are displayed on the screen.

The workaround: The following procedures might resolve the problem:
1. Click the History Collection Configuration button in the Tivoli Enterprise

Portal.
2. In the Select a product scroll-down list, select ITCAM for Application

Diagnostics as the product.
3. In the Select Attribute Groups scroll-down list, select the attribute groups for

which you want to view historical data. Click the Show Default Groups button
at the bottom of the page

4. Select the corresponding check boxes in the Configuration Controls panel, and
click the Configure Groups button.
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5. Click Show Default Groups again.
6. Click Start Collection.

There might be a delay before historical data is displayed in Tivoli Enterprise
Portal. This delay might be as much as twice as long as the historical collection
interval time.

History is not visible after upgrading

The problem: After upgrading to ITCAM for Application Diagnostics, history is not
visible in the Tivoli Enterprise Portal.

The solution: On the Tivoli Enterprise Monitoring Agent host, after an upgrade to
ITCAM for Application Diagnostics, you need to delete the following files:
v Windows, ITM_home\TMAITM6\hostname_yn*.ctx
v Linux and UNIX systems, ITM_home/config/hostname_yn*.ctx

Issues arising out of Attribute name changes
The problem: In the KYNREQUEST table, the following four attribute names were
changed:

Table 8. Attribute name changes in KYNREQUEST table

Attribute names present Equivalent names for old versions

Request health Request Delay Type

Client Tier Health Client Tier Delay Type

Application Tier Health Application Tier Delay Type

Backend Tier Health Backend Tier Delay Type

This may cause issues when upgrading from old versions to ITCAM for
Application Diagnostics. Areas of particular concern are:
1. Customized workspaces or situations that depend on the attributes listed.
2. Historical and Tivoli Data Warehouse (TDW) data.

The reason: This name has been changed in ITCAM for Application Diagnostics.

The solution: The solution depends on the symptom:
v For problems with customized workspaces or situations that depend on the

attributes listed, you must re-work workspace or situation definitions to use
up-to-date attribute names.

v For problems with Historical and TDW data, you must reset/restart historical
data collection/TDW (for example, both short and long term) for the specified
KYNREQUEST table, refer to the IBM Tivoli Monitoring manuals for further
details.

78 ITCAM for Application Diagnostics: Troubleshooting Guide



ITCAM Agent for WebSphere Applications shows disconnected in
workspace server summary

The problem: ITCAM Agent for WebSphere Applications workspace "WebSphere
Agent" and workspace view "Application Servers Summary" shows status of
disconnected for a server subnode name. In the "WebSphere Agent" workspace you
will see a status of disconnected for a server subnode name but the WebSphere
Application Server JVM will actually be running.

The cause: An un-configuration for the ITCAM Data Collector as a WebSphere
Application Server was performed and then the Data Collector was re-configured
for WebSphere Application Server Portal Server. A restart of the JVM is needed
between these two activities.

The solution: Delete the hostnameyn.ctx file in the ITM_home directory.

ITLM agent not installed
The problem: When starting the WebSphere agent, in the WebSphere
Agent-Primary → WebSphere Agent Events window on the portal, an information
notice appears, stating:
KYNA0040I ITLM License status:ITLM_AGENT_NOT_INSTALLED

The reason: ITLM agent is IBM Tivoli License Manager, this message is returned
when ITLM is either not installed or available.

The workaround: This is an information message and should not affect the
operation of the WebSphere agent. However, if you wish to prevent recurrence this
message, you must install the ITLM.

Manually removing the Tivoli Enterprise Portal Server database and
TEPS2 ODBC driver

The question: How to remove Tivoli Enterprise Portal Server database and TEPS2
ODBC driver in a Windows environment?

The answer: To force removal of the Tivoli Enterprise Portal Server database and
the TEPS2 ODBC driver in a Windows environment, perform the following steps:
1. Invoke the Add or Remove Programs function in Control Panel to uninstall all

IBM Tivoli Monitoring components, including the Tivoli Enterprise Monitoring
Agent.

2. Click Start → Programs → IBM DB2 → General Administration Tools → Control
Center.

3. Expand Systems → hostname → instances → DB2 → Databases.
4. Right-click Tivoli Enterprise Portal Server, and select Drop from the pop-up

menu.
5. Click Settings → Control Panel → Administrative Tools → Datasources (ODBC).
6. Click the System DSN tab.
7. Select the TEPS2 data source, and click Remove.
8. Reboot your node.
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Not reporting data problems
The following content provides information about not reporting data problems in
Tivoli Enterprise Portal.

Datasources workspace is blank

The question: Why does the Datasources workspace in Tivoli Enterprise Portal for
Tivoli Enterprise Monitoring Agent for ITCAM for WebSphere Applications contain
no data?

The answer: Check the following points:
1. Tivoli Enterprise Monitoring Agent and Data Collector code level must be a

supported combination, as per fix packs readme files.
2. Datasources must be defined in the WebSphere;
3. Tivoli Enterprise Monitoring Agent Monitoring Level must be set to L2;
4. JDBC collection must be enabled for instrumentation. That is, in

DC_home/runtime/svr/custom/toolkit_custom.properties, make sure that
com.ibm.tivoli.itcam.toolkit.ai.enablejdbc=true. If this setting does not
exist in your toolkit_custom.properties, it is set to true by default;

5. Sampling rate on the Tivoli Enterprise Monitoring Agent side needs to be high
enough. For Request Data to be displayed in workspaces, enough user
transactions have to be monitored and collected by the Request Aggregator in
the Data collector. The Request Collection Sampling Rate (%) setting determines
how many requests have to be sampled. If the user load is low and this
percentage is set to 2% (the default value), then it is likely that the time
duration between transactions getting monitored is large. Hence, these
workspaces might not display data for a long time. If you suspect that the
Request Collection Sampling Rate is the cause, you can set it to 100% and see if
the workspace is populated with data;

6. The application must use Datasources via J2EE Connectors. Consult the
application developer to determine if your application uses J2EE connectors to
attach to the DB, or its own code. Even if data sources are defined in
WebSphere Application Server, the application still might not be using them if
the application attaches using its own code. If the application is using
WebSphere Application Server data sources and you see SQL activity on the
Resource Analysis Tivoli Enterprise Portal workspace, then you can see
something on the datasource workspace.

EJB Modules workspace and JCA Connection Pools workspace
show no data

The question: Why is there no data on EJB Modules workspace and JCA
Connection Pools workspace on Tivoli Enterprise Portal?

The answer: This problem is a limitation of JBoss 5.1. The JCA connection Pools,
EJB Modules, and Servlets/JSPs → Web Application tables do not report any data
because some MBeans are missing in JBoss 5.1.

Empty workspaces with message KFWITM217E

The question: Some workspaces in Tivoli Enterprise Portal related to ITCAM Agent
for WebSphere Applications Monitoring Agent are empty and show error message
KFWITM217E.
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The answer: KFWITM217E is a generic message and you need to check the return
code (rc) to understand the actual root cause of the message. Where do you look
up this return code? Usually it is reported as appended text to the error message in
the same workspace or on its bottom status area.

For example:
KFWITM217E Request error: SQL1_OpenRequest failed rc=3000

The root cause will likely be an incorrect Historical Data Collection configuration
for those historical views showing the problem.

Check if the historical data collection is started on Tivoli Enterprise Portal for the
Attribute Groups used in the view that is showing the error.

Note: EJB Containers → Container transactions and EJB Containers → Container
objects Pools in Tivoli Enterprise Portal do not enable historical data collection by
default.

For rc=3001 it probably means that Historical Data Collection is properly
configured and started already but there are no still data available to be shown in
the view.

Please make sure there is activity for those data sources and wait for a time at least
equal or greater than the Collection Interval specified.

Garbage Collector analysis not reporting data

The problem: The GC analysis workspace depends on the GC log collection feature,
which is (optionally) enabled during GC configuration. If GC log collection is not
enabled, then only few metrics (PID and Java heap sizes) will be reported from this
workspace.

The solution: By default, GC analysis is configured with a 60 second, fixed
collection interval; take this into account when navigating into a linked workspace
(Allocation Failures, GC Cycles, etc.). Allocation Failures/GC Cycle workspaces are
supported for IBM JVM only. For JVM 1.3, ensure that the GC log file location is
defined in the <DC_home>/runtime/<platform.node.server>/
<platform.node.server>.kwjdc.properties properties file, as follows:
# Set this for JDK 1.3 where GC log file name can’t be
# specified on the command line
TEMAGCCollector.gclog.path=C:/PROGRA~1/ibm/tivoli/common/CYN/logs/gc.log

Log Analysis table shows no data on IBM i 5.4

The question: Why does the Log Analysis table show no data after installing
ITCAM Agent for WebSphere Applications on IBM i 5.4?

The answer: It is a limitation. Log Analysis table is not available because Tivoli
Enterprise Monitoring Agent is not supported on IBM i systems.

No data returned for Lock Analysis

The problem: In the Web User Interface of ITCAM for WebSphere Applications,
select Problem Determination → Server Activity Display → Lock contentions, and
the following error message is received:
CYNVE0850E: There are no classes instrumented for lock analysis.
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The solution: Check the following points:
v Data Collector must be running at L2 or L3 monitoring level;
v Lock analysis must be enabled, specifically the file DC_home/runtime/

app_server_version.node_name.server_name/custom/toolkit_custom.properties
must contain the following lines:
am.camtoolkit.gpe.customxml.lock=/opt/IBM/itcam/WebSphere/DC/itcamdc/etc/lock_
analysis.xml com.ibm.tivoli.itcam.toolkit.ai.enablelockanalysis=true

and file DC_home/itcamdc/etc/lock_analysis.xml must exist.
v If the code level is Fix Pack 4 or higher, you must make sure that the

DC_home/runtime/app_server_version.node_name.server_name/custom/
*datacollector.properties file contains the following lines, which have been
introduced together with Lock Analysis Enhancements:
The following properties define how much data Lock Analysis will collect at
various MOD levels.

internal.lockanalysis.collect.LN.lock.events = true | false
indicates whether or not lock acquisition and release events
will be collected at MOD level ’N’ (1, 2, or 3).

internal.lockanalysis.collect.LN.contend.events = true | false | justone
indicates whether or not lock contention events
will be collected at MOD level ’N’ (1, 2, or 3). If this
property is set to a value of ’justone’, it indicates that only
one pair of contention events is created for a request that encounters
contention acquiring a lock. If this property is set to a value of
of ’true’, then multiple pairs of contention records may be created,
if there are multiple threads that acquire the lock prior to the request.

internal.lockanalysis.collect.LN.contention.inflight.reports = true | false
indicates whether or not the inflight lock contention report is
supported from the System Activity Display at MOD level ’N’
(1, 2, or 3).

The default settings are as follows:
internal.lockanalysis.collect.L1.lock.events=false
internal.lockanalysis.collect.L1.contend.events=false
internal.lockanalysis.collect.L1.contention.inflight.reports=false

internal.lockanalysis.collect.L2.lock.events=true
internal.lockanalysis.collect.L2.contend.events=true
internal.lockanalysis.collect.L2.contention.inflight.reports=true

internal.lockanalysis.collect.L3.lock.events=true
internal.lockanalysis.collect.L3.contend.events=true
internal.lockanalysis.collect.L3.contention.inflight.reports=true

Resource metrics not reported

The problem: Resource analysis metrics are not reported

The reason:

v PMI workspaces report data in on-demand collection mode with a 30 second
sample age - unlike request and GC workspaces which have fixed intervals.

v For WebSphere, make sure that PMI is enabled in application server
configuration.

v Some workspaces are available for specific WebSphere Application Servers
versions only:
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– Enhanced PMI (Alarm Manager, DCS Stack, Platform Messaging, and so on.)
are available for WebSphere Application Server 6.0 or higher.

– Workload Management workspaces are not available for WebSphere
Application Server Base releases.

Request metrics not reported

The problem: Request analysis metrics are not reported.

The solution: Check your Tivoli Enterprise Monitoring Agent configuration for the
request monitoring enabled and sampling rate value. By default, the sampling rate
is 2, which means that only 2% percent of all requests (randomly selected) are
measured.

Selected Request or Datasource/JMS Summary workspaces not
reporting data

The problem: Selected Request or Datasource/JMS Summary workspaces do not
report data.

The solution: By default, request monitoring is configured for fixed interval
collection (60 second expiration interval), take this into account when navigating
through workspaces. If you still have this problem, check the request monitoring
level in your Tivoli Enterprise Monitoring Agent configuration. By default it is set
to Level 1, which means that only edge request times are measured, increase this
to Level 2 in order to display data in these workspaces.

Statistics in the Selected Application Summary not always
present

The problem: In the "Selected Application Trend at L1" view and "Selected
Application Trend at L2/L3" view, the statistics in the Selected Application
Summary table are not always present.

The solution: It works as designed. The statistics are only displayed in this table
when you are accessing the application.

Problems on Situations in Tivoli Enterprise Portal
The following content provides solutions to the problems of Situations in Tivoli
Enterprise Portal.

Identifying default Situations that come with ITCAM Agent for
WebSphere Applications Monitoring Agent

The problem: How can I see what the default Situations are with the ITCAM Agent
for WebSphere Applications Monitoring Agent?

The solution: Perform the following steps to identify what default Situations come
with the product:
1. Log in to the Tivoli Enterprise Portal Server console and view the agents on the

left panel.
2. Highlight the WebSphere Agent - Primary on your Tivoli Enterprise Portal

Server console and click the Situation icon. This brings up a new window with
a list of default Situations.
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3.

Some Situations cannot be triggered automatically

The problem: For ITCAM for Application Diagnostics 7.1, some Situations (for
example, WASReqSQLQueryTimePercentHigh) cannot be triggered automatically
when the condition is satisfied.

The cause: Some Situations are not started automatically by default.

The solution: Perform the following steps:
1. Log on to the Tivoli Enterprise Portal and open the agent.
2. Right-click on the WebSphere Application Server instance node.
3. Select Manage Situations.
4. Find the Situation in question and right-click Status to select Start.

The time that a situation is issued is different from the time of
the event

The problem: The time when situations are issued in Tivoli Enterprise Monitoring
Server is different from the actual time that the events occurred in the Tivoli
Enterprise Monitoring Agent. This problem occurs when the time of the Tivoli
Enterprise Monitoring Agent and the time of Tivoli Enterprise Monitoring Server
are not synchronous.

The workaround: Synchronize your Tivoli Enterprise Monitoring Agent time and
Tivoli Enterprise Monitoring Server time.

Wrong attribute groups associated with Situations in ITCAM
Agent for WebSphere Applications

The problem: When using IBM Tivoli Monitoring 6.2.1 with ITCAM Agent for
WebSphere Applications, the wrong attribute groups are associated with Situations.

The cause: This problem is a Tivoli Enterprise Portal limitation. It affects all
situation definitions that use UTF-8 string data type attribute for display-item, and
causes the wrong attribute group to be displayed for default Situations in the
Situation Editor.

The solution: You must re-create the Situation from the beginning when this type
of modification is necessary.

Request failed during execution (KFWITM220E)
The problem: WebContainer Pool Usage, ORB Pool Usage, Web Container Pool%,
ORB Pool % at Max in the PoolAnalysis workspace displays the following error:
KFWITM220E Request failed during execution.

The cause: These errors are related to Performance Monitoring Infrastructure (PMI)
level (basic) being enabled for ITCAM Agent for WebSphere Applications. The PMI
resource data is not available in historical views and causes these errors to occur.
Whenever the PMI collection level is set so that threadPoolModule.percentMaxed
metric is not collected the user will see these errors in ITCAM Pool Analysis
workspace.
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The solution: Change PMI from Basic to ALL, then restart the WebSphere
Application Server. To change the PMI level you will need to access the admin
console and change it there. For additional information on PMI levels refer to the
following link:

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/
com.ibm.websphere.nd.doc/info/ae/ae/rprf_dataorg.html.

Resource IDs displayed instead of English language strings
The problem: Resource IDs are displayed instead of English language strings in
Tivoli Enterprise Portal when using a Tivoli Enterprise Portal Server on Linux.

The solution: Perform the following procedure:
1. On the machine for the Tivoli Enterprise Portal Server, find and open the

cnp.sh file.
2. Add one of the following values to the CLASSPATH variable:

For the WebSphere monitoring agent: $<KCJ_LIB>/kyn_resources.jar

For the J2EE monitoring agent: $<KCJ_LIB>/kyj_resources.jar

For the Web Servers monitoring: $<KCJ_LIB>/kht_resources.jar

3. Save your changes to the cnp.sh file, here ITM_home/Platform_code/cj/bin, for
example /opt/IBM/ITM/li6263/cj/bin for RHEL.

4. Stop and start the Tivoli Enterprise Portal Server.

Time span icons are missing
The problem: Time span icons are missing in some views on the Tivoli Enterprise
Portal. For example, when the Container Transactions history is not enabled, you
may find that there are no time span icons in the Container Transactions - Rates
view.

The solution: Enable the history function to make time span icons available.

Tivoli Enterprise Portal browser client fails with error "CMWApplet
notinited"

The problem: When opening the Tivoli Enterprise Portal browser client, the load
fails with error "Applet: CMWApplet notinited".

The workaround: The following actions might resolve the problem:
1. Uninstall the IBM Java 1.4.2 plug-in by invoking the installer from the Java

installation path, such as \IBM\ITM\cnb\java\ibm-java2.exe.
2. Reinstall the Java 1.4.2 plug-in from the Java installation path, such as

\IBM\ITM\cnb\java\ibm-java2.exe.
3. Clear the Internet Explorer offline files and cookies: Access Internet Explorer's

Internet Options, and on the General page take the following actions:
v Delete cookies
v Delete offline files
v Clear history

4. Access Internet Explorer's Internet Options, and on the Advanced page, clear
the Use Java 2 v1.4.2 for applet option.
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5. From the Java plug-in's Control Panel, Advanced page, select the Java Runtime
Environment. Change the value from Use Java Plug-in Default to JRE 1.4.2 in
C:\Program Files\IBM\Java142\jre.

If this procedure does not resolve the problem, use the Tivoli Enterprise Portal
desktop client instead or contact IBM support.

The Failed Login Rate Metric displays 0 on Sun Web site
The problem: The Failed Login Rate Metric displays 0 on Sun Web site.

The solution: Configure the Sun Web Server by doing the following steps:
1. Create C:\Sun\WebServer6.1\docs\secure.
2. In the admin console click Manage after you select a server.
3. Click Restrict Access on the left panel of the Preferences page, and click OK in

the window that follows.
4. In A. Pick a resource of the Access Control List Management, click Browse,

and then select Secure directory.
5. Click the Edit access control, select Access control is on checkbox..
6. Ensure that the Action field value is Deny and the Users field value is anyone.
7. Click Submit.
8. Click Apply on the right top corner of the admin console.
9. Click Apply changes.

The Tivoli Enterprise Monitoring Agent JMX connection socket binding
is reported incorrectly

The problem: In some circumstances, the status of the Tivoli Enterprise Monitoring
Agent JMX connection socket binding is reported incorrectly.

The reason: By default, the Tivoli Enterprise Monitoring Agent listens to the
incoming Data Collector connections on port 63335, which you can customize
during configuration. If the Tivoli Enterprise Monitoring Agent fails to receive
incoming connections from the Data Collector, check whether the Tivoli Enterprise
Monitoring Agent socket interface was properly configured and initialized. The
possible reason is that another application is listening to the same port as the
Tivoli Enterprise Monitoring Agent does. This can lead to lose connection requests
from the Data Collector.

The solution: In order to resolve this problem, perform the following steps:
1. Check the Tivoli Enterprise Monitoring Agent message log or the Agent Event

workspace in Tivoli Enterprise Portal for the status of socket server
initialization. The Tivoli Enterprise Monitoring Agent issues message
KYNA0009 or KWJ0027A when socket interface initialization is successful.

Note: On the Windows platform, message KWJ0027A might not be issued
when another application is listening on the same port. Use system utilities
(such as Netstat) to determine whether a socket conflict has occurred.

2. Re-configure your Tivoli Enterprise Monitoring Agent listening port. For
information about how to re-configure ITCAM for Application Diagnostics
Agent listening port, refer to ITCAM Agent for WebSphere Applications Installation
and Configuration Guides or IBM Tivoli Composite Application Manager: Agent for
J2EE Monitoring Agent Installation and Configuration Guide.
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The Oracle application server displays incorrect port number in the
Request Name column

The problem: In the Request Name column, the Tivoli Enterprise Monitoring Agent
displays the request URLs with port numbers. You might find that the port
number in the Request Name column is different from the port number you
entered in the Web explorer.

The reason: This problem occurs when the Oracle application server does not have
Web Cache installed.

The workaround: To resolve this problem, do one of the following:
v Install the Oracle Web Cache.
v Ignore the incorrect port number, because it is essentially the same as the port

number used internally by the Oracle application server.

The version of the HTTP Server is wrong on Tivoli Enterprise Portal
The question: Why is the version of the HTTP server wrong in the Server
Summary table on Tivoli Enterprise Portal?

The answer: The HTTP server version displayed in the Server Summary table is
obtained from Apache 'apachectl -V' output. Apache web server reports its version
as 'UNIX' on both Linux and UNIX systems, and 'Win32' on Windows systems.

Tomcat JDBC Connection Pools is always 0 on REC
The problem: When configuring DataSources with administration Web application
provided by Tomcat, you cannot get the related MBean from the MBeanServer. On
the Runtime Environment Check page and the Runtime Environment Comparison
page, the value of JDBC Connection Pools is always 0. However the value should
not be 0. This problem occurs on Tomcat server 5.0 only.

The workaround: This problem does not occur in Tomcat 5.5.

New Take actions and Situations appear in workspaces for older Tivoli
Enterprise Monitoring Agent versions

The problem: New situations and take actions, such as Configure, ConfigCancel,
and ConfigPing show up in workspaces for the 6.1/6.2 Fix Pack 5 (and earlier)
Tivoli Enterprise Monitoring Agent. However, these take actions are only
supported in ITCAM for Application Diagnostics 7.1 and later.

This is an issue for systems running ITCAM for WebSphere 6.1 Fix Pack 5 or
earlier, ITCAM for J2EE 6.1 Fix Pack 5 or earlier or ITCAM for Web Resources 6.2
Fix Pack 5 or earlier in conjunction with ITCAM for Application Diagnostics 7.1.
The issue is only evident on Tivoli Enterprise Monitoring Agent in the 6.1/6.2 Fix
Pack 5 (or earlier) versions.

The reason: The Tivoli Enterprise Portal client does not rely on situation affinity to
determine the valid targets for distribution.
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The solution: This is a known issue and is actually necessary functionality for
some users. You can ignore these Situations and Take Actions if you are running
version 6.1/6.2 Fix Pack 5 or earlier in conjunction with version 7.1.
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Chapter 6. Troubleshooting: Managing Server

Installation and configuration
The following are troubleshooting tips and techniques for problems that occur
during installation and configuration of the Managing Server.

Configuring many WebSphere Application Servers takes a
long time

The problem: Configuration of many WebSphere Application Servers takes a long
time (for example, 50 servers may take 8 hours).

The reason: This is a limitation of wsadmin. This problem is especially prevalent
on AIX.

Core dump error occurs when accessing the Visualization
Engine on an Oracle database

The problem: Core dump error occurs when you perform the following actions:
v Run the klctl.sh dbtest command.
v Run the am-start.sh command.
v Access the Visualization Engine.

The solution: For Oracle OCI driver you must specify LD_LIBRARY_PATH and
ORACLE_HOME system environment variables explicitly before launching the
Managing Server and WebSphere Application Server which the Visualization
Engine is installed on.

Create application traps in Managing Server Visualization
Engine to see ITCAM agents data in RPT version 7 and 8

The problem: Problem Analysis tools in IBM Rational® Performance Tester (RPT)
can process and analyze transaction data from ITCAM agents for WebSphere
Applications and J2EE through a web service. ITCAM agents for WebSphere
Applications and J2EE support RPT version 7.x and 8.x. To see ITCAM agents data
in RPT, you can create application traps with method trace data action in
Managing Server Visualization Engine (MSVE).

The solution: To configure the Managing Server to work with RPT, complete the
following steps:
1. For information about RPT and how to install it, see the following Web site:

http://publib.boulder.ibm.com/infocenter/rpthelp/v8r0m0/index.jsp
2. If you have installed the Managing Server with an existing IBM WebSphere

Application Server 6.1, enable IBM WebSphere Global Security manually by
completing the following steps:
a. Log on to the IBM WebSphere Application Server administrative console.
b. Open Security → Secure administration, applications, and infrastructure →

Application security.
c. Select Enable Application Security.
d. Click Apply.
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e. Save your changes.

For embedded installations of IBM WebSphere Application Server and for all
existing IBM WebSphere Application Servers except version 6.1, IBM
WebSphere Global Security is automatically enabled during Managing Server
installation.

3. Enable method signature tracing.

In RPT, complete the following steps to import transaction data from the Managing
Server to RPT:
1. Start IBM Rational Performance Tester - Full Eclipse, from the File menu select

Import.
2. In the Import window, select Response Time Breakdown Data and click Next.
3. In the Monitoring Server Host field, enter the VE user name and password.
4. In Web Service Port, select Use port and enter the VE port number, click Next.
5. In the Constraints panel, specify the period of time for which you wish to

import data, click Next.
6. In the Trap window, select a trap to see method trace data.

Display problems during Managing Server installation
The following content provides some solutions to the display problems during
Managing Server installation.

Background color of some Java Swing components is white
while installing Managing Server

The problem: When installing the Managing Server on Linux/UNIX, the
background color of some Java Swing components is white.

The cause: The Managing Server installer is based on Java Runtime Environment
1.5, which may have issues when used in GNOME settings.

The solution: Use KDE instead of GNOME when installing the Managing Server
on Linux/UNIX.

Managing Server Installation panel overlaps the pop-up dialogs

The problem: When installing the Managing Server, the installation panel overlaps
the pop-up dialogs (for example, the "Cancel Install" dialog) if the installation
panel gets focus.

The cause: Managing Server installer is based on Java 1.5. This problem is a
limitation of Java 1.5.

The solution: Move the installation panel aside to view the pop-up dialogs.

Progress bar displays as stuck during embedded installations of
DB2 and WebSphere Application Server

The problem: The progress bar displays as stuck at a certain position for a long
time during the embedded installations of DB2 and WebSphere Application Server.

The reason: This issue is expected. Allow the installation to continue.
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Error CYNK0069E: MON_HEAP_SZ occurred while querying or
updating records in tables

The problem: The following error message is returned in trace-aal.log and
trace-kl1.log when Managing Server is supporting many data collectors:
CYNK0069E Database exception com.ibm.db2.jcc.b.SqlException: DB2 SQL error:
SQLCODE: -973, SQLSTATE: 57011,
SQLERRMC: MON_HEAP_SZ occurred while querying or updating records in tables.

The solution: Increase the MON_HEAP_SZ to 3072
su - [database instance user ID]
db2 update dbm cfg using MON_HEAP_SZ 3072
db2stop
dbstart

Failed to start am_start.sh after Managing Server installation
on Windows Server 2003 SP1

The problem: After installing the Managing Server on Windows Server 2003 SP1,
am_start.sh cannot be run and returns the following error:
Memory fault (core dumped)

The cause: The "Memory fault (core dumped)" message here means that the SFU
fix is not installed. You must install a UNIX shell environment (SFU/SUA) to
support Managing Server scripts on Windows platforms.

The solution: Install SFU/SUA according to the instructions on the following Web
site: http://publib.boulder.ibm.com/tividd/td/ITCAMMS/prereq61/en_US/
HTML/6.1_preinstall_other.htm

Failure to log on to the Managing Server
The following content provides some solutions to the problems you may encounter
when logging on to the Managing Server.

Failure to log on to the Managing Server after it is installed on
eWAS

The problem: Failure to log on to Managing Server after it is installed on eWAS.

The reason: The Managing Server cannot get the password when it is installed to
the components of Tivoli Monitoring.

The solution: Perform the following steps:
1. Before installing Managing Server, you are required to set a new password.
v For Windows: Open the Tivoli Enterprise Portal Server and select Actions →

Advanced → TEPS/e Administration → TEPS/e Administration Password.
v For UNIX or Linux: Enter the pdateTEPSEPass.sh username password

command from the script directory.
2. Restart Tivoli Enterprise Portal Server.
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Error CYNVE0002E occurs when logging on to the Managing
Server

The problem: During installation of the Managing Server, if you have entered an
incorrect DB2 instance port number, you cannot log on to the Managing Server
user interface successfully, and the following error message is returned:
CYNVE0002E A system error has occurred.

The solution: Perform the following steps:
1. Determine the correct port number. Take one of the following actions:

Table 9. Determine correct port number on different systems

Windows 1. Navigate to Start → All Programs → IBM DB2 →
General Administration Tools → Control Center.

2. In the left pane, right-click one of the available
instances for the local system.

3. Select Setup Communications.

4. Click Properties to the right of the TCP/IP choice.
The port number is listed on the window.

UNIX 1. Open the /etc/services file.
Note: You must have permissions to open the file,
which in many cases means that you have to be
root.

2. Look for the DB2 instance port number towards
the bottom of the file. The relevant line of text is
like the following line:

DB2_db2inst1 6000/tcp

In this example, db2inst1 is the name of the DB2
instance and 6000 is the port number for it.

2. If indeed the port number was entered incorrectly during installation, perform
the following steps:
a. Change the DB2 port number in JDBC_DRIVER_URL in

MS_home/bin/setenv.sh to the correct port number.
b. In the WebSphere Application Server administration console, change the

DB2 port number entered in the JDBC setup for the Application Monitor
JDBC resource to the correct port number.

FFDC returns a failure during Managing Server installation
The problem: First-Failure Data Capture (FFDC) returns a failure during Managing
Server installation, with the following message:
Database directory cannot be found on the indicated file system"
or "Unable to get a PooledConnection from the DataSource

The reason: The Managing Server installer creates database tables after creating the
WebSphere Application Server JDBC. After creating the WebSphere Application
Server JDBC, it tries to create the Data Pool. The error message is then returned.
This message indicates that the system database directory or local database
directory could not be found. A database has not been created or it was not
cataloged correctly.

The solution: It is most likely that your system is functioning as designed. Verify
that the database was in fact created with the correct path specification. The
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Catalog Database command has a path parameter which specifies the directory
where the database resides. You can find that the database was in fact created. If
so, no action is required. If not, contact IBM support for assistance.

Java not found error occurred during installations from CD
The following content provides some solutions to the Java not found errors during
installations from CD.

Installation from CD using LaunchPad: Java not found error
message

The problem: Attempting to use the LaunchPad program from CD-ROM
installation fails with a /java: not found error.

The solution: Change directories to the cdrom/ directory and try the installation
again.

Solaris installation from CD: Java not found error message

The problem: You receive a java not found error during installation on Solaris.

The solution: While mounting CDs on Solaris using volume manager, if the path to
the CD-ROM device contains a sharp character (#), such as /cdrom/WMSwin#1,
installation might fail with a java not found error. Unmount the CD-ROM (or eject
the CD), remove the entry with the sharp in /vol/dsk, and remount the CD-ROM
(reinsert the CD).

Managing Server and embedded installations fail
The problem: Installation of the Managing Server, embedded DB2, or embedded
WebSphere Application Server fails.

The solution: See the log files for error information.

Managing Server fails to get WebSphere profile information
when upgrading

The problem: When upgrading the Managing Server 6.1 to ITCAM for Application
Diagnostic 7.1, the upgrade fails because the installer cannot find WebSphere
Application Server profile information.

The cause: When the Managing Server is installed not using the normal methods,
the app.install.path property in the MS_home/etc/ve.properties is unset by
default, which causes a problem when upgrading.

The solution: To solve this problem, take the following steps:
1. Navigate to the MS_home/etc directory
2. Open the ve.properties file
3. Find the app.install.path=@{App_Install_Path} property
4. Set the value of App_Install_Path to the path where the Visualization Engine is

installed. For example:
app.install.path=c:/IBM/WAS61/profiles/AppSrv01/

installedApps/MSNode01Cell/ITCAM_Application.ear
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Managing Server installer hangs at 75% completed
The problem: Managing Server installation hangs at 75% completed during
"Installing the Visualization Engine... Restarting WebSphere Application Server...."

The reason: This is a WebSphere Application Server limitation. WebSphere Global
Security (GS) is not enabled.

The solution: Enable WebSphere GS manually, then you can install the Managing
Server.

Managing Server is started successfully but the connection
has problem

The following content provides some solutions when Managing Server is started
successfully but the connection has problem.

Managing Server is started successfully but Kernel is shown to
be unreachable

The problem: After installing ITCAM for Application Diagnostics 7.1 or upgrading
from ITCAM for WebSphere Application Server 6.1 and running am-start.sh,
Managing Server is started successfully, but the Enterprise view shows no data.
When viewing the diagnostic page, a message shows kernel can't be contacted.
There is also a "No such file or directory" message during running am-start.sh.

The cause: This problem is caused by Winzip or zip utility of Windows. When
extracting Managing Server installation image using Winzip or zip utility of
Windows, the CR/LF(^M) was added automatically to all text files in Managing
Server image.

The solution: For Managing Server installation on Windows, you must use
WinRAR or utility 7-Zip to extract Managing Server image. Do not use Winzip.

Managing Server is installed successfully but the database
cannot be connected

The problem: The installation of ITCAM for WebSphere Managing Server runs
successfully, but the database cannot be connected.

Diagnosing the problem: You must still test the database connection even if the
installation appears to succeed. The installation program creates a data source. The
following procedure tests if the installation was successful.

Note: In the case of an Oracle database, you have to perform the following steps
in addition:
1. In the WebSphere Application Server administrative console, expand the tree

Security → JAAS Configuration → J2C Authentication Data.
2. Click the WSAM J2C Authentication data entry.
3. Click Apply.

To test the database connection:

1. In the WebSphere Application Server administrative console, expand the tree
Resources → JDBC Providers.

2. Select the name of the JDBC provider.
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3. At the bottom of the page, select Data Sources.
4. Place a checkmark in the box next to the correct data source.
5. Click Test Connection to verify that ITCAM for WebSphere can connect

successfully to the Octigate database.

The solution: If the database is connected successfully, a message will display at
the top of the screen.

If the test fails, try verifying the following actions:
v Try to connect to the Octigate database manually using the DB2/Oracle

command-line processor.
v Verify the user name, password, and database name. If using Oracle, make sure

the URL has the following format:
jdbc:oracle:thin:@db_host:port:SID

For example:
jdbc:oracle:thin:@perfdb-sun-so1.ibm.com:1521:octigate

v Verify that the user which is used to start the WebSphere Application Server
console has a DB2 or Oracle profile as part of its profile.

Note: If the Managing Server uses an Oracle database and you see SQL syntax
errors, check the ve.properties file to make sure that
com.cyanea.octigate.database.ORACLE_8I is set to Y, and then restart the
Application Monitor. For example:
com.cyanea.octigate.database.ORACLE_8I=Y

Restoring the WebSphere Application Server configuration
The problem: The installation of the Managing Server fails, and the WebSphere
Application Server cannot be restarted.

The solution: Restore the configuration of WebSphere Application Server to its
prior values by take the following steps:

Run the script (UNIX) restoreConfig.sh or (Windows) restoreConfig.bat located
in the WAS_home/bin directory. Pass the backup configuration file
MS_home/backup/WebSphereConfig_backup_time as an argument, where time is the
time when the backup was taken.

This will restore the original WebSphere Application Server configuration.

Here is an example:
WAS_home/bin/restoreConfig.sh MS_home/backup/WebSphereConfig_backup_1127160879969
-nostop

Note: No backup is done for a remote network deployment environment.

RHEL5 requires xlibp files from Fedora Core v6 for Managing
Server to install

The problem: RHEL5 requires xlibp files to be updated before using Managing
Server, otherwise the following Java errors are seen:
The java class could not be loaded. java.lang.UnSatisfiedLinkError:
/opt/install/ms/ITCAMMSxlin/java/jre/bin/libawt.so: libXp.so.6: cannot
open shared object file: No such file or directory:
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The cause: This problem is caused due to the missing xlibp Fedora core 6 updates
files on the RHEL 50 OS.

The solution: Do the following steps:
1. Go to this Web site and download it: http://rpmfind.net/linux/rpm2html/

search.php?query=libxp&submit=Search+...&system=&arch=
2. Install the missing xlibp files using the Fedora Core 9/10 updates.
3. If you are installing on a Linux Intel-based architecture, narrow your search to

"i386" (do a "name -a" on your Linux box to see the version/kernel info first).
4. Most likely, libXp-1.0.0.-11.fc.9.i386.rpm (as of this writing) is needed.
5. Do these commands to install and then verify it is installed.
6. To install the package, run this command:

rpm -i libXp-1.0.0.-11.fc.9.i386.rpm (or your own package name)

7. To verify its installed, use this command:
rpm -q libXp-1.0.0-11.fc.9.i386 (without the "rpm" extension)

8. Then start the Managing Server using the launchpad.sh script.

Note: No restart of the OS is required because this problem is on Linux, not
Windows.

Security issue when installing Managing Server in WebSphere
Application Server Network Deployment

The Problem: When installing the Managing Server in WebSphere Application
Server Network Deployment, a security issue arises resulting in the dialog
requesting the username and password appearing repeatedly.

The Reason: In WebSphere, when you enable security in the DMGR console, if the
Node agent is not synchronized with the DMGR, the server's security is not
enabled. This can occur if automatic configuration synchronization is disabled, or if
the synchronization interval value is large, and a configuration change has been
made to the cell repository that needs to be replicated to that node.

The Solution: Synchronize the node's configuration by following these steps:
1. On the Node Agents page, ensure that the node agent for the node is running.
2. Select the check box for the node you want to synchronize
3. Select Synchronize or Full Resynchronize.

Problems on the installation and connection of Managing
Server databases

The following examples are some problems with the Managing Server databases
you might encounter.

DB2 connection fails when installing Managing Server on Solaris

The problem: When using a DB2 type 2 JDBC driver while installing Managing
Server on Solaris, the following error is returned:
CYNCR9705E Can not find DB2 type 2 jdbc driver library in the system library path.

The solution: Ensure that the database is running and accessible on the network.
Confirm that the information you entered for the database is correct before you
continue the installation. It may be caused by environment errors on the operation
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system or database. For example, when using a DB2 type 2 JDBC driver, the driver
library path must be specified in the system library path.

Before running the Managing Server installation, you are required to source the
DB2 environment by using the source db2profile command. You must also do this
before starting WebSphere and Managing Server.

If the error still occurs, review the installation trace log file, trace-install.log, for
more information. This log file is located in the common logging directory.

Error running db2install.sh script

The problem: After running the db2install.sh script, the following errors were
returned:
./db2install.sh db2inst1 cyanea /tmp/wsam31/Installer-MS/scripts/db2
ksh: db2: not found.
ksh: db2: not found.

Does this mean the script failed?

The reason: The script may have completed successfully, but the error messages
mean that the user did not have the correct information in the ".profile" file.

The solution: There needs to be a reference that sources the db2profile.

Fail to install DB2 with the Managing Server

The problem: During an installation of DB2 with the Managing Server, you may
specify an invalid DB2 installation image (for example, DB2 Workgroup Server
Edition). This may cause the installation of DB2 with the Managing Server to fail.

The solution: Ensure that you are using the DB2 installation images that were
shipped with ITCAM for WebSphere. These images are provided in the CD-ROM
packet or as a download as part of the ITCAM for WebSphere eAssembly.

Remote DB2 installation failed because of different DB2 instance
owners on the client and the server

The problem: When installing ITCAM for WebSphere Managing Server, the installer
cannot find the database with db2inst1 specified as the DB2 instance user. After
db2inst3 is specified as the remote user, the installer shows that the user does not
exist.

The cause: When installing ITCAM for WebSphere in an environment with a
remote DB2 database there are issues when your DB2 instance user (db2inst1 by
default) is different on the DB2 client and server. DB2 handles this fine. But when
you connect to a database using the DB2 client you supply the remote instance
user name and password. The problem is with the installer. It expects the remote
user name and password AND it checks to see whether there is a local user of that
same name. If your instance user name is not the same, you must at least create a
dummy user on the Managing Server (DB2 client) with the same name as the
instance user on the DB2 server.

The following section describes an example of this issue:
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v DB2 Server - Had multiple DB2 instances, and the customer created a new one
called db2inst3 where the ITCAM databases were created using the provided
scripts on the install CDs;

v ITCAM Managing Server - Had the DB2 client installed with the defaults
including creating the instance user db2inst1, and could connect to the remote
databases with no problems using the db2 command shell.

The solution: To complete the installation, you are required to create a dummy
user on the Managing Server (DB2 client) with the same name as the instance user
on the DB2 server. In this specific example, create a local user db2inst3 to solve the
problem.

Set up an alternate SID name on an Oracle Database

The question: How do I set up an alternate SID name on an Oracle Database?

The answer: Do the following steps:
1. Oracle Configuration
v Install the Managing Server per standard procedures, skipping the creation of

the Managing Server database. This procedure is standard when using a
remote database instance.

v Create the ITCAMx (i/q/p) database on the wanted Oracle server using the
dbca utility or existing Oracle scripts.

v Extract the contents of the oracle-remote-scripts.tar file copied from the
Managing Server to a temporary directory on the Oracle server.

v Generate the wanted schema user and assign it 100-200 MB table space. The
configuration script will grant unlimited table space to the user.

v Execute the following commands to grant roles to the schema user.
GRANT RESOURCE TO ITCAMIWAS;
GRANT CREATE PROCEDURE TO ITCAMIWAS;
ALTER USER ITCAMIWAS DEFAULT ROLE ALL;

v Execute the following command from the oracle directory in the path of the
extracted tar file. The following parameters are used in the following
command:
itcamiwas - Oracle schema owner
CAM - Oracle tablespace name
admin - local Managing Server OS account, used as default administrator

sh bin/oracleinstall.sh itcamiwas password CAM itcamiwas password admin

v Verify that there are no unusual errors in the log files created in the
~/oracle/logs directory, oracle_createschema_installation.out and
oracle_prepare_installation.out.

v Verify the Oracle client connection from the Managing Server to database
using an SQL plus connection using the schema owner credentials. The
Managing Server owner account must have all the proper Oracle
configurations in its profile file, as shown in the following example. The
ORACLE_OWNER and ORACLE_SID variables can be changed to match the
current environment.
Oracle 10g
ORACLE_BASE=/home/oracle/oracle; export ORACLE_BASE
ORACLE_HOME=$ORACLE_BASE/product/10.2.0/db_2; export ORACLE_HOME
ORACLE_TERM=xterm; export ORACLE_TERM
PATH=$ORACLE_HOME/bin:$PATH; export PATH
ORACLE_OWNER=oracle; export ORACLE_OWNER
ORACLE_SID=itcamx; export ORACLE_SID
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LD_LIBRARY_PATH=$ORACLE_HOME/lib; export LD_LIBRARY_PATH
CLASSPATH=$ORACLE_HOME/JRE:$ORACLE_HOME/jlib:$ORACLE_HOME/rdbms/jlib
CLASSPATH=$CLASSPATH:$ORACLE_HOME/network/jlib; export CLASSPATH

TMP=/tmp; export TMP
TMPDIR=$TMP; export TMPDIR

2. Managing Server Configuration
Managing Server configuration must be changed to accommodate the new
database name. Changes are applied to the shell script that sets the Managing
Server operating environment and the data source used by the WebSphere
Enterprise Application that provides the Visualization Engine.
v Log in as the Managing Server owner.
v Back up the setenv.sh file in the ~/MS_home/bin directory.
v Open the setenv.sh script and change the line listed to include the proper

host name, Oracle SID, and listener port.
JDBC_DRIVER_URL=jdbc:oracle:thin:@rh4as20gb.test.org:1521:itcami

v Test the database connectivity by using the command MS_home/bin/amctl.sh
kl1 dbtest. This command checks the database credentials and client driver
configuration then check for the presence of a table created by the Oracle
configuration scripts. An example output from this command is shown.
[amuser@rh4as20gb bin]$ ./amctl.sh kl1 dbtest
/opt/IBM/itcam/WebSphere/MS/bin/klctl.sh dbtest kl1.properties
Testing DB Connection with kernel properties...
using the following properties to test database connection...
JDBC DRIVER NAME =oracle.jdbc.driver.OracleDriver
DB URL =jdbc:oracle:thin:@rh4as20gb.test.org:1521:itcami
DB USER =itcamiwas
DB PASSWORD =XXXX
Trying to establish connection to database
Succesfully established connection

Testing by executiong two sql calls
.........................

Trying to get first prepared statement from connection
Successfully got prepared statement from connection
Trying to execute prepared statement on connection
Successfully executed prepared statement on connection
Trying to close prepared statement
Successfully closed prepared statement

Trying to get second prepared statement from connection
Successfully got prepared statement from connection
Trying to execute prepared statement on connection
Successfully executed prepared statement on connection
Trying to close prepared statement
Successfully closed prepared statement

Trying to close database connection
Successfully closed connection

Test complete
[amuser@rh4as20gb bin]$

v Start the Managing Server processes using the command
MS_home/bin/am-start.sh

3. WebSphere Application Server Configuration
v Start the WebSphere Application Server configured for the Managing Server

Visualization Engine and login to the Admin Console.
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v Open Resources → JDBC Providers → ITCAM-JDBCDriver → Data Sources →
ITCAMDataSourceand change the URL at the bottom of the page to reflect
the wanted host name, SID, and listener port.

v Click Apply.
v Select the "J2EE Connector Architecture (J2C) authentication data entries" link

and then the Node...Cell/server1 entry.
v Change the user ID and password values to match those changed in the

setenv.sh file. Click Apply, then the Save link at the top of the Window.
Click Save again.

v Restart the Application Server, login to the Admin Console and test the data
source connection to the new database. If this passes, login to the
Visualization Engine using the default admin account.

Verifying that the database tables successfully populated the
Octigate database

The problem: You need to verify that the database tables successfully populated the
octigate database.

The solution:

In UNIX:
1. Switch to the user that logs into the Application Monitor.

su - admin_user

2. Issue the following DB2 commands:
db2 connect to octigate

db2 list tables

db2 terminate

In Windows:
1. From Windows Start menu, select Start → All Programs → IBM DB2 →

Command Line Tools → Command Window.
2. Issue the following DB2 commands:

db2 connect to octigate user [username] using [password]

db2 list tables

db2 terminate

The DB2 list tables produces 65 tables. If there are no results, then the tables were
not created.

Setting up the cygwin X server to install the Managing Server
remotely

The problem: How to set up the cygwin X server to install the Managing Server
remotely?

The solution: To install the Managing Server using a GUI on a remote Linux for
System z® server, you have to use the Visualization Engine. You are required to use
a standard X Server on the remote client first. If you are using a Windows client,
you can download and install the cygwin X Server package from the Internet.
1. Once you have installed the cygwin server package, select Start → Run →

Programs → cygwin-X → X-Win Server.
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2. Start the X Server here. You can see an X icon on the bottom right of the
Windows task bar, which indicates the X Server is running.

3. After the X Server runs, start the putty client and connect to the remote Linux
for System z. If you are using X, you have to set the "X11" settings in the putty
client, so that the X Server is connected to the Linux for System z server
successfully. You can then use the standard launchpad.sh command-line shell
script and start the GUI.

Note: Do not set the DISPLAY variable when you start the putty client and log in
to the server. Set this variable automatically.

Windows: Scripts Execution Authentication
The problem: By default, the installer grants the right of executing Managing
Server control scripts to all the members of the group Administrators on Windows
platforms. It allows any of them to start and stop the Managing Server by
double-clicking the shortcuts on Desktop or by running the scripts in a KShell
console. However, if two or more users run the scripts in an improper order, the
lock file may fail.

The solution: Before starting the server, it is required to make sure that there are
no pid files under the /tmp directory that was created by other users during
previous operations. As another option, the right of executing these scripts can be
restricted to one user by changing the ownership and mode of these files with
chown and chmod commands.

Note: For the Application Monitor component running on WebSphere Application
Server, it is recommended that the same Windows account is used to operate the
Managing Server.

Running the Managing Server
The following are troubleshooting tips and techniques for problems that occur
during running the Managing Server.

Application Monitor shows Data Collectors as unavailable
even though they are running

The problem: This can happen when either the Data Collector or Managing Server
is heavily loaded such that a heartbeat is missed between the Data Collector and
the Managing Server.

The solution: Increase the heartbeat of the Managing Server from the default 15
seconds to 30 or 45 depending on the load. The heartbeat is set in both
kl1.properties or kl2.properties under the property contract.duration.

Authoritative server does not list in the sorted order in the
comparison table after setting up a Runtime Environment
Comparison

The problem: The authoritative server does not list in the sorted order in the
comparison table after setting up a Runtime Environment Comparison.

The solution: The sort function applies to all the comparison servers but not the
authoritative server which remains always top of the comparison table.
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Change the Managing Server that a Data Collector is
connected to

The question: How to change the Managing Server which a Data Collector is
connected to?

The answer: Perform the following steps:
1. Log in to the WebSphere Application Server administrative console.
2. Modify the MS_AM_home variable to reflect the path of the new Managing

Server and save your changes.

Note: If the Managing Server is on UNIX, the path that you enter needs to
start with two forward-slashes (//). For example, //opt/IBM/itcam/WebSphere/
MS.

3. Stop the instance of WebSphere Application Server or WebSphere Portal Server
that will be used by the Data Collector.

4. In the DC_home/etc directory, edit the datacollector.properties file. Change all
the IP references in that file to the new IP address.

5. In the DC_home/etc directory, there will be about 4 system generated files for
your server. Delete those system generated files. These will have the following
format: nodename.servername.datacollector.properties.

6. Tar the files in the DC_home/logs directory into a tar file.
7. Start the instance of WebSphere Application Server or WebSphere Portal Server

that will be used by the Data Collector.

Changes to make on WebSphere Application Server
administration console for the Visualization Engine to work
correctly

The problem: I have set up global security on my WebSphere Application Server
now. What changes do I have to make on the administration console for the
Visualization Engine to work correctly?

The cause: When you log in to the Visualization Engine, the ITCAM software uses
the authentication method defined in the WebSphere Application Server
administration console.

The solution: Take the following steps:
1. Open the WebSphere Application Server administration console.
2. Check the Enable Application Security field. If you do not enable application

security, you are not able to log in to the Visualization Engine.
3. Check that the top three fields in the right panel are selected.

Problems and tips on the databases of Managing server
The following examples are some problems with the Managing Server databases
you might encounter.

Correcting DB2 high CPU usage on Linux

The problem: The db2fm process (DB2 Fault WebSphere Business Monitor) exhibits
high CPU usage on Red hat systems, even after changes to the /etc/inittab file to
change the startup process from respawn to once.
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The cause: This problem is present with the base DB2 8.2 included in the supplied
prerequisites CD for ITCAM Agent for WebSphere Applications on Linux. The
ultimate fix for the problem is applying DB2 Fix Pack 9 or higher. This patch is
applied to all Red hat VMWare images in order to stabilize the system
performance. The following procedure lists the procedure to install Fix Pack 12 on
Red hat Linux.
1. Download the appropriate version of the patch, based on whether you are

running Red hat 3 (2.4 kernel) or Red hat 4 (2.6 kernel). This example uses the
32 bit 2.4 kernel download file, FP12_MI00154.tar.

2. Comment out (add a # sign at the beginning) the following line at the end of
the /etc/inittab file.
fmc:2345:respawn:/opt/IBM/db2/V8.1/bin/db2fmcd #DB2 Fault Monitor Coordinator

3. Save the file and reboot the Red hat image, which will effectively disable the
DB2 auto start. Check for any DB2 processes with the command ps -ef|grep
db2.

4. Copy the FP12_MI00154.tar file to the Red hat VMWare image using ftp, sftp,
scp, or a Samba share and extract the tar file with the command tar xvf
FP12_MI00154.tar

5. Run the command ./installFixPak to update all the Red hat software packages
for DB2.

6. Confirm the DB2 instance name created when you installed the database,
typically db2inst1.

7. Run the command /opt/IBM/db2/V8.1/instance/db2iupdt db2inst1 to update
the current instance. Repeat this command for any other installed instances.

8. Run the command /opt/IBM/db2/V8.1/instance/dasupdt to the DB2
Administrative Server.

9. Uncomment the last line in the /etc/inittab file, save the file, and reboot once
again.

Note: These steps are excerpted from the release.txt file included with the patch,
in the doc directory. Please refer to this document for any details.

Maintaining an Oracle Database

The question: How do I know which segments have plenty of free space under the
high-water mark and would benefit from a reorganization?

The answer: You can use the Oracle Enterprise Manager interface provided in
Oracle Database 10g to target a specific tablespace to identify potential candidates.

However, if the database has several hundred tablespoonsful, it cannot be possibly
done every day, and not every tablespace would have segments that need
reorganization. In Oracle Database 10g Release 2, the supplied package
DBMS_SPACE provides an automatic tool that proactively scans the segments and
reports any potential candidates for reorganization. The built-in function
ASA_RECOMMENDATIONS shows the segments. This is a function in the
pipeline. You can use it as follows:
1. Select * from table (dbms_space.asa_recommendations());
2. Runstats in DB2 replacement. Automatic table level statistics gathering is on

by default.

In 10g, statistics are collected automatically if the initialization parameter
STATISTIC_LEVEL is set to TYPICAL or ALL. (The default value is TYPICAL, so
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automatic statistics gathering is enabled out of the box.) Oracle Database 10g has a
predefined Scheduler job named GATHER_STATS_JOB, which is activated with the
appropriate value of the STATISTIC_LEVEL parameter. The collection of statistics is
fairly resource-intensive. To ensure it doesn't affect regular operation of the
database, there is a special resource consumer group named
AUTO_TASK_CONSUMER_GROUP predefined for automatically executed tasks
such as gathering of statistics. This consumer group makes sure that the priority of
these statistics collection jobs is below that of the default consumer group, and
hence that the risk of automatic tasks taking over the machine is reduced or
eliminated.

The question: How do I set the parameter STATISTIC_LEVEL to TYPICAL without
making the statistics collection automatic?

The answer: Disable the Scheduler job by issuing the following:
BEGIN
DBMS_SCHEDULER.DISABLE(’GATHER_STATS_JOB’);
END;

To make sure it is indeed set:
1. Select * from DBA_SCHEDULER_JOBS WHERE JOB_NAME = 'GATHER_STATS_JOB'; the

enabled value will have a true column
2. Check the last date when your tables were analyzed: select * from

DBA_TA_STATISTICS WHERE OWNER='AMUSER' AND TABLE_NAME NOT LIKE '%$%'
ORDER BY TABLE_NAME;

Script for manually trimming data of the Octigate database

The question: The data trim process may take much time to complete (up to 24
hours or more, in specific cases). What can be done as an alternative cleaning
mechanism, without losing all the historical data?

The answer: The SQL scripts provided here are to be used exclusively when the
normal data trim process does not respond well because of the large amount of
data on certain few days (millions of requests per day). The standard data trim job
is still recommended as a rule.

This script can be run either through cron job or manually, and the following three
tables are handled for data trim:
v REQUEST
v METHOD
v IMSEVENTS

It creates a temporary table using a statement as the following sentence, retaining n
days of data.

For Oracle database with n=1,
create table request_tmp as select * from request where END_TIME > (sysdate - 1);

For DB2 with n=3,
insert into request_tmp select * from request where END_TIME >

(current_timestamp - 3 days);

The main table REQUEST is then truncated and all entries from the preceding
temporary table are inserted back into the REQUEST table. The temporary table is
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dropped. The commits are intermediate since the log resource could be a
bottleneck to the number of rows that can be held in pending state. The script can
be customized as needed.
v To run the script for DB2:

db2 connect to octigate user db_user_id using password
db2 -tvf datatrim_external_db2.sql > result.txt

v To run the script for Oracle database:
sqlplus OCT_DBUSER/DB_PASSWD@SQL_LOCATION/ datatrim_external.sql

Trimming a Large Octigate Database

The question: Is there anything I can do to quickly reduce the size of the Octigate
database if I have not been running the datatrim script and the database has
grown to an excessively large size?

The answer: Ideally, you should set up your ITCAM database (Octigate) pruning
and optimization when you create the Managing Server. For details on optimizing
the database, see the appendix on maintaining the monitoring environment in
ITCAM for Application Diagnostics: Managing Server Installation and Customization
Guide.

In the case of an extremely large Octigate database that has not been trimmed by
the datatrim script on a regular basis, you may want to consider dropping and
rebuilding the following 4 tables.
request
method
serverstats
gc_data

These 4 tables are usually the big ones. Recreating them will not harm ITCAM in
any way other than the fact that the data will be lost.
v DB2: To recreate the tables in DB2, drop and then create the tables similar to the

way they are dropped and created in the MS_home/etc/am-db2.sql script.
v Oracle: To reduce the size of the tables in Oracle, use the TRUNCATE

command.

In addition, another technote has been provided that includes AS-IS scripts to help
remove large amounts of data. See this link to see how it's done:
http://www-01.ibm.com/support/docview.wss?&uid=swg21383986

Customers running at monitoring level 2 (MOD L2) cannot
obtain Method Profiling data

The problem: Customers running at monitoring level 2 (MOD L2) that select the
check box for Method Profiling, might get the following message:

"To make sure that your system is instrumented to capture all level 3 data, update
the toolkit_custom.properties file within the data collector's custom folder for the
monitored application server. Be sure to recycle the application server to ensure
proper results. For CICS and IMS™, please ignore this warning."

The reason: Method Profiling, an optional feature at monitoring level 2, is
dependent on monitoring level 3 method entry and exit instrumentation. The
purpose of Method Profiling is to summarize those Level 3 method entry and exit
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requests, to give you summarized method level data without the overhead of
sending all Level 3 requests to the Managing Server for analysis.

The solution: For an introduction to ITCAM for WebSphere's technique for
instrumenting application classes, see the following section of the Data Collector
installation and customization guide: "Controlling instrumentation of application
classes for memory leak, lock, and Level 3 method analysis"

To enable Method Profiling with default settings, you must update the
toolkit_custom.properties file for each application server to be monitored using this
feature. In particular, you must uncomment the am.camtoolkit.gpe.customxml.L3
property and set com.ibm.tivoli.itcam.toolkit.ai.methodentryexittrace=true. Refer to
the section "Enabling Byte Code Instrumentation features with default settings" in
"Data Collector Installation and Customization Guide".

It is recommended that you customize Method Profiling to instrument a subset of
your application classes. Refer to the section "Customizing Level 3 method entry
and exit analysis" in "Data Collector Installation and Customization Guide".

CYNP0016W: There is a missing method trace for the end of
the request

The problem: The following error message occurs:
CYNP0016W: There is a missing method trace for the end of the request.

The cause: The Publish Server maintains the request stack corresponding to the
request on the application server in the same order as they are invoked. If the
Publish Server gets the end of the request without the start, this warning message
is thrown.

The solution: Take the following steps:
1. Log on to the Visualization Engine;
2. Navigate to Administration → Managing Server → System Properties;
3. Tune the Managing Server by increasing Max Method Records from 10000

(default) to 100000 (100K), 500000 (500K) or 1000000 (1M) in steps if the error
persists in the logs.

Data is not correctly shown
The following content provides some solutions when data is not correctly shown.

Database Connection Pool information is not showing up

The problem: Database Connection Pool information is not present on the
Managing Server.

The solution: Perform the following:
1. Verify that the JDBC Connection Pools PMI setting is enabled in WebSphere

Application Server for the Data Collector.
v beanModule=X
v cacheModule=H
v connectionPoolModule=X
v j2cModule=H
v jvmRuntimeModule=H
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v orbPerfModule=H
v servletSessionsModule=H
v systemModule=H
v threadPoolModule=H
v transactionModule=H
v webAppModule=H
v webServicesModule=H
v wlmModule=H
v wsgwModule=H

2. For z/OS, verify that com.ibm.websphere.management.enableConfigMbean is
set to 'true' in WebSphere Application Server for the Data Collector.

3. Once the above mentioned items are set, stop and start the AppServer on the
Data Collector. It is important to remember that the System Resources → DB
Connection Poolsdisplays data only after a request is running in the monitored
WebSphere Application Server and accesses the Datasource. Before that
happens, the display for the Datasource will continue to show 'Data Not
Available'.

To force DB Connection Pool data:
1. Run a request in the server where the 'Data Not Available' message is. Set the

monitor on demand level to L2 and 100% sampling to collect a trace on the
request. Ensure that the L2 trace shows that traffic is flowing to the JDBC
dataSource successfully in that server before proceeding.

2. After 1) is confirmed, then check the System Resources → DB Connection
Pools display for the common DataSource in the server and look for processing
statistics to appear then.

If the value is showing up as 0 (zero), there is a fix if the Data Collector is on z/OS
(APAR PK17518). A 0 value has not been an issue that has been identified on the
other Operating Systems at this time so there are no APARs for those platforms.

No data received on custom MBean

The problem: After configuring a custom MBean, on the VE side, the user can see
the custom category but when they click the category it returns a NO DATA
AVAILABLE error message.

The solution: Check your custom MBean configuration file, make sure all category
names are in uppercase and contain only letters, no blanks and no other characters.

No GC data is available in the Recent Active Display and Memory
Diagnosis page of the Managing Server Virtual Engine

The problem: No GC data is available in the Recent Active Display and Memory
Diagnosis page of the Managing Server Virtual Engine.

The reason: Verbose GC is not enabled and the path to the WebSphere
native_stderr.log file is not specified in the TEMAGCCollector.gclog.path
property.

The solution: You can solve this problem according to the following steps:
1. Enable verbose GC for WebSphere Application Server in the Admin Console or

adding -verbose:gc to JVM arguments in the server.xml file.
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2. Append the next property in the DC_home/runtime/RUNTIME/
SERVER.kwjdc.properties file:
TEMAGCCollector.gclog.path = <PATH_TO_WebShere native_stderr.log>

3. Restart WebSphere Application Server.

No Tivoli Enterprise Portal event reported on Alerts and Events
page

The problem: An event is reported on Tivoli Enterprise Portal but not on the Alerts
and Events page.

The solution: Follow these steps to set the Tivoli Enterprise Monitoring Server
information:
1. Edit MS_home/etc/dal/dal.properties and enter the Tivoli Enterprise

Monitoring Server host information:
dal.tema.hostName=[TEP hostname or IP address]
dal.tema.port=[TEP port number]
dal.tema.useHttps=[true or false]

2. Edit MS_home/etc/dal/TEMAQuerySchema.xml and enter the Tivoli Enterprise
Monitoring Server login information:
<parameter name="userid" value="sysadmin"></parameter>
<parameter name="password" value="password"></parameter>
<parameter name="passwordEncrypted" value="false"></parameter>

3. Restart Managing Server.

Note: A Managing Server can retrieve data from one Tivoli Enterprise Monitoring
Server only and you cannot configure a Managing Server to retrieve event data
from multiple Tivoli Enterprise Monitoring Server. Therefore, it is recommended
that all Data Collectors under the same Managing Server are connected to the same
Tivoli Enterprise Monitoring Server.

System Data not available in WebSphere Application Server ND
and cluster configurations

The problem: System level statistics are not available at the server level in an ND
or cluster environment. The following fields are not available ("N/A") on the
JVM/System Detail report:
v Percent CPU Usage
v Free Memory (MB)
v Avg. CPU Usage

The reason: They are collected from the Node Agent. This is due to the design of
ND, which typically places one Node Agent on each system in place. The Node
Agent is responsible for information gathering and reporting when there are
multiple servers on a single system.

Error CYNVE0181E: One or more data collectors were unable
to be configured

The problem: When trying to configure 250 or a large number of data collects on
the Unconfigured Data Collector Overview page in a single operation, you may get
the error message "CYNVE0181E: One or more data collectors were unable to be
configured". This can occur in a managing server with DB2 or Oracle as the
database server.
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The reason: Database connections run out during the configuration time and the
default setting of maximum number of connections in DB2 or Oracle is not
sufficient enough to handle all the database activities involved.

The solution: 50 or fewer number of data collectors is recommended when trying
to configure them in a single operation.

Inapplicable features when customizing an user-defined role
The problem: On Role Configuration page, some features are not available for
customizing an user-defined role. This implies those features can be accessed by all
users.

The reason: This is working as designed.

Inconsistent timestamp shown in Heap Dump Management
with time set in Data Collector

The problem: The timestamp from Data Collector is converted to Greenwich Mean
Time (GMT) first. It is then based on the Managing Server time zone when it is
displayed on Heap Dump Management page.

The reason: This is working as designed.

ITCAM Agent for WebSphere Applications/J2EE Database
optimization

The problem: There are some general performance issues in ITCAM Agent for
WebSphere Applications/J2EE reports, especially with Lock Contention reports or
your SQL reports for "Response Time (ms)" not working.

The solution: The following are some solutions to boost performance and solve
your problems with reports not being rendered.
v db2 "CREATE BUFFERPOOL itcamBP SIZE 1000 PAGESIZE 32K"

"itcamBP" is the name of the buffer pool and "32K" is the page space size.
To see available bufferpools, run db2 select * from syscat.bufferpools.

v db2 "CREATE TEMPORARY TABLESPACE itcamTEMP PAGESIZE 32K MANAGED BY SYSTEM USING
(’/opt/IBM/temp/db2inst1/itcamts.10’) BUFFERPOOL itcamBP"

/opt/IBM/temp/db2inst1/itcamts.10 is the file that will be used. DB2 MUST be
able to read/write to the directory/file and it must have adequate space on the
file-system. "itcamTEMP" is the TEMPORARY tablespace name while "itcamBP"
is defined above. "...TEMPORARY TABLESPACE..." is important.
To see available tablespace: db2 list tablespaces

v Stop and start DB2:
1. Log in as the DB2 admin
2. Run db2stop
3. Run db2start
Note: This will require a Managing Server/WebSphere Application Server restart
too after creating the bufferpool and temporary tablespace.

v Follow the Managing Server installation guide for DB2 maintenance:
$AM_home/bin/run-stat-cmds.sh or...
db2 "RUNSTATS ON TABLE db2inst1.request WITH DISTRIBUTION AND DETAILED

INDEXES ALL"
db2 "RUNSTATS ON TABLE db2inst1.method WITH DISTRIBUTION AND DETAILED

INDEXES ALL"
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db2inst1 is the schema user ID.

Running these commands may take a few minutes, and should be done daily.

In addition, you may use the AM_home/bin/datatrim.sh script. See the IBM Tivoli
Composite Application Manager for Application Diagnostics Managing Server Installation
Guide for further details and DB2 maintenance.

Launch in context to portal fails
The problem: Error page is displayed after pressing the Monitoring Console button
on the Resources tab in Problem Centre.

The Solution: Follow these steps to set the launch in context information:
1. Edit MS_home/etc/ve.properties and enter the portal information:

tep.hostname=[TEP hostname or IP address]
tep.port=[TEP port number]
tep.baseurl=[TEP base URL]
tep.userid=[TEP user ID]

2. Restart Managing Server.

Load-balancing Archive Agents across multiple Publishing
Servers

The problem: When starting multiple Archive Agents, their starting time may vary.
The Publishing Server will establish all queues with the first started Archive Agent.
If that Archive Agent is overloaded, it may crash.

The solution: A new feature was implemented in the Publishing Server that resets
the queues to better balance the load across all queues. This feature is disabled by
default; to enable it, set this property in ps1.properties and ps2.properties:
# Allows to load balance PS->AA connections more uniformly by resetting the
# connections at regular intervals.
aa.loadbalancing.enable=false

Also, you can set the time intervals for queue reset using the following properties:
# Start time in minutes when to reset the AA connections for the first time
aa.loadbalancing.start=10
# Delay time in minutes to wait between two different AA connection resets.
aa.loadbalancing.delay=90

Managing Server and Data Collectors require a restart after IP
address change

The problem: The Managing Server and Data Collectors require a restart after a
DHCP IP address change. The kernel stops serving the RMI (remote method
invocation) codebase correctly to the other components; the Data Collectors don't
try to reconnect to the Publishing Server, even after the Publishing Server has been
restarted. Both still reference the old IP address, and they show up as unavailable
in the Application Monitor. Nothing crashes , but the kernel RMI socket stops
serving the classes correctly.

The first exception on the Managing Server is an IOException Socket Closed event,
followed by many socket exceptions.

The solution: Use dynamic DNS, and have the kernel host and RMI codebase
parameters set on the Data Collector using the dynamic DNS name for this
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Managing Server rather than the IP address; see the IBM Tivoli Composite
Application Manager for WebSphere Installation and Customization Guide.

Messages with severity "INFO" level are still logged after the
log level is set to "ERROR"

The problem: After issuing the following command to change the log level of
managing server components, you may find messages with severity "INFO" level
are still logged in the log files:
MS_home/bin/amctl.sh kl1 error
MS_home/bin/amctl.sh ps1 error
MS_home/bin/amctl.sh ps2 error
MS_home/bin/amctl.sh aa1 error

The solution: There is a shared module in the managing server components. The
messages with severity "INFO" level are generated by the shared module. To set
the log level of the module, please follow these steps:
1. Edit MS_home/etc/cynlogging.properties file.
2. Replace "INFO" as "ERROR" in these lines:

# MESSAGE LOGGER
CYN.msg.common.level=INFO
CYN.msg.common.logging=true

CYN.trc.common.level=INFO
CYN.trc.common.logging=true

3. Restart the managing server components.

New traps and PAR reports from the ITCAM 6.1 Managing
Server Fix Pack 2 still exist but do not work after
uninstallation

The problem: If you create and save traps and PAR reports that were newly added
in ITCAM 6.1 Managing Server FP2, when you uninstall the fix pack, these new
traps and reports will not be deleted by the uninstaller.

These saved traps and PAR reports will still be listed, but the traps will not be
triggered, and if you click Saved PAR reports, errors will display.

The solution: Manually delete the saved trap or PAR report by clicking the button
next to it.

OutOfMemory exceptions
The following content provides some solutions to the OutOfMemory exceptions.

Kernel crashes with OutOfMemory exceptions during startup

The problem: Kernel processes for numerous Data Collectors dump the heap with
OutOfMemory exceptions.

The solution: Increase the kernel process's heap size to at least 512MB.

Publishing Server crashes with OutOfMemory exceptions

The problem: When running a large number of Data Collectors, the Publishing
Server crashes with OutOfMemory exceptions.
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The solution: Either increase the heap size of the Publishing Server process in
setenv.sh (HEAP_MAX_SIZE_PS=512) to 1024 or add another Publishing Server
process to the Managing Server.

Port 9090 Conflicts error on AIX
The problem: When you start your Managing Server, the following error is
returned:
Error: Failed to Start Transport on host , port 9090. The most likely cause is
that the port is already in use. Please ensure that no other applications are
using this port and restart the server.
com.ibm.ws.webcontainer.exception.TransportException: Failed to start transport
http: java.net.BindException: Address already in use.

The cause: There is a port number conflict between the WebSphere Application
Server administrative console and WebSM service on AIX. Both use port 9090.
WebSM is a tool that is useful to administrators who manage many AIX
computers. The WebSphere Application Server administrative console is used to
administer WebSphere Application Server. The port 9090 conflict on AIX is a
known WebSphere Application Server issue. Ensure that no other applications are
using this port.

The solution: Before starting the server, it is required to make sure that there are
no pid files under the /tmp directory that was created by other users during
previous operations. As another option, the right of executing these scripts can be
restricted to one user by changing the ownership and mode of these files with
chown and chmod commands.

Note: For the Application Monitor component running on WebSphere Application
Server, it is recommended that the same Windows account is used to operate the
Managing Server.
To modify the port number that is used by WebSphere Application Server
administrative console, perform the following steps:
1. Disable WebSM Service by issuing the following command:

# /usr/websm/bin/wsmserver -disable

Note: Failure to complete this step before installing WebSphere Portal Server
results in an incomplete deployment of portlets.

2. Install WebSphere Application Server and WebSphere Portal Server (including
fix packs and interim fixes).

3. Modify the WebSphere Application Server administrative console port number
9090 in the following files to the desired port for the administrative console.
Refer to WebSphere Application Server documentation for more information.
v was_root/config/cells/cell_name/nodes /node_name/servers/server1/

server.xml
v was_root/config/cells/cell_name/virtualhosts.xml

4. Restart WebSphere Application Server and WebSphere Portal Servers.
5. Enable WebSM Service by issuing the following command:

# /usr/websm/bin/wsmserver -enable

Problems and tips on language issues
The following content are some problems and tips on language issues.
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Chinese characters are corrupted in a trap e-mail

The problem: When using the Chinese version of Managing Server for WebLogic,
Chinese characters are corrupted in a trap e-mail.

The solution: Ensure the locale is set to zh_CN.GB18030 for these users:
v The user who invokes am-start.sh to start ITCAM for WebSphere.
v The user who starts the WebLogic Application Monitor server.

Limitation for creating trap names and group names in Japanese

The problem: Trap names and group names can only include letters, numbers, and
white spaces. Certain Japanese characters will not be allowed.

The solution: Input only letters, numbers, and white spaces for trap names and
group names.

Viewing the product with non-supported language

If you are using Internet Explorer configured with a non-supported language to
view the Managing Server's user interface (Visualization Engine), the display
language will be based on the locale of the Managing Server. If the Manager
Server's locale is also not supported, English will be shown by default.

Note: This does not apply to the Tivoli Enterprise Monitoring Agent.

Problems with Server Active Display page
The following content provides solutions to some problems on Server Active
Display page.

Server Activity Display in Method/Trace component shows CPU
time greater than elapsed time

The problem: When viewing a Method/Trace for a request captured on L3, some
methods will display a CPU time greater than the elapsed time.

The reason: Due to the difference in the resolutions of the clocks in the operating
system for CPU and wall clock, you will sometimes see greater CPU times than
wall clock times. This happens especially when the response time of a request is
very small.

Solaris and AIX: Cannot view requests on Server Active Display
page

The problem: Due to system limitations on Solaris and AIX, requests with
considerable methods may lead to overflowstack exceptions when the Data
Collector deals with them. The Data Collector cannot capture such requests and
send them to the Managing Server due to problems with the application.

The solution: In order to view requests on the Server Active Display page, you
need to modify the WebSphere Application Server Generic JVM arguments.
Perform the following steps:
1. Check where the application fails from the stack trace reported in the JVM

error logs.
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2. Try to fix the application.
3. Otherwise, perform the following workaround:

a. Login to the WebSphere Application Server administrative console.
b. Navigate as follows:

1) Select the Servers > Application Servers and select the <ServerName>.
2) Navigate to the Additional Properties: Process Definition > Servant >

Additional Properties: Java Virtual machine.
3) In the Generic JVM arguments field, append the following parameter:

-Xss2m

Note: This may cause a minor performance decrease in the WebSphere
Application Server.

Problems with method trace
The following content provides solutions to some problems with method trace.

Method trace captured for Lock traps may contain negative
depth

The problem: Method trace captured for Lock traps may contain negative depth.
When we drill-down into the method trace in Trap Action History for Lock traps,
the method trace may show -1 for the depth.

The reason: For Lock-based traps, method trace is captured before the transaction
is over so the request stacks of those transactions is incomplete. This makes
calculating the depth for partial events (a start without an end event) impossible.

Method trace unavailable or partially available

The problem: When using MOD L3, method trace data is either not found or was
partially captured in Trap Action History, Server Activity Display, or Performance
Analysis Report pages. This is due to having large number of method records
associated with each monitored request. By default, the limit is 10000 method
records. If the limit is exceeded, the method records will be discarded and will not
be stored in the database.

The solution: Increase the Maximum Method Records value in System Properties
by clicking Administration → Managing Server → System Properties.

Request throughput spikes when Managing Server is restarted
The problem: When many heavily loaded Data Collectors are communicating with
the Managing Server and then the Managing Server is restarted, the Enterprise
Overview shows a spike in the request throughput.

The reason: This may happen if many heavily loaded Data Collectors are
communicating with the Managing Server. A Data Collector automatically detects
the status of Publishing Server and drops events when the Publishing Server is
disconnected. But some events may remain in the queue. So when the Managing
Server restarts, these events may show up as a spike in throughput.
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SAD Client Requests Time uses managing server local time
The problem: If the managing server and the data collector are installed in different
time zones, the Client Requests time in SAD will be shown according to the
managing server local time.

The reason: This is working as designed.

Server Availability graph does not correctly account for offline
servers

The problem: The % Available graph within the Server Availability report does not
take offline servers into account. The first graph always reports 100% availability,
but when you drill into it, several of the servers are offline and are reporting 0%
availability in the detail graph.

The reason: ITCAM for WebSphere is application-centric, not server-centric; thus it
takes an application-centric view of availability. When requesting a Server
Availability report on All Servers, all servers in the group must host the same
application and be clustered or load-balanced. Otherwise, the report will not make
sense.

If any server is available, the application is considered available. Conversely, the
application is considered unavailable only when all servers in the group are
unavailable. Therefore, if any server is 100% available during the time period being
monitored, the availability of the group will be 100%.

Example #1: Four servers in a group are clustered, and during the time period
requested, three of them are always unavailable while one of them is always
available. The availability will be reported as 100%, since users always had access
to the application (through the one server that was always available).

Example #2: Four servers in a group are clustered, and during the time period
requested, all servers are available for 75% of the time. Then all become
unavailable for 25% of the time. The availability will be reported as 75% since 25%
of the time the application was totally unavailable.

Server name displayed as a double value when exporting
report to CSV file

The problem: When exporting a report to CSV file and opening it with Excel, the
server name is displayed as a double value instead of a string value.

The solution: Parsing of a number format is handled by Microsoft Excel. To display
a correct value for the server name, configure the field type when exporting or
open the CSV file with a text editor.

Significant CPU consumption and high latency observed if a
thread dump is requested

The problem: Significant CPU consumption by both the Data Collector and the
Managing Server is observed if a thread dump is requested, and high latency is
received in generating traps if thread dumps are requested when the trap is
requested.
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The solution: In a production environment, generating a thread dump is not
encouraged as a trap action, due to the latency it will impose on trap actions and
the high CPU time it will consume on the Data Collector and the Managing Server.

Note: Performing a thread dump may also mean that you cannot access the
application when you refresh the thread dump page.

Some pages are displayed inappropriately in MSVE
The problem: After installing and enabling Firebug, some pages cannot be
displayed appropriately in the Managing Server Visualization Engine.

The reason: Firebug is not supported in ITCAM for Applications Diagnostics.

The solution: You are required to disable the Fire bug by clicking Disable in the
Console menu of the Firefox browser.

The Server Unavailable trap can be triggered only once when
the server is not available

The problem: If you have two traps, one with the condition >1 and a second one
with the condition >2, the Publish Server will only trigger the first trap (with the
condition >1) when the server becomes unavailable the first time. The Publish
Server will not trigger the trap with the condition >2 even if the server goes down
more than once.

The solution: To prevent this, do not create more than one Server Unavailable trap
per server. The trap condition must be set to >1.

Unable to load kernel classes from a user other than root
The problem: When the Managing Server is started using a userid other than root
(such as cyanea), you experience errors such as "Unable to load classes from Kernel
...".

The solution: Give the userid write permission to the /var/tmp directory.

Web Session Browser feature not supported at monitoring
level 1

The problem: The Web Session Browser feature is not supported at monitoring
level 1. A message will display, "DATA NOT AVAILABLE. Web Session Browser
feature is not supported at MOD Level 1. Please set your data collector monitoring
level to 2 or above to activate it." This message will only be displayed in English.

The solution: Set the monitoring level to monitoring level 2 or above to utilize the
Web Session Browser feature.

CYNVE0471E: No Data Available message displayed when
trying to generate a report

Put your short description here; used for first paragraph and abstract.

The problem: When attempting to generate a report, the user gets the message
CYNVE0471E: No Data Available.

The Managing Server uses a DB2 database.
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The solution: From the IBM DB2 command prompt, enter the following
commands:
db2 connect to octigate
db2 CREATE BUFFERPOOL BP32K IMMEDIATE SIZE 1000 PAGESIZE 32 K
db2 CREATE SYSTEM TEMPORARY TABLESPACE OCTTMP32 PAGESIZE 32 K
MANAGED BY SYSTEM USING
(’/home/db2inst1/db2inst1/NODE0000/SQL00001/OCTTMP32.0’)
BUFFERPOOL BP32K
db2 disconnect octigate
db2 terminate
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Appendix A. Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use software products successfully. These are the
major accessibility features you can use with IBM Tivoli Composite Application
Manager when accessing it on the IBM Personal Communications terminal emulator:
v You can operate all features using the keyboard instead of the mouse.
v You can read text through interaction with assistive technology.
v You can use system settings for font, size, and color for all user interface

controls.
v You can magnify what is displayed on your screen.

For more information about viewing PDFs from Adobe, go to the following web
site: http://www.adobe.com/enterprise/accessibility/main.html
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Appendix B. Support information

This section describes the following options for obtaining support for IBM
products.

Searching knowledge bases
If you have a problem with your IBM software, you want it resolved quickly. Begin
by searching the available knowledge bases to determine whether the resolution to
your problem is already documented.

Finding Release Notes®

You can find Release Note information online by viewing IBM Technotes.
Technotes are short documents that cover a single topic. You can search the
Technote collection for common problems and solutions, as well as known
limitations and workarounds. Technotes are continuously updated to provide
current product information.

You can search for Technotes and subscribe to have future Technotes e-mailed to
you, as described below. Alternatively, you can watch demonstrations of these
procedures at the following Web site: http://www-306.ibm.com/software/
support/sitetours.html

Finding Technotes
Perform the following actions to access Technotes for this product:
1. Launch the IBM Software Support Web site: http://www.ibm.com/software/

support
2. Follow the instructions on the screen to search for the Technotes related to the

issue encountered.

Subscribing to new Technotes
You can subscribe to an RSS feed of the product support page or subscribe to
receive e-mail notification about product tips and newly published fixes through
My support. To subscribe to an RSS news feed of the product support page, click
the orange RSS button under the Stay up to date pane.

My Support is a personalized portal that enables you to:
v Specify the products for which you want to receive notifications
v Create a personalized page that provides product information for the products

you use
v Choose from flashes, downloads, and Technotes
v Receive an e-mail update in your inbox

Perform the following actions to subscribe to My Support e-mails:
1. Launch an IBM support Web site, such as the following site:

http://www.ibm.com/support/us/
2. Click My support in the upper-right corner of the page.
3. If you have not yet registered, click register in the upper-right corner of the

support page to create your user ID and password.
4. Sign in to My support.
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5. On the My support page, click Add products.
6. Make the following selections from the lists to add this product to your

personal page:
a. Software
b. Systems Management
c. Application Performance & Availability

7. Click Add products.
8. Click Subscribe to email.
9. Set your preferences to specify the information you want in your e-mails.

10. Click Update.
11. Click Submit.

Tivoli Support Technical Exchange
You can become a participant in the new Tivoli Support Technical Exchange, where
you can expand your technical understanding of your current Tivoli products in a
convenient format hosted by Tivoli support engineers. This program provides
support discussions about product information, troubleshooting tips, common
issues, problem solving resources, and other topics. As Exchange leaders, Tivoli
engineers provide subject matter expert direction and value. Participating in the
Exchange helps you manage your Tivoli products with increased effectiveness.

What do you do to participate? Review the schedule of Exchange sessions. Find a
topic of interest and select register. Provide your name, phone number, company
name, number of attendees, the Exchange Topic, and IBM Customer number. You
will be invited to attend a one to two hour conference call where the information is
presented. The new Tivoli Support Technical Exchange can help with the following
areas:
v Increased product knowledge
v Ways to avoid common pitfalls
v Support recommendations
v Proactive customer support
v Helpful hints and tips
v Knowledge transfer
v Expansion of your knowledge base

For more information or to suggest a future Exchange session, contact Support
Technical Exchange (xchange@us.ibm.com). To learn more, visit the following Web
site: http://www-306.ibm.com/software/sysmgmt/products/support/
supp_tech_exch.html

Search the information center on your local system or
network

IBM provides extensive documentation that can be installed on your local
computer or on an intranet server. You can use the search function of this
information center to query conceptual information, instructions for completing
tasks, reference information, and support documents.

Search the Internet
If you cannot find an answer to your question in the information center, search the
Internet for the latest, most complete information that might help you resolve your
problem. To search multiple Internet resources for your product, expand the
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product folder in the navigation frame to the left and select Web search. From this
topic, you can search a variety of resources including:
v IBM technotes
v IBM downloads
v IBM Redbooks®

v IBM DeveloperWorks
v Forums and newsgroups
v Google

Obtaining fixes
A product fix might be available to resolve your problem. To determine what fixes
are available for your IBM software product, follow these steps:
1. Go to the IBM Software Support Web site at http://www.ibm.com/software/

support
2. Click Drivers in the Related support section.
3. In the Products of IBM section, select one software category from the Category

list.
4. Select one product from the Sub-category list.
5. Use the Search within results field if you want to refine your search.
6. Click Search.
7. From the list of downloads returned by your search, click the name of a fix to

read the description of the fix and to optionally download the fix.

For more information about the types of fixes that are available, see the IBM
Software Support Handbook at http://techsupport.services.ibm.com/guides/
handbook.html

Receiving weekly support updates
To receive weekly e-mail notifications about fixes and other software support news,
follow these steps:
1. Go to the IBM Software Support Web site at http://www.ibm.com/software/

support
2. Click My support in the upper right corner of the page.
3. If you have already registered for My support, sign in and skip to the next

step. If you have not registered, click Register now. Complete the registration
form using your e-mail address as your IBM ID and click Submit.

4. Click Edit profile.
5. In the Products list, select Software. A second list is displayed.
6. In the second list, select a product segment, for example, Application servers.

A third list is displayed.
7. In the third list, select a product subset, for example, Distributed Application

& Web Servers. A list of applicable products is displayed.
8. Select the products for which you want to receive updates, for example, IBM

HTTP Server and WebSphere Application Server.
9. Click Add products.

10. After selecting all products that are of interest to you, click Subscribe to
e-mail on the Edit profile tab.

11. Select Please send these documents by weekly e-mail.
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12. Update your e-mail address as needed.
13. In the Documents list, select Software.
14. Select the types of documents that you want to receive information about.
15. Click Update.

If you experience problems with the My support feature, you can obtain help in
one of the following ways:

Online
Send an e-mail message to erchelp@ca.ibm.com, describing your problem.

By phone
Call 1-800-IBM-4You (1-800-426-4968).

Contacting IBM Software Support
IBM Software Support provides assistance with product defects.

Before contacting IBM Software Support, your company must have an active IBM
software maintenance contract, and you must be authorized to submit problems to
IBM. The type of software maintenance contract that you need depends on the
type of product you have:
v For IBM distributed software products (including, but not limited to, Tivoli,

Lotus®, and Rational products, as well as DB2 and WebSphere products that run
on Windows or UNIX operating systems), enroll in Passport Advantage® in one
of the following ways:
– Online: Go to the Passport Advantage Web site: http://www.ibm.com/

software/passportadvantage Then click How to Enroll .
– By phone: For the phone number to call in your country, go to the IBM

Software Support Web site (http://techsupport.services.ibm.com/guides/
contacts.html).

v For IBM eServer™ software products (including, but not limited to, DB2 and
WebSphere products that run in zSeries®, pSeries®, and iSeries environments),
you can purchase a software maintenance agreement by working directly with
an IBM sales representative or an IBM Business Partner. For more information
about support for eServer software products, go to the IBM Technical Support
Advantage Web page (http://www.ibm.com/servers/eserver/techsupport.html)

If you are not sure what type of software maintenance contract you need, call
1-800-IBMSERV (1-800-426-7378) in the United States or, from other countries, go to
the contacts page of the IBM Software Support Handbook on the Web
(http://techsupport.services.ibm.com/guides/contacts.html) and click the name of
your geographic region for phone numbers of people who provide support for
your location.

Follow these steps when contacting IBM Software Support:
1. Determine the business impact of your problem.
2. Describe your problem and gather background information.
3. Submit your problem to IBM Software Support.

Determine the business impact of your problem
When you report a problem to IBM, you are asked to supply a severity level.
Therefore, you need to understand and assess the business impact of the problem
you are reporting. Use the following criteria:
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Table 10. Severity Level

Severity 1 Critical business impact: You are unable to use the program,
resulting in a critical impact on operations. This condition
requires an immediate solution.

Severity 2 Significant business impact: The program is usable but is
severely limited.

Severity 3 Some business impact: The program is usable with less
significant features (not critical to operations) unavailable.

Severity 4 Minimal business impact: The problem causes little impact on
operations, or a reasonable circumvention to the problem has
been implemented.

Describe your problem and gather background information
When explaining a problem to IBM, be as specific as possible. Include all relevant
background information so that IBM Software Support specialists can help you
solve the problem efficiently. To save time, know the answers to these questions:
v What software versions were you running when the problem occurred?
v Do you have logs, traces, and messages that are related to the problem

symptoms? IBM Software Support is likely to ask for this information.
v Can the problem be re-created? If so, what steps led to the failure?
v Have any changes been made to the system? (For example, hardware, operating

system, networking software, and so on.)
v Are you currently using a workaround for this problem? If so, please be

prepared to explain it when you report the problem.

Submit your problem to IBM Software Support
You can submit your problem by going to the "Submit and track problems" page
on the IBM Software Support site (http://www.ibm.com/software/support/
probsub.html). Enter your information into the appropriate problem submission
tool.

If the problem you submit is for a software defect or for missing or inaccurate
documentation, IBM Software Support creates an Authorized Program Analysis
Report (APAR). The APAR describes the problem in detail. Whenever possible,
IBM Software Support provides a workaround for you to implement until the
APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the
IBM product support Web pages daily, so that other users who experience the
same problem can benefit from the same resolutions.

Appendix B. Support information 125

http://www.ibm.com/software/support/probsub.html
http://www.ibm.com/software/support/probsub.html


126 ITCAM for Application Diagnostics: Troubleshooting Guide



Index

Numerics
32bit 71, 73

A
accessibility xii, 119
Agent node 75
Application Server subnode 75
Application Server Workspace

historical view
no data 77

B
books ix

see publications xi
BWMCR9502 25

C
Change

Log level 10
cluster 106
Collector log files and system information

Plug-in 5
conventions

typeface xii
CPU consumption 43, 115
custom MBean 106
Custom Mbean

not functioning 66
customer support 124

D
Data Collector Configuration 23, 26, 29,

47, 102
Data Collector Installation 25, 29, 31, 35
Data Collector Uninstallation 28, 34
data collectors

unable to be configured 108
Data Collectors unavailable 101
Database Connection Pool 106
DB2 Installation

connection 96
DC installation fails 58
Deploy

DB2 applications on Oracle 9 67
deployment manager 23
deserialize marshalled object 37
Direct JVM invocation 12
disability 119
double value

CSV 115
Download plug-in

IBM Support Assistant 5

E
education

see Tivoli technical training xii
Environment Checking 18
Error

no error message
JDK or JRE not found 62

F
Fail Logins per minute 86
Fail to log on 91
fail to run script

am_start.sh 91
Filter predicate

Specify 14
First Failure Data Capture 6, 9
fixes, obtaining 123
FQDN 23

G
Gather Script 1

Running procedures 6

H
historical view

Application Server Workspace
no data 77

HTTP Server version 87

I
IBM Support Assistant

Download plug-in 5
Plug-in 5, 9

inconsistent JVM heap size
Server Activity Display 40
System Resources 40

Inconsistent timestamp in Heap Dump
Mgt 109

information centers, searching to find
software problem resolution 122

Install
server using JVMPI interface 25

Install ISA and MDD for Java 20
Installation

incomplete list of servers shown 28
insufficient temporary disk space 33
Internet, searching to find software

problem resolution 122
IP address change 41, 110
ISA

Download plug-in 5
Plug-in 5, 9

ITCAM Agent for HTTP Servers 73
ITLM

ITLM agent 79

J
J2EE Application server

start, recycle 71, 73
Java 1.4.2 45, 71, 73
JDBC Connection Pools is 0 87
JMX connection socket binding 86
JVMPI interface

install server 25

K
Kernel 94
Kernel crashes 111
KFWITM220E Request failed

workspace 84
knowledge bases, searching to find

software problem resolution 121
KYNA0009, KWJ0027A 86

L
lack of memory 45, 71, 73
Launch in context 110
load balancing 110
loading kernel classes 116
lock analysis 46
log file utilities

First Failure Data Capture 6, 9
Gather Script 1
LogViewer 11

Log files and Utilities
Environment Checking Utility 18

Log level
Change 10

log path 62
logged messages 111
LogViewer 11

Start 11

M
Managing Server host name 23
Managing Server Installation 90, 91, 92,

93, 95, 100
Configuration 91
connection problem 94

Managing Server Running 102, 109
Managing Server Virtual Engine 102
Managing Server Virtualization

Engine 116
manuals ix

see publications xi
Memory Dump Diagnostic for Java with

IBM Support Assistant 20
memory, out of 43
method trace data 54
Missing Tivoli Enterprise Portal

event 106
MON_HEAP_SZ 91

© Copyright IBM Corp. 2007, 2010 127



N
Net Weaver DC 57
Net Weaver installation/configuration

fails 58
No GC data is available

Recent Active Display and Memory
Diagnosis 106

non-root user 25

O
ODBC driver, removing TEPS2 79
online publications

accessing xi
Oracle Installation/configuration fails 58
ordering publications xii
out of memory 43

P
Plug-in

Collect log files and system
information 5

IBM Support Assistant 5, 9
port 9090 conflicts 112
problem determination

describing problem for IBM Software
Support 125

determining business impact for IBM
Software Support 124

submitting problem to IBM Software
Support 125

Procedures
Run Gather Script 6

protocol timeout 54
publications ix

accessing online xi
ordering xii

Q
Query string

Specify 13

R
reader requirements ix
Release Notes, finding 121
request metrics 54
Request Name 87
request throughput 114
requirements for readers ix
Restore WebSphere Application Server

configuration 43
RPT 89
Running Data Collector 40, 42, 44, 50
Running Managing Server 106
Running the Data Collector 46
Running the Managing Server 94
Running Tivoli Enterprise Monitoring

Agent 38, 40, 52, 78
Running Tivoli Enterprise Portal 40, 79

S
SAD Client Request Time 115
scripts execution authentication 101
Server

installation with JVMPI interface 25
Server Activity display

cannot view requests 113
Server Availability graph 115
Silent installation

DC on AIX
warning message 62

Software Support
contacting 124
describing problem for IBM Software

Support 125
determining business impact for IBM

Software Support 124
submitting problem to IBM Software

Support 125
Solaris JDK 1.5

Heap Dump 42, 69
Specify

Filter predicate 14
Query string 13

stack trace 44
Start

LogViewer 11
starting WebSphere administrative

console 32
summary workspace 76
support updates, e-mail

notifications 123
system data not available 106

T
Technotes

e-mail notifications 121
viewing 121

TEMA doesn't start on SLES 9 49
the user interface for the agents 75
thread dump 43, 115
time to configure WebSphere Application

Servers 89
Tivoli Enterprise Monitoring Agent 28,

70
Tivoli Enterprise Monitoring Agent

Configuration 23, 87
Tivoli Enterprise Portal 76, 80, 83, 85
Tivoli Enterprise Portal browser client

fails 85
Tivoli Enterprise Portal Server database,

removing 79
Tivoli Information Center xi
Tivoli license manager 79
Tivoli Support Technical Exchange 122
Tivoli technical training xii
training, Tivoli technical xii
troubleshooting

Agent for WebSphere
Applications 23

installing and configuring 23
ITCAM Agent for WebSphere

Applications 35
troubleshooting techniques 70, 73, 75
typeface conventions xii

U
upgrade 38

V
Variables for directories xiii

W
Warning message

silent installation for DC on AIX 62
WebLogic

not functioning 70
WebLogic DC 57

unable to configure 57
WebSphere administrative console,

starting 32
WebSphere Application Server

configuration 95
WebSphere Application Server ND 106
workspaces

Application Server
no historical data 77

Wrapper script 11
Wrong mount 58
wrong port number in Oracle App

Server 87

X
XD 23

128 ITCAM for Application Diagnostics: Troubleshooting Guide



Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, Acrobat, PostScript® and all Adobe-based trademarks are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
other countries, or both.

Intel, Intel logo, Intel Inside®, Intel Inside logo, Intel® Centrino®, Intel Centrino
logo, Celeron®, Intel® Xeon®, Intel SpeedStep®, Itanium®, and Pentium® are
trademarks or registered trademarks of Intel Corporation or its subsidiaries in the
United States and other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, Windows NT®, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, and service names may be trademarks or service marks
of others.

© Copyright IBM Corp. 2007, 2010 129

http://www.ibm.com/legal/copytrade.shtml


130 ITCAM for Application Diagnostics: Troubleshooting Guide



Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM‘s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 2005. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color
illustrations might not display.
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